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Documents for This Product 

Documents for this product are provided as booklets ( ) and as electronic manuals ( PDF ) in the 
EXPRESSBUILDER DVD ( ). 

 

 
Precautions for Use Describes points of caution to ensure the safe use of this server. 

Read these cautions before using this server. 

 
Getting Started Describes how to use this server, from unpacking to operations.  

See this guide at first and read the outline of this product. 

 

 

PDF

 User’s Guide 
Chapter 1: General Description Overviews, names, and functions of the server components 

Chapter 2: Preparations Installation of additional options, connection of peripheral devices,  
and suitable location for this server 

Chapter 3: Setup System BIOS configurations and summary of EXPRESSBUILDER 

Chapter 4: Appendix Specifications 

PDF

 Installation Guide (Windows) 
Chapter 1: Installing OS Installation of OS and drivers, and important information for installation 

Chapter 2: Installing Bundled 
Software 

Installation of bundled software, such as NEC ESMPRO 

PDF

 Maintenance Guide 

Chapter 1: Maintenance Server maintenance and troubleshooting 

Chapter 2 Configuring and 
Upgrading the System 

Configure hardware and setup management tool associated with 
hardware 

Chapter 3: Useful Features Useful features and the detail of system BIOS settings, SAS 
Configuration Utility, and EXPRESSBUILDER 

PDF

 Other documents 
Provides the detail of NEC ESMPRO, BMC Configuration, and the other features. 

 

 

EXPRESSBUILDER 
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Notations Used in This Document 
 

Notations used in the text 

In addition to safety-related symbols urging caution, three other types of notations are used in this document. 
These notations have the following meanings. 

 

Important Indicates critical items that must be followed when handling the hardware or operating 
software. If the procedures described are not followed, hardware failure, data loss, and other 
serious malfunctions could occur. 

Note Indicates items that must be confirmed when handling the hardware or operating software. 

Tips Indicates information that is helpful to keep in mind when using this server. 

 

 

Optical disk drive 

This server is equipped with one of the following drives. These drives are referred to as optical disk drive in this 
document. 

• DVD-ROM drive

• DVD Super MULTI drive

 

Removable media 

Unless otherwise stated, removable media described in this document refers to both of the following. 

• USB flash drive

• Flash FDD
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Abbreviations of Operating Systems (Windows) 

Windows Operating Systems are referred to as follows. 

 

Refer to Chapter 1 (1.2 Supported Windows OS) in Installation Guide (Windows) for detailed 
information. 

 

Notations in this document Official names of Windows 

Windows Server 2012  
Windows Server 2012 Standard 
Windows Server 2012 Datacenter 

Windows Server 2008 R2  
Windows Server 2008 R2 Standard  
Windows Server 2008 R2 Enterprise  

 

 

POST 

POST described in this document refers to the following. 

• Power On Self-Test 

 

BMC 

BMC described in this document refers to the following. 

• Baseboard Management Controller 
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Trademarks 

EXPRESSSCOPE is a registered trademark of NEC Corporation. 

Microsoft, Windows, Windows Server, and MS-DOS are registered trademarks or trademarks of Microsoft Corporation in the United 

States and other countries. Intel, Pentium, and Xeon are registered trademarks of Intel Corporation of the United States. AT is a 

registered trademark of International Business Machines Corporation of the United States and other countries. Adaptec, its logo, and 

SCSI Select are registered trademarks or trademarks of Adaptec, Inc. of the United States. LSI and the LSI logo design are 

trademarks or registered trademarks of LSI Corporation. Adobe, the Adobe logo, and Acrobat are trademarks of Adobe Systems 

Incorporated. DLT and DLTtape are trademarks of Quantum Corporation of the United States. PCI Express is a trademark of 

Peripheral Component Interconnect Special Interest Group.  

 

 

All other product, brand, or trade names used in this publication are the trademarks or registered trademarks of their respective 

trademark owners. 
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Regulatory Notices 

FCC Statement 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause 
harmful interference in which case the user will be required to correct the interference at his own expense. 

 

Industry Canada Class A Emission Compliance Statement/ 

Avis de conformité à la réglementation d'Industrie Canada: 

CAN ICES-3(A)/NMB-3(A) 

 

CE / Australia and New Zealand Statement 

This is a Class A product. In domestic environment this product may cause radio interference in which case the 
user may be required to take adequate measures (EN55022). 

 

BSMI Statement 

 

Korean KC Standards 

 
 

Registration NO.  : MSIP-REM-NEC-EXP320Q 
Basic Model Number : EXP320Q 
Trade Name or Registrant : NEC CORPORATION               : 
Equipment Name : FT Server 
Manufacturer : NEC CORPORATION 

 

Turkish RoHS information relevant for Turkish market 

EEE Yönetmeliğine Uygundur. 
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Japan 

 

<本装置の利用目的について> 
本製品は、高速処理が可能であるため、高性能コンピュータの平和的利用に関する日本政

府の指導対象になっております。 
ご使用に際しましては、下記の点につきご注意いただけますよう、よろしくお願いいたし

ます。 
本製品は不法侵入、盗難等の危険がない場所に設置してください。 
パスワード等により適切なアクセス管理をお願いいたします。 
大量破壊兵器およびミサイルの開発、ならびに製造等に関わる不正なアクセスが行われる

おそれがある場合には、事前に弊社相談窓口までご連絡ください。 
不正使用が発覚した場合には、速やかに弊社相談窓口までご連絡ください。 
弊社相談窓口 ファーストコンタクトセンター 
 電話番号  03-3455-5800 

 
 

注 意 
この装置は、クラスＡ情報技術装置です。この装置を家庭環境で使用すると電波妨害を引

き起こすことがあります。この場合には使用者が適切な対策を講ずるよう要求されること

があります。 
VCCI-A 

 

高調波適合品 

この装置は、高調波電流規格 JIS C 61000-3-2 適合品です。 

：JIS C 61000-3-2 適合品とは、日本工業規格「電磁両立性－第 3-2 部：限度値－高調波電流発生限度値（1 相

当たりの入力電流が 20A 以下の機器）」に基づき、商用電力系統の高調波環境目標レベルに適合して設計・製

造した製品です。 

 

回線への接続について  

本体を公衆回線や専用線に接続する場合は、本体に直接接続せず、技術基準に適合し認定されたボードまたは

モデム等の通信端末機器を介して使用してください。 

 

電源の瞬時電圧低下対策について  

この装置は、落雷等による電源の瞬時電圧低下に対し不都合が生じることがあります。電源の瞬時電圧低下対

策としては、交流無停電電源装置（UPS）等を使用されることをお勧めします。 

 

レーザ安全基準について  

この装置にオプションで搭載される光学ドライブは、レーザに関する安全基準（JIS C-6802、IEC 60825-1）ク

ラス 1 に適合しています。 

 

 

Vietnum 

Complying with “CIRCULAR, No.30/2011/TT-BCT (Hanoi, August 10 2011), Temporary 

regulations on content limit for certain hazardous substances in electrical products” 
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the Ukraine 

 

English Declaration of Conformity 

with the requirements of Technical Regulation on the Restriction Of the use of certain 
Hazardous Substances in Electrical and Electronic Equipment 

(adopted by Order №1057 of Cabinet of Ministers of Ukraine) 

 

The Product is in conformity with the requirements of Technical Regulation on the 
Restriction Of the use of certain Hazardous Substances in electrical and electronic 
equipment (TR on RoHS). 

 

The content of hazardous substance with the exemption 

 of the applications listed in the Annex №2  of TR on RoHS: 

1. Lead (Pb) – not over 0,1wt % or 1000wt ppm; 

2. Cadmium (Cd) – not over 0,01wt % or 100wt ppm; 

3. Mercury (Hg) – not over 0,1wt % or 1000wt ppm; 

4. Hexavalent chromium (Cr6+) – not over 0,1wt % or 1000wt ppm; 

5. Polybrominated biphenyls (PBBs) – not over 0,1wt % or 1000wt ppm; 

6. Polybrominated diphenyl ethers (PBDEs) – not over 0,1wt % or 1000wt ppm. 

Ukrainian Декларація про Відповідність 

Вимогам Технічного Регламенту Обмеження Використання деяких 
Небезпечних Речовин в електричному та електронному обладнанні 

(затвердженого Постановою №1057 Кабінету Міністрів України) 

 

Виріб відповідає  вимогам Технічного Регламенту Обмеження Використання 
деяких Небезпечних Речовин в електричному та електронному обладнанні (ТР 
ОВНР). 

 

Вміст небезпечних речовин у випадках, не обумовлених в Додатку №2 ТР 
ОВНР, : 

1. свинець(Pb) – не перевищує 0,1 % ваги речовини або в концентрації до 
1000 частин на мільйон; 

2. кадмій (Cd)– не перевищує 0,01 % ваги речовини або в концентрації до 
100 частин на  мільйон; 

3. ртуть(Hg) – не перевищує 0,1 % ваги речовини або в концентрації до 
1000 частин на мільйон; 

4. шестивалентний хром (Cr6+ ) – не перевищує 0,1 % ваги речовини або в 
концентрації до 1000 частин на мільйон; 

5. полібромбіфеноли (PBB) – не перевищує 0,1% ваги речовини або в 
концентрації до 1000 частин на мільйон; 

6. полібромдефенілові ефіри (PBDE) – не перевищує 0,1 % ваги речовини 
або в концентрації до 1000 частин на мільйон. 

Russian Декларация о Соответствии 

Требованиям Технического Регламента об Ограничении Использования 
некоторых Вредных Веществ в электрическом и электронном оборудовании 

(утверждённого Постановлением №1057 Кабинета Министров Украины) 

 

Изделие соответствует требованиям Технического Регламента об Ограничении 
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Использования некоторых Вредных Веществ в электрическом и электронном 
оборудовании (ТР ОИВВ). 

Содержание вредных веществ в случаях, не предусмотренных Дополнением 
№2 ТР ОИВВ: 

1. свинец (Pb) – не превышает 0,1 % веса вещества или в концентрации 
до 1000 миллионных частей; 

2. кадмий (Cd) – не превышает 0,01 % веса вещества или в концентрации 
до 100 миллионных частей; 

3. ртуть (Hg) – не превышает 0,1 % веса вещества или в концентрации до 
1000 миллионных частей; 

4. шестивалентный хром (Cr6+)– не превышает 0,1 % веса вещества или в 
концентрации до 1000 миллионных частей; 

5. полибромбифенолы (PBB) – не превышает 0,1 % веса вещества или в 
концентрации до 1000 миллионных частей; 

6. полибромдифеноловые эфиры (PBDE) – не превышает 0,1 % веса 
вещества или в концентрации до 1000 миллионных частей. 

 

 

 

Disposing of your used product 

In the European Union 

EU-wide legislation as implemented in each Member State requires that used electrical and 
electronic products carrying the mark (left) must be disposed of separately from normal household 
waste. This includes Information and Communication Technology (ICT) equipment or electrical 
accessories, such as cables or DVDs. 
When disposing of used products, you should comply with applicable legislation or agreements 
you may have. The mark on the electrical and electronic products only applies to the current 
European Union Member States. 
 
Outside the European Union 

If you wish to dispose of used electrical and electronic products outside the European Union, 
please contact your local authority and ask for the correct method of disposal. 
 

 

India 

This product is RoHS compliant. 

 



   
 Warnings and Additions to This Document 
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Warnings and Additions to This Document 

1.  Unauthorized reproduction of the contents of this document, in part or in its entirety, is prohibited. 

2.  This document is subject to change at any time without notice. 

3.  Do not make copies or alter the document content without permission from NEC Corporation. 

4.  If you have any concerns, or discover errors or omissions in this document, contact your sales 

representative. 

5.  Regardless of article 4, NEC Corporation assumes no responsibility for effects resulting from your 

operations. 

6.  The sample values used in this document are not the actual values. 

 

Keep this document for future use. 

 

 

Latest editions 

This document was created based on the information available at the time of its creation. The screen images, 
messages and procedures are subject to change without notice. Substitute as appropriate when content has 
been modified. 

The most recent version of the guide, as well as other related documents, is also available for download from 
the following website. 

http://www.nec.com/ 
 

 

 
 
 
 
 

http://www.nec.com/�
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NEC Express5800 Series 
Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4 

Maintenance 
This chapter explains maintenance of server, and what actions are to be taken in case of trouble when operating 
this server.  

 

1. Transfer, Relocation, and Disposal 
Describes how to transfer this server to a third party. Also describes how to dispose, move and store this 
server. 

2. Daily Maintenance 
Describes what you must confirm for daily use, how to manage files, and how to clean the server. 

3. User Support 
Describes various services on this product.  

4. Maintenance of Express5800/ft series 
Describes how to start, stop, diagnose each components of ft server, and how to update firmware. 

5. Checking the Duplicating Operation of Modules 
Describes how to check if the system runs properly after system installation or reinstallation.  

6. Error Messages 
Describes error messages and actions to be taken at occurrence of an error. 

7. Collecting Failure Information 
Describes how to collect information about the location where a failure occurred and its cause when the 
server malfunctions. Refer to this section in case of a failure. 

8. Troubleshooting 
Describes how to identify the causes of problems and what actions are to be taken to address them. Refer to 
this section when you suspect a failure. 

9.  Windows System Recovery 
Describes Windows recovery setup. Refer to this section when Windows is corrupt.  

10. Resetting and Clearing the Server 
Describes how to reset or clear the server. Refer to this section when the server is not working or when you 
want to restore BIOS settings to the factory settings. 

11. System Diagnostics 
Describes the system diagnostics of this server. 

12. Offline Tools 
Describes tools for preventive maintenance of this product.  

 



1. Transfer, Relocation, and Disposal 
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1. Transfer, Relocation, and Disposal 

 

1.1  Transfer to a Third Party 

Observe the following precautions when you transfer (or sell) the server or software provided with the server to 
a third party. 

 

Server 

When transferring (or selling) the server to a third party, be sure to provide the server’s instruction manuals 
(including electronic manuals) to the third party. 

 

Data on the hard disk drive 

Be sure to erase the data stored in HDD to prevent the leakage of sensitive data (such as customer 
information or company management information) to any third parties. It is the user’s responsibility to erase 
the data. 

 

Important NEC assumes no liability for data leakage should the product be transferred 

to a third party without erasing the data. 

 

Data seems to be erased when you empty "Recycle Bin" of Windows or execute the "format" command of 
the operating system. However, the actual data remains on the hard disk drive. Data not erased completely 
might be restored by special software and used for unexpected purposes. 

 

Bundled software 

Observe the following precautions when transferring (selling) the bundled software to a third party. 

– Transfer them with the server. 

– All provided media and documents must be transferred and no backup copies must be retained. 

– Transfer requirements listed in "Software License Agreement" that comes with each software application 

must be satisfied. 

– Software on client PC must be uninstalled before transferring. 
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1.2  Disposal of the Server and Consumables 

• Dispose of the server, hard disk drives, option board, and battery according to laws and regulations of the 
central and/or local government. Also dispose of the power cord attached to this product together with the 
server to prevent diversion to other products. 

 

Note • For disposal (or replacement) of the battery on the mother board of the server, 
consult with your sales representative. 

• It is the user’s responsibility to completely erase all data stored on storage 
devices such as hard disk drives, backup data cartridges, or any other media 
(such as CD-R/CD-RW) so that the data cannot be restored by a third party. 

 

• Some components including fans, batteries, and the optical disk drive work for a limited period of time and 
require replacement. For stable operation of the server, NEC recommends you regularly replace these 
components. Contact your sales representative for information on replacement or the lifetime of components.  
 

 

 

1.3  Regarding the Transportation of This Server 

This server and/or some of the associated optional devices uses lithium metal batteries or lithium ion batteries. 
Regulations for air/ocean transportation apply when transporting lithium batteries. Conform to the regulations if 
you want to transport this server or optional devices by air or ship. 
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1.4  Relocation and Storage 

Follow the steps below when you move or store this server. 

 

WARNING
  

  

  

  

 

Be sure to observe the following precautions to use the server safety. Failure to 

observe the precautions may cause death or serious injury. For details, refer to

Safety precautions in Precautions for Use in "User’s Guide". 

• Do not disassemble, repair, or alter the server. 

• Do not remove the lithium battery, NiMH, or Li-ion battery. 

• Disconnect the power plug before installing or removing the server. 

  

 

CAUTION  
  

  

 

Be sure to observe the following precautions to use the server safely. Failure to 

observe the precautions may cause burns, injury, and property damage. For 

details, refer to Safety precautions in Precautions for Use in "User’s Guide". 

• Make sure to complete installation. 

• Do not get your fingers caught. 

• Be careful of handling internal components that may be at high 
temperatures. 

  

 

Note • If the server needs to be relocated/stored due to a change in the floor layout to 
a great extent, contact your service representative. 

• If the server has hard disk drives, move the server while being careful not to 
damage the drive. 

• When storing the server, monitor the environmental conditions of the storage 
area (temperature: −10°C to 55°C, humidity: 20% to 80%). (No dew 
condensation is permitted) 

 

Tips Make backup copies of important data stored in the hard disk drive. 

 

1.  Remove the media from the optical disk drive. 

2.  Power off the server (POWER LED goes off). 

3.  Unplug the power cord of the server from the power outlet. 

4.  Disconnect all the cables from the server. 

5.  Remove CPU/IO modules and 4U frame. 

6.  Carry the removed CPU/IO modules and 4U frame separately. 

7.  Pack the server securely to protect from damage, shock, and vibration. 
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Important If this server and internal optional devices are suddenly moved from a cold 

place to a warm place, condensation will occur and cause malfunctions and 

failures when these are used in such state. Wait for a sufficient period of time 

before using the server and other components in the operating environment. 

 

Note • Check and adjust the system clock before operating after relocating or storing 
the server.  

• If the system clock time is significantly delayed or advanced over time in spite 
of adjustment, contact your sales representative. 
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2. Daily Maintenance 

To use this server under top conditions at all times, periodically check and perform maintenance as follows. If 
abnormalities are found, ask your sales representative, avoiding impossible operation. 

 

 

2.1  Checking and Applying Updates 

Express5800 Series posts update information for BIOS, FW (firmware), driver, and others of the server and 
peripheral devices on our website. We recommend that the latest update always be applied for stable system. 

 

NEC corporate site: http://www.nec.com/ 

[Support & Downloads] 

 

NEC also provides ExpressUpdate that supports the detection, download, and application of the updates that 
must be applied to BIOS and FW (firmware) of the server. 

ExpressUpdate is contained in EXPRESSBUILDER provided with the server. 

 

Tips • Download and apply the latest update yourself. 

• NEC recommends that you back up data for a rainy day before applying the 
latest update. 

 

 

2.2  Checking Alerts 

Use NEC ESMPRO Manager (for Windows) to constantly verify that no abnormalities are detected on the 
monitored server and that no alerts have been issued.  

 
Example image of NEC ESMPRO Manager 

 

 

NEC ESMPRO Manager AlertViewer 
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2.3  Checking STATUS LED 

Check LED indication when: 

• Power on the server and while the server is running. 

• Before shutting down the server. 

 

LEDs to be checked: 

• LEDs located at front of the server 

 

 

• LEDs on hard disk drives installed in 2.5-inch hard disk drive bay 

 

If the indicator shows the server abnormality, contact your sales representative. 

For the functions and descriptions of the LED, see Chapter 1 (6.1 Error Messages by LED Indication). 

 

 

Slot 0 Slot 2 Slot 4 Slot 6 

Slot 1 Slot 3 Slot 5 Slot 7 

Slot 0 Slot 2 Slot 4 Slot 6 

Slot 1 Slot 3 Slot 5 Slot 7 
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2.4  Making Backup Copies 

NEC recommends you make backup copies of your valuable data stored in hard disks of the server on a regular 
basis. For backup storage devices suitable for the server and backup tools, consult with your sales agent. 

 

When you have changed the hardware configuration or BIOS configuration, make a backup copy of the system 
information according to Chapter 1 (7. Backing Up System Information) in Installation Guide. 

 

2.5  Cleaning 

Regularly clean the server to keep it in good condition. 

 

WARNING
  

  

  

 

Be sure to observe the following precautions to use the server safety. Failure to 

observe the precautions may cause death or serious injury. For details, refer to

Safety precautions in Precautions for Use in "User’s Guide". 

• Do not disassemble, repair, or alter the server.  

• Disconnect the power plug before cleaning the server.  
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2.5.1  Cleaning the Express5800/ft series 

For daily cleaning, wipe the external surfaces of the server with a dry soft cloth. Follow the procedure below if 
stains remain on the surfaces: 

 

Important • To avoid altering the material and color of the server, do not use volatile solvents 
such as thinner or benzene to clean the server. 

• The power receptacle, the cables, the connectors on the rear panel of server, and 
the inside of the server must be kept dry. Do not moisten them with water. 

 

1. Power off the server. 
1. Make sure that the server is powered off. 
2. Unplug the power cord of the server from a power outlet. 

2. Clean the power plug. 
Wipe off dust from the power cord plug with a dry cloth. 

3. Clean the server. 
1. Soak a soft cloth in neutral detergent that is diluted with cold or warm water, and squeeze it firmly. 
2. Rub off stains on the server with the cloth prepared in Step 1. 
3. Soak a soft cloth in water, squeeze it firmly and wipe the server with it once again. 
4. Wipe the server with a dry cloth. 

4. Clean the rear panel of the server. 
Wipe off dust from the fan exhaust opening on the rear of the server with a dry cloth. 
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2.5.2  Cleaning Tape Drive 

A dirty tape drive head causes unsuccessful file backup and damages the tape cartridge. Periodically clean the 
tape drive with the designated cleaning tape. 

For the cleaning interval and method, the estimated usable period and lifetime of the tape cartridge, refer to the 
instructions attached to the tape drive. 

 

2.5.3  Cleaning the Keyboard and Mouse 

A keyboard and a mouse use USB interface. Therefore it is not necessary to power off the server when 
connecting or disconnecting them. 

1.  Disconnect the mouse from the USB port of the keyboard. 

2.  Wipe the surface of the keyboard and mouse with a dry cloth 

3.  Wipe the sensor with a dry cloth to remove any dirt or dust. 

 

2.5.4  Cleaning Optical Disk 

A dusty optical disk or dust-accumulated tray causes the device to fail to read data correctly. 
Follow the procedure below to clean the tray and optical disk regularly: 

1.  Make sure that the server is powered on (POWER LED is lit). 

2.  Press the Eject button on the front of the optical disk drive. 
The tray comes out. 

3.  Hold the optical disk lightly and take it out from the tray. 

 

Important Do not touch the signal side of the optical disk with your hand. 

 

4.  Wipe the tray with a dry soft cloth. 

 

Important Do not wipe the lens of the optical disk drive. Doing so may damage the lens and 

may cause a malfunction of the drive. 

 

5.  Gently push the tray to close the tray. 

6.  Wipe the signal side of the optical disk with a dry soft cloth. 

 

Important Wipe optical disks from the center to the outside. Use only CD-ROM cleaner if 

necessary. Cleaning an optical disk with record spray/cleaner, benzene, or thinner 

causes damage to the optical disk contents. At worst, inserting the DVD/CD-ROM 

into the server may cause failure. 
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3. User Support 

Before getting after-sales service, check the contents of the warranty and service. 

 

3.1  Maintenance Services 

Service representatives from NEC subsidiary companies or companies authorized by NEC provide 
maintenance services. For the services, contact your sales representative.  

 

3.2  Before Asking for Repair 

If you think that a failure occurred, follow the steps below: 

 

1. Check if the power cord and cables to other products are properly connected. 

2. Check LED indications and alarm messages on display unit. See Chapter 1 (6. Error Messages).  

3. See Chapter 1 (8. Troubleshooting). If you find a symptom similar to your problem, take the action as 
instructed. 

4. Confirm that the required software has been properly installed. 

5. Scan for viruses using a commercial Antivirus Software. 

 

If the problem persists after taking the measures above, contact your sales representative. Take notes on LED 
indications and the display on the screen at the failure, which will be useful information for the repair. 
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4. Maintenance of Express5800/ft series 

Express5800/ft series can be maintained in two ways. 

• To use NEC ESMPRO Manager for remote maintenance 

• To use the ft server utility on the Express5800/ft series for local maintenance. 

 

Tips To start the ft server utility, select menus as follows: 

Start → Programs → NEC ESMPRO Agent → ft server utility 

 

The table below lists the availability of maintenance features common to all components. 

 

Component 

Maintenance features 
General CPU module PCI module 

SCSI 
enclosure 

Firmware 
under BMC

Start – Remote / Local Remote / Local – – 

Stop – Remote / Local Remote / Local – – 

View MTBF information – Remote / Local Remote / Local – – 

MTBF clear – Remote / Local Remote / Local – – 

Diagnosis – Remote / Local Remote / Local – – 

Dump collection – Remote / Local – – – 

Board switch – Remote / Local – – – 

BIOS Update – Remote / Local – – – 

F/W update – – – – Local 

Quick dump Local – – – – 

Auto firmware update Local – – – – 

Auto module start Local – – – – 

 
Remote: Executable from remote management PC by using NEC ESMPRO Manager 
Local: Executable on local server by using ft server utility 
–: Not supported 

 

Tips The server does not support maintenance feature for the components listed below. 
• Internal devices 

SCSI adapter under PCI module 
Ethernet board under PCI module 
Network port of Ethernet board under PCI module 
SCSI enclosure and SCSI slots under the enclosure 

• Optional devices 

 

Important • Consult with your maintenance personnel to use the maintenance features. 

• Perform the following steps before replacing component. 
1. Clear MTBF information of relevant component. 
2. Stop the relevant CPU module and PCI module. 
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4.1  Start and Stop of Components 

This section describes how to start or stop components. 

 

Important Use this feature to stop the relevant CPU module and PCI module before replacing 

component. 

 

If a component fails or needs to be replaced, Express/ft series allows you to forcibly stop the component. The 
stopped component can also be restarted. 

 

4.1.1  Available status 

 

The table below shows the potential cases in which the dump is acquired. 

Component 

State of component 

Start Stop 

CPU module ・Power supply stop 
・Broken 
・Forced stop 
・Firmware Update Complete 
・Diagnostics Passed 

・Duplex 

PCI module ・Power supply stop 
・Broken 
・Forced stop 
・Firmware Update Complete 
・Diagnostics Passed 

・Duplex 

 

Tips You can view the state of component by NEC ESMPRO Manager or ft server utility. 
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4.1.2  Procedure in NEC ESMPRO Manager 

 
Perform the procedure below to start component. 

1.  Select General screen of the target component under the ft System tree in Information of server 
state/constitution. 

2.  Check that the current status of the target component is available. The status is shown on Status 
Information display of General screen. 

3.  Select Maintenance screen and click the Execute button of Bring Up operation. 

 

Tips • The target component starts after a while. 

• The start result can be verified by "State" in the General screen of target component. 
The result of the start operation is reported by the Express5800/ft series as an alert. 

 

Perform the procedure below to stop the component. 

1.  Select General screen of the target component under the ft System tree in Information of server 
state/constitution. 

2.  Check that the current status of the target component is available. The status is shown on Status 
Information display of General screen. 

3.  Select Maintenance screen and click the Execute button of Bring Down operation. 

 

Tips • The target component stops after a while. 

• The stop result can be verified by "State" in the General screen of target component. 
The result of the stop operation is reported by the Express5800/ft series as an alert. 

 

Sample screen of NEC ESMPRO Manager 

 

Maintenance screen of CPU Module 
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4.1.3  Procedure in the ft server utility 

 
Perform the procedure below to start component. 

1.  Select the target component by using the ft server utility. 

2.  Check the current state of the target component by selecting View menu → Refresh on ft server utility. 

3.  Click the Up button of the target component. 

 

Tips • The target component starts after a while. 

• The start result can be verified by "State" of target component.  
Note that state display is not refreshed automatically, you need to select View menu → 
Refresh of ft server utility to check the current status. 

 
Perform the procedure below to stop the component. 

1.  Select the target component by using the ft server utility. 

2.  Check the current state of the target component by selecting View menu → Refresh on ft server utility. 

3.  Click the Down button of the target component. 

 

Tips • The target component stops after a while. 

• The stop result can be verified by "State" of target component.  
Note that state display is not refreshed automatically, you need to select View menu → 
Refresh of ft server utility to check the current status. 

 

Sample screen of ft server utility 
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4.2  Check and Clear of MTBF Information 

The MTBF information of a component can be viewed or cleared (initialized). 

 

Important Stop the relevant CPU module and PCI module before replacing components. 

 

Express5800/ft series manages the MTBF (mean time between failure) of each component. If a fault occurs in a 
component, the Express5800/ft series calculates the MTBF of the component again. If the calculated value is 
lower than the pre-defined threshold, the Express5800/ft series disables the component to be used. 

A disabled component with the MTBF lower than the threshold can be forcibly enabled by clearing the MTBF. 

 

Important Before clearing MTBF and forcedly enable the component, contact your 

maintenance personnel for the forced use of such a component. 

 

 

4.2.1  Available status 

 

The table below shows the potential cases in which the MTBF information can be cleared. 

Component Status of component 

CPU module ・Broken 
・MTBF is lower than the threshold. 

PCI module ・Broken 
・MTBF is lower than the threshold. 

 

Tips The status of component can be verified on screen of NEC ESMPRO Manager or ft server 
utility. 
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4.2.2  Procedure in NEC ESMPRO Manager 

 

Perform the procedure below to clear MTBF information of component. 

 

1.  Select General screen of the target component under the ft System tree in Information of server 
state/constitution. 

2.  Check that the current status of the target component is available. The status is shown on Status 
Information display of General screen. 

3.  Select Maintenance screen and click the Execute button of MTBF Clear operation. 

Tips The MTBF clearing result can be verified by "Status Information" in General on the target 
component screen. The result of the MTBF clearing operation is reported by the 
Express5800/ft series as an alert. 

 

4.  Start the target component. 

 

Sample screen of NEC ESMPRO Manager 

 

Maintenance screen of CPU Module 
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4.2.3  Procedure in the ft server utility 

 

Perform the procedure below to clear MTBF information of component. 

 

1.  Select the target component by using the ft server utility. 

2.  Check the current state of the target component by selecting View menu → Refresh on ft server utility. 

3.  Click the Clear button in MTBF Clear of the target component. 

 

Tips The MTBF clearing result can be verified by "Status Information" of the target component. 
Note that state display is not refreshed automatically, you need to select View menu → 
Refresh of ft server utility to check the current status. 

 

4.  Start the component. 

 

Sample screen of ft server utility 

 

PCI Module 
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4.3  Diagnostics 

 

You can diagnose the server components. 

The Express5800/ft series provides the self-check diagnosis function for some components. If a fault occurs in a 
component, the Express5800/ft series can diagnose the component to detect the fault. 

 

Note Stop the target component before starting diagnostics, it is is running. 

 

 

4.3.1  Available status 

The table below shows the potential cases in which a component is to be diagnosed. 

Component Status of component 

CPU module ・Power supply stopped 
・Broken 
・Forcibly stopped 
・Firmware Update Complete 

PCI module ・Power supply stopped 
・Broken 
・Forcibly stopped 
・Firmware Update Complete 

 

Tips The status of component can be verified on screen of NEC ESMPRO Manager or ft server 
utility. 
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4.3.2  Procedure in NEC ESMPRO Manager 

 
Take the procedures below to diagnose the component. 

 
1.  Select General screen of the target component under the ft System tree in Information of server 

state/constitution. 

2.  Check that the current status of the target component is available. The status is shown on Status 
Information display of General screen. 

3.  Select Maintenance screen and click the Execute button of Diagnostics operation. 

Tips • The diagnosis result can be verified by Diagnostics Information in Maintenance 
screen. If a fault is detected by the result of the diagnosis, the state of the General tree 
of the component is changed. In addition, the result of the diagnosis is reported by the 
Express5800/ft series as an alert. 

• The result of diagnosis executed last is displayed in the Diagnostics Information in 
Maintenance screen. 

 

 

Sample screen of NEC ESMPRO Manager 

 

Maintenance screen of CPU Module 
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4.3.3  Procedure in the ft server utility 

 

Take the procedures below to diagnose the component. 

 
1.  Select the target component by using the ft server utility. 

2.  Check the current state of the target component by selecting View menu → Refresh on ft server utility. 

3.  Click the Diagnostics button in the Diagnosis Information on the target component. 

 

Tips The diagnosis result can be verified in "Result" on the target component. The result of 
diagnosis executed last is displayed in the Diagnosis Information. 

Note that state display is not refreshed automatically, you need to select View menu → 
Refresh of ft server utility to check the current status. 

 

4.  Start the component. 

 

Sample screen of ft server utility 

 

PCI Module 
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4.4  Dump Collection 

 

Take the steps below to collect dump. 

 

Important Collect dump upon request from maintenance personnel. 

 

If a failure or malfunction occurs on Express5800/ft series, you can collect dump for the examination of a fault. 

The dump file is collected with the same path and file name "%SystemDrive%\NECDump\MEMORY.DMP" as the 
dump file of the OS standard. 

 

Note Dump collection can be performed only in the duplex system. 

Either of the CPU modules is entered into the offline state and the dump is collected during 
system operation. After the acquisition, the CPU module is returned to the state specified 
by setting for auto start. If auto start feature is disabled, the module does not go to online 
state automatically. 

 
 

4.4.1  Available status 

 

The table below shows the potential cases in which the dump is acquired. 

Component Status of component 

CPU module Duplex 

 

Tips The status of component can be verified on screen of NEC ESMPRO Manager or ft server 
utility. 
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4.4.2  Procedure in NEC ESMPRO Manager 

 

Take the steps below to collect dump. 

 

1.  Select General screen of the target CPU module under the ft System tree in Information of server 
state/constitution. 

2.  Check that the current status of the target component is available. The status is shown on Status 
Information display of General screen. 

3.  Select Maintenance screen and click the Execute button of Dump operation. 

Tips • A certain time is required for the dump saving. The dump is stored 
as %SystemDrive%\NECDump\MEMORY.DMP on the managed server. 

• The result of the dump saving is reported by the Express5800/ft series as an alert. 

 

 

Sample screen of NEC ESMPRO Manager 

 

Maintenance screen of CPU Module 
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4.4.3  Procedure in ft server utility 

 
Take the steps below to collect dump. 

 
1.  Select the target CPU module by using the ft server utility. 

2.  Check the current state of the target component by selecting View menu → Refresh on ft server utility. 

3.  Select the dump acquisition method with Dump of the target CPU module and click the Harvest button. 

 

Tips A certain time is required for the dump acquisition. 

The dump is stored as %SystemDrive%\NECDump\MEMORY.DMP on the server. 

The result of the dump acquisition can be verified in the event log. 

 

Sample screen of ft server utility 

 

CPU Module 
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4.5  BIOS Update 

 

The BIOS of CPU module can be updated. 

 

4.5.1  Available status 

 

The BIOS of CPU module can be updated with CPU module in online state (system is continuously running, but 
the target CPU module is in halt state). 

 

The table below shows the potential cases in which the BIOS update can be performed. 

Component Status of component 

CPU module ・Power supply stopped 

 

Tips The status of component can be verified on screen of NEC ESMPRO Manager or ft server 
utility. 
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4.5.2  Procedure in NEC ESMPRO Manager 

 
Take the steps below to update BIOS of CPU module. 

 

Important To update BIOS of CPU module, a BIOS image file for updating needs to be stored on 

Express5800/ft series. 

 
1.  Save the BIOS image file for update in the desired folder in Express5800/ft series. Take a note of path to 

that folder. 

2.  Select General screen of the target CPU under the ft System tree in Information of server 
state/constitution. 

3.  Check that the current status of the target component is available. The status is shown on Status 
Information display of General screen. 

4.  Select Update screen and click the Execute button of Firmware Update. 

Sample screen of NEC ESMPRO Manager 

 

Update screen of CPU Module 
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5.  Select Specify the file path to update, enter the path for BIOS image file you have recorded in Step 1 
into absolute path box, and click Apply. 

 

6.  When you click OK on confirmation dialog box, firmware update starts. 

 

Tips The update result can be verified by Status Information of General of target component 
("Firmware update completed" is displayed). In addition, the result of the update is reported 
by the Express5800/ft series as an alert. 

 

7.  When BIOS update completes, open Update screen, and click Execute button on Jump Switch. 

 

8.  When you click OK on confirmation dialog box, the CPU module of which BIOS has been updated starts, 
and the other CPU module stops. 
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9.  Click Execute button in Firmware Update on Update screen of the CPU module in halt status. 

 

10.  Select Copy online BIOS image to Offline and click Apply. 

 

 

11.  When you click OK on confirmation dialog box, the firmware is updated. 

12.  Start CPU module. 
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4.5.3  Procedure in the ft server utility 

 

Take the steps below to update BIOS of CPU module. 

 

Important To update BIOS of CPU module, a BIOS image file for updating needs to be stored on 

Express5800/ft series. 

 

1.  Save the BIOS image file for update in the desired folder in Express5800/ft series. Take a note of path to 
that folder. 

2.  Select either one CPU module from ft server utility. 

3.  Check the current state of the target CPU module by selecting View menu → Refresh on ft server utility. 
If the target CPU module is operating, stop it. 

4.  Click Update on Firmware... of CPU module screen. 

 

Sample screen of ft server utility 

 

CPU module 
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5.  Select Specify new firmware for update, enter the path for BIOS image file you have recorded in Step 
1 into box, and click Activate. 

The firmware update starts. 

 

Tips The update result can be verified by "State" of target component.  
Note that state display is not refreshed automatically, you need to select View menu → 
Refresh of ft server utility to check the current status. 

 

 

6.  Verify the firmware update status. 

It takes about 25 minutes until the firmware update completes from start of update. 

When firmware update completes, verify the firmware revision shows the one you expected. 

Tips Pressing the <F5> key refreshes the display of ft server utility. 
Display changes according to progress of update process. 

"Updating firmware" → "Update firmware, Simplex" or "Simplex, update firmware ", then 
"Duplex" when firmware update completes. 

 

7.  When BIOS update completes, click Switch. 
The CPU module of which BIOS has been updated starts, and the other CPU module stops. 

8.  Click Firmware Update on Update screen of the CPU module in halt status. 

9.  Select Copy firmware from Online module to Offline one on Firmware Update screen, and click 
Activate. 

10.  Start the CPU module. 
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4.6  BMC Firmware Update 

 

The BMC firmware can be updated. 

 

Important Consult with your maintenance personnel before updating BMC firmware. 

 

Tips Express5800/ft server has BMC on each of PCI modules 0 and 1. With the procedure 
described below, both BMCs are automatically updated. 

 

 

4.6.1  Available status 

 

The table below shows the potential cases in which the BMC firmware can be updated. 

Component Status of component 

Firmware under 
BMC 

・Duplex, Duplex 

 

Tips The status of component can be verified on screen of ft server utility. 

 



4. Maintenance of Express5800/ft series 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 46

Chapter 1  Maintenance 

4.6.2  Procedure in the ft server utility 

 

Take the steps below to update BMC firmware. 

 

Important To update BMC firmware, a firmware image file for updating needs to be stored on 

Express5800/ft series. 

 
1.  Click Firmware... on Firmware. 

The Firmware Update dialog box appears. 

 

2.  Specify the location to store the firmware, and click Activate. 

Confirmation dialog box appears. 

 

3.  Click OK. 

Firmware update starts. 
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4.7  Setup of System Operation 

 

The following properties can be set as the operation setup of the whole system. 

 

Quick dump 

If this property is enabled (by checking "Enable" on the setup screen), the dump is acquired in parallel with 
the system startup if a fault occurs in the system. If this property is disabled, the dump is acquired by the 
dump function normally provided by OS. 

The initial setup value is "Disable". 

Auto firmware update 

If a new CPU module containing BIOS different from that of the existing CPU module in version with this 
property being enabled (by checking "Enable" on the setup screen), the BIOS of the new CPU module is 
updated to the BIOS of the existing CPU module to match with each other. If this property is disabled, the 
BIOS of the new CPU module is not updated automatically. 

The initial setup value is "Enable". 

Auto module start 

When this property is set to Enable (select it on the setting screen), the newly inserted CPU/PCI module is 
automatically started and becomes operable. If this property is set to Disable, auto-start is not performed. 
When the OS is started with this property set to Disable, the auto-start for CPU module is not performed, but 
the PCI module is started automatically. 

The initial setup value is "Enable". 
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4.7.1  Procedure in the ft server utility 

 

Take the steps below to setup system operation. 

 

Important • Consult with your maintenance personnel before changing setting for system 
operation. 

• The new setting becomes valid after restart of system. 
Be sure to restart the system though you are not prompted on utility screen. 

 

1.  Select General in the ft server tree. 

2.  Check the property of carrying out the modification with System Settings (or cancel the check). 

3.  Click the Apply button. 

Sample screen of ft server utility 
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5. Checking the Duplicating Operation of Modules 

 

This section describes how to check if the system runs properly after system installation or reinstallation.  

 

Tips CPU/IO module has a processor function part and IO function part. Each part is monitored 
and managed by the module. In this section, the processor function part is referred to as 
CPU module and IO function part PCI module. 

 

 

5.1  Evaluate Startup and Stop of PCI Modules 

 

This section describes how to confirm the continuous system operation by failover after stopping the primary 
CPU/IO module.  

1.  Check which is the primary CPU/IO module.  

 

Tips The PCI module with the PRIMARY LED illuminated is the primary module.  

 
2.  Check whether the CPU/IO modules are duplicated.  

 

Tips To check if the CPU/IO modules are duplicated, see the System FT LED.  

 

 
 

②

む

① 

③ 

(2) 

(1)

(3) 
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Indications of the status LEDs when CPU/IO modules are duplicated 

LED Primary Secondary 

1 PRIMARY LED On (Green) – 

2 DISK ACCESS LED Blinking (Green) Blinking (Green) 

 

LED System 
3 System FT LED On (Green) 

* The numbers in table above correspond to those shown in figure above. 
DISK ACCESS LED (2) lights only when hard disk drive is accessed. 

 

3.  Select Start - All Programs - NEC ESMPRO Agent - ft server utility to start the ft server utility.  

4.  Then, from the ft server utility, select PCI Module and then the primary PCI module (*) from the ft server 
tree on the left pane. 
   - Select PCI module (ID:10) when CPU/IO module 0 is primary module. 
   - Select PCI module (ID:11) when CPU/IO module 1 is a primary module. 

5.  Click Down of Bring Up/Bring Down 

 

Tips When you stop the operation of the primary PCI module, a failover occurs and the 
secondary PCI module becomes the primary module. 
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When the primary PCI module is stopped, the screen temporarily blacks out and then displayed again, 
and the status changes as follows. This indicates that PCI module is failed over. 

 

Indications of status LEDs 

LED Secondary* Primary* 

1 PRIMARY LED – On (Green) 

2 
DISK ACCESS LED 

– 
Blinking amber or green 
(Lights green when 
accessing the disk drive) 

 

LED System 
3 System FT LED – 

* The primary and secondary modules after failover 

 

6.  Restart the stopped PCI module.  

From the ft server utility, click Up of Bring Up/Bring Down to the PCI module which has been stopped, 
and the PCI module will be started.  

 

Tips When the PCI module is started, PCI module diagnosis, mirror volume duplication and PCI 
module duplication are performed.  

 

Important If ARCserve Backup or Backup Exec is installed and the backup software related 

services are operating at the time of PCI module startup, the PCI module is not 

duplexed properly may occur or backup software may not work properly.  

Thus be sure to stop the services before starting the PCI module. 

1. Start Services from Administrative Tools of Control Panel. 

2. Select a service of backup software. 

3. Choose "Stop" from the "Action" menu. 

4. Repeat steps 2 and 3 for all services of the backup software. 

If the PCI module is started with these services being operated, stop the PCI module 

first, then stop the services related to backup software, then try again. 

 

Tips You can stop or start services collectively by using the batch file. 

• ARCserve Backup (Stop collectively) 
C:\Program Files (x86)\CA\ARCserve Backup\cstop.bat 

• ARCserve Backup (Start collectively) 
C:\Program Files (x86)\CA\ARCserve Backup\cstart.bat 

• Backup Exec (Stop collectively) 
C:\Program Files\Symantec\Backup Exec\bestop.bat 

• Backup Exec (Start collectively) 
C:\Program Files\Symantec\Backup Exec\bestart.bat 

The path name shown above is assigned when the software is installed with default setting.
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The PCI modules’ status LEDs changes as shown below:  

Indications of the status LEDs 

Immediately after the PCI module startup until the completion of diagnosis: 

LED Secondary Primary 

1 PRIMARY LED – On (Green) 

2 
DISK ACCESS LED – Blinking amber or green 

(Lights green when 
accessing the disk drive) 

 

LED System 

3 System FT LED – 

 

When duplication of disks is started after the completion of PCI module diagnosis: 

* The status of LEDs varies depending on the method of disk duplication.  

LED Secondary Primary 

1 PRIMARY LED – On (Green) 

2 
DISK ACCESS LED Blinking amber or green 

(Lights green when 
accessing the disk drive) 

Blinking amber or green 
(Lights green when 
accessing the disk drive) 

 

LED System 

3 System FT LED – 

 

After the completion of mirror volume duplication and when the PCI modules are duplicated: 

LED Secondary Primary 

1 PRIMARY LED – On (Green) 

2 DISK ACCESS LED Blinking (Green) 
(Lights green when 
accessing the disk drive) 

Blinking (Green) 
(Lights green when 
accessing the disk drive) 

 

LED System 

3 System FT LED On (Green) 

 

Important After duplication is completed, the FT LED lights in green. Do not perform the 

evaluation of start and stop unless the above process is completed. 

 

 



5. Checking the Duplicating Operation of Modules 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 53

Chapter 1  Maintenance 

5.2  Confirm Start and Stop of CPU Modules 

 

This section describes how to confirm the continuous system operation after stopping one of the CPU modules. 

 

1.  Confirm that the CPU modules are duplicated. 

 

Tips To check if the CPU modules are duplicated, see the System FT LED.  

 

 

 

Indications of status LEDs when CPU modules are duplicated 

LED CPU/IO module 0 (Operating) CPU/IO module 1 (Operating) 

1 PRIMARY LED On (Green) – 

2 DISK ACCESS LED Blinking (Green) 
(Lights green when accessing to 

HDD) 

Blinking (Green) 
(Lights green when accessing to 

HDD) 

 

LED System 

3 System FT LED On (Green) 

* The numbers in table above correspond to those shown in figure above. 
DISK ACCESS LED (2) lights only when hard disk drive is accessed. 

 

2.  From Start, select All Programs, NEC ESMPRO Agent then ft server utility to start the ft server utility. 

3.  From the ft server utility, select CPU Module then the CPU module to stop (*) from the ft server tree on 
the left pane. 
- Select CPU module (ID:0) to stop CPU/IO module 0. 
- Select CPU module (ID:1) to stop CPU/IO module 1. 

②

む

① 

③ 

(1) 

(3) 

(2)
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4.  Click Down of Bring Up/Bring Down. 

 

When you stop the operation of a CPU module, the indications of the status LEDs change as follows.  
Below denotes that the only one CPU module is operating.  

Indications of status LEDs 

LED CPU/IO module 0 (Stopped)* CPU/IO module 1 (Operating) 

1 PRIMARY LED On (Green) – 

2 DISK ACCESS LED Blinking amber or green 
(Lights green when accessing the 

disk drive) 

Blinking amber or green 
(Lights green when accessing the 

disk drive) 

 

LED System 

3 System FT LED – 

* As an example, the indications of when CPU/IO module 0 is stopped are shown.  
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5.  Press the Start button of the CPU module stopped by ft server utility.  
In the ft server utility, select the stopped CPU module and click Up of Bring Up/Bring Down. 

 

Tips When the CPU module is started, hardware diagnosis and then synchronization of 
memory (memory copy) are performed, and the duplication process is completed.  
Note that the system is paused temporarily for copying memory during memory 
synchronization.  

 
Indications of status LEDs after completion of duplication 

LED CPU/IO module 0 (Operating) CPU/IO module 1 (Operating) 

1 PRIMARY LED On (Green) – 

2 DISK ACCESS LED Blinking (Green) 
(Lights green when accessing the 

disk drive) 

Blinking (Green) 
(Lights green when accessing the 

disk drive) 

 

LED System 

3 System FT LED On (Green) 

 

Important After duplication is completed, the System FT LED lights in green. Do not perform 

the evaluation of start and stop unless the above process is completed.  
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6. Error Messages 

The following errors are notified if the server is faulty. 

 
• LED indication is unusual. 

→ See "6.1 Error Messages by LED Indication". 

• An error message appeared. 
→ See "6.2 POST". 

• Warning or error message appeared on event log. 
→ See "6.3 List of Windows Event Logs". 

• Blue screen appeared. 
→ See "6.4 Error Message on Windows Server". 
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6.1  Error Messages by LED Indication 

LEDs on the front and rear panels of the server and near the handles of hard disk drives notify the various 
server statuses. If trouble seems to have occurred, check the LED indication. 

 

 

 

 

 

 

 

 

 

System POWER LED 

System FAULT LED 

System FT LED 

System ID LED 
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(1) System POWER LED 

 LED indication Description Action 

On (green) Either or both of CPU/IO modules are powered on. – 

Off Both of CPU/IO modules are powered off. – 

 

(2) System FAULT LED 

 LED indication Description Action 

Off Both of CPU/IO modules are offline or normal. System FAULT LED does NOT notify of 
Disk status. Check it according to 
(5)Disk Access LED indication. 

On (amber) One of the CPU/IO modules failed. Take a note of LED indications on 
EXPRESSSCOPE, and then contact 
your sales representative. 

Blinking (amber) One of the CPU/IO modules failed.  
Failed CPU/IO module cannot be identified. 

Contact your sales representative. 

 

(3) System FT LED 

 LED indication Description Action 

On (green) System is operating under duplex condition. – 

Off System is not duplexed. – 

Blinking (green) Active Upgrade is in progress. – 

 

(4) System ID LED 

LED indication Description Action 

On (blue) UID switch is pressed. – 

Blinking (blue) The device identification request is issued from 
remote site. 

– 

Off – – 

 

(5) Disk Access LED 

LED indication Description Action 

Off Disk is in the idle state. – 

Green Disk is being accessed. – 

Amber Disk is faulty. Contact your sales representative. 

Blinking (amber) The mirror of the disk is disconnected. Perform mirroring. 

Blinking in green and 
amber in turn 

The hard disk drive configuration (rebuild) is in 
progress. 

Wait for a while; the LED blinks in green 
after rebuild finishes. If the rebuild fails, 
the LED lights in amber. 
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(6) Access LED on optical disk drive 

LED indication Description Action 

Off Optical disk is not accessed. – 

On Optical disk is being accessed. – 

 

(7) LAN Connector LEDs on management port and LAN connectors 

LINK/ACT LED 

LED indication Description Action 

On (green) Power is supplied to the main unit and hub, and they 
are connected correctly ("LINK"). 

– 

Blinking (green) The network port is sending or receiving data (ACT). – 

Off Disconnected from network. Check the condition and connection of 
network cables. 

 

SPEED LED (Management port) 

LED indication Description Action 

On (green) Port is operating on 100BASE-T. – 

Off Port is operating on 10BASE-T. – 

 

SPEED LED (1G LAN connector) 

LED indication Description Action 

On (amber) Port is operating on 1000BASE-T. – 

On (green) Port is operating on 100BASE-TX. – 

Off Port is operating on 10BASE-T. – 

 

SPEED LED (10G LAN connector) 

LED indication Description Action 

On (amber) Port is operating on 1000BASE-T. – 

On (green) Port is operating on 1000BASE-TX. – 

Off Port is operating on 100BASE-T. – 
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(8) EXPRESSSCOPE 

Corresponding LED lights amber when modules have failures.  

 

 

 

(1) Module POWER LED 

LED indication Description Action 

On (green) The power of CPU/IO module is ON. – 

Off The power is not supplied to CPU/IO module. – 

Blinking (green) CPU/IO module is in standby state. – 

 

(2) SAFE TO PULL (SAFE TO PULL LED) 

This LED indicates the possibility to remove CPU/IO module safely. 

LED indication Description Action 

On (green) CPU/IO module can be removed. – 

Blinking (green) CPU/IO module cannot be removed. – 

Off CPU/IO module is in off line state. – 

 

(3) Module ID (ID LED) 

Module ID LED is used for identifying the device that requires maintenance among devices mounted on the 
rack. 

LED indication Description Action 

On (green) UID switch is pressed. – 

Blinking (green) The device identification request is issued from 
remote site. 

– 

Off – – 

 

(1) (2) (3) (4) (5)-4
(5)-2

(5)-3(5)-1

(11) (10) (9) (8) (7) (6)
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(4) CPU (CPU FAULT LED) 

The LED lights amber when the CPU part of CPU/IO modules fails. Contact your sales representative. 

 

(5) MEM NUMBER (Memory slot error LED) 

The LED lights amber when failure occurs on the memory slot 0 of CPU/IO module. 
Memory slots with errors can be identified by illumination status of the following (5)-1 to (5)-4. 

 

Status of memory slot error LED 

Description Action 
(5)-1 

(MSB) 
(5)-2 

 
(5)-3 

 
(5)-4 

(LSB) 

– – – – Operating normally – 

– – – ○ Error at memory slot 1 Contact your sales representative. 

– – ○ – Error at memory slot 2 Contact your sales representative. 

– – ○ ○ Error at memory slot 3 Contact your sales representative. 

– ○ – – Error at memory slot 4 Contact your sales representative. 

– ○ – ○ Error at memory slot 5 Contact your sales representative. 

– ○ ○ – Error at memory slot 6 Contact your sales representative. 

– ○ ○ ○ Error at memory slot 7 Contact your sales representative. 

○ – – – Error at memory slot 8 Contact your sales representative. 

– – – ● Error at memory slot 9 Contact your sales representative. 

– – ● – Error at memory slot 10 Contact your sales representative. 

– – ● ● Error at memory slot 11 Contact your sales representative. 

– ● – – Error at memory slot 12 Contact your sales representative. 

– ● – ● Error at memory slot 13 Contact your sales representative. 

– ● ● – Error at memory slot 14 Contact your sales representative. 

– ● ● ● Error at memory slot 15 Contact your sales representative. 

● – – – Error at memory slot 16 Contact your sales representative. 

○ ○ ○ ○ Error at unknown memory slot Contact your sales representative. 

○: LED is lit. 
●: LED is blinking. 
–: LED is unlit. 
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(6) TEMP (Abnormal temperature LED) 

Amber:  Temperature in CPU/IO module becomes abnormal. Contact your sales representative. 

 

(7) VLT (Power error LED) 

Amber:  Electric voltage failure occurs in CPU/IO module. Contact your sales representative. 

 

(8) PSU(Power supply unit error LED) 

Amber:  Failure occurs on the power supply unit of CPU/IO module. Contact your sales representative. 

 

(9) FAN (Fan error LED) 

Amber:  Failure occurs on the cooling fan for CPU and power supply unit of CPU/IO module. Contact your 
sales representative. 

 

(10) I/O (I/O FAULT LED) 

Amber:  Failure occurs on the I/O (PCI) part of CPU/IO module. Contact your sales representative. 

 

(11) PRIMARY (Primary LED) 

Green:  CPU/IO module is primary. 

 

(9)  Power Unit LED 

Power Unit LED is located at power supply unit at the rear of the server. 

LED indication Description Action 

Off The server is NOT receiving AC power.  

Blinking (green) The server is receiving AC power. – 

On (green) The server is powered on. – 

On (amber) 
Blinking (amber) 

The power supply unit fails. Contact your sales representative. 
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6.2  POST Error Message 

If POST detects any error, it displays an error message on the display unit. 

 

 

 

The following table lists error messages and the actions to take in response to them. 

 

Tips • Write down the displayed messages or beep patterns before contacting your 
sales representative. Alarm messages are useful information for maintenance.

• The list only contains messages for the server. For details about error 
messages of optional devices, and the actions to take, refer to the instructions 
that come with each product. 

 

 

System Monitoring Check 

... Passed 

ERROR 

8002: Check date and time settings 

 

Press <F1> to resume, <F2> to setup 

Example of error message 
This message indicates that date and time 
set on realtime clock is incorrect. 

http://ejje.weblio.jp/content/instructions�
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(1) Error messages 

 

Error Message Cause Solution 

8000 System variable is 

corrupted. 

Illegal setup information of BIOS was 
detected. 

Start BIOS Setup Utility (SETUP), and then 
execute Load Setup Defaults and specify the 
necessary settings. 
If the same error is detected repeatedly in spite 
of re-setting, contact your sales representative.

8001 Real time clock error Real time clock error was detected. Start SETUP, and then specify the correct date 
and time.  
If the same error is detected repeatedly in spite 
of re-setting, contact your sales representative.

8002 Check date and time 

settings 

Incorrect date and time set on real time 
clock was detected. 

8006 System configuration 

data cleared by Jumper. 

The setup utility settings were cleared 
using the jumper. 

Follow the steps described in Chapter 1 (10. 
Resetting and Clearing the Server). 

8007 SETUP Menu Password 

cleared by Jumper. 

The setup utility password was cleared 
using the jumper. 

8800 DXE_NB_ERROR An error was detected during 
initialization of chipset. 

Contact your sales representative. 

8801 DXE_NO_CON_IN An error was detected during 
initialization of console. 

8802 DXE_NO_CON_OUT 

8803 PEI_DXE_CORE_NOT_FOUND A flash ROM is corrupt. 

8804 PEI_DXEIPL_NOT_FOUND 

8805 DXE_ARCH_PROTOCOL_NOT_A

VAILABLE 

8806 PEI_RESET_NOT_AVAILABLE The system was not reset correctly. 

8807 DXE_RESET_NOT_AVAILABLE 

8808 DXE_FLASH_UPDATE_FAILED The Flash ROM was not written to 
correctly. 

B000 Expansion ROM not 

initialized 

Failed to expand option ROM. Disable expansion of option ROM of the board 
that is not used for OS boot. 

B001 Expansion ROM not 

initialized - PCI  

Slot 1 

Option ROM expansion in PCI slot 1 
failed. 

Disable expansion of option ROM of the option 
board that is not used for OS boot. 
 
Start SETUP, and select Advanced → PCI 
Configuration → PCI Device Controller and 
Option ROM Settings → PCIxx Slot Option 
ROM → Disabled. (xx: PCI slot number) 

B002 Expansion ROM not 

initialized - PCI  

Slot 2 

Option ROM expansion in PCI slot 2 
failed. 

B003 Expansion ROM not 

initialized - PCI  

Slot ３ 

Option ROM expansion in PCI slot 3 
failed. 

B004 Expansion ROM not 

initialized - PCI  

Slot ４ 

Option ROM expansion in PCI slot 4 
failed. 

B022 Serial Port 

Configuration 

Overlapped. 

Overlapping serial port configuration 
was detected. 

Start SETUP, select Advanced → Serial Port 
Configuration, and specify the setting again in 
a way that the values of Base I/O or Interrupt in 
Serial Port A and Serial Port B will not be the 
same. 

C010 The error occurred during 

temperature sensor 

reading  

An error was detected while reading 
temperature sensor. 

Contact your sales representative. 

C011 System Temperature out of 

the range.  

A temperature abnormality was 
detected. 

It is possible that a fan has failed or is clogged. 
Contact your sales representative. 
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Error Message Cause Solution 

C061 1st SMBus device Error 

detected.  

An error was detected on 1st SM Bus. Contact your sales representative. 

C062 2nd SMBus device Error 

detected.  

An error was detected on 2nd SM Bus.

C063 3rd SMBus device Error 

detected.  

An error was detected on 3rd SM Bus.

C064 4th SMBus device Error 

detected.  

An error was detected on 4th SM Bus.

C065 5th SMBus device Error 

detected.  

An error was detected on 5th SM Bus.

C066 6th SMBus device Error 

detected.  

An error was detected on 6th SM Bus.

C067 7th SMBus device Error 

detected.  

An error was detected on 7th SM Bus.

C101 BMC Memory Test 

Failed..  

An error was detected on BMC. Unplug the power cord, wait for at least 30 
seconds, then restart the server. If the same 
error is detected repeatedly, contact your sales 
representative. C102 BMC Firmware Code 

Area CRC check 

Failed. 

C103 BMC core hardware 

failure.  

C104 BMC IBF or OBF check 

failed.  

An error was detected while accessing 
BMC. 

C105 BMC SEL area full.  There is not enough space to store the 
system event log. 

Start up Offline Tools (Chapter 1, 12. Offline 
Tools) and delete the event logs. 

C10C BMC update firmware 

corrupted.  

An illegality was detected while 
updating BMC firmware. 

Unplug the power cord, wait for at least 30 
seconds, then restart the server. If the same 
error is detected repeatedly, contact your sales 
representative. C10D Internal Use Area of BMC 

FRU corrupted.   

An illegality was detected in FRU 
containing the device information. 

C10E BMC SDR Repository empty. An error was detected on BMC SDR. 

C10F IPMB signal lines do not 

respond.  

Failure of Satellite Management 
Controller was detected. 

C110 BMC FRU device failure. An error was detected in FRU that 
contains device information. 

C111 BMC SDR Repository 

failure.  

Failure was detected in SROM that 
stores the SDR. 

C112 BMC SEL device failure. Device failure was detected in BMC 
SEL. 

C113 BMC RAM test error.  An error was detected in BMC RAM. 

C114 BMC Fatal hardware error. A hardware error was detected in BMC.

C115 Management controller 

not responding 

Management controller does not 
respond. 

Update the BMC firmware.  
If the same error is detected repeatedly, 
contact your sales representative. 

C116 Private I2C bus not 

responding. 

Private I2C bus does not respond. Unplug the power cord, wait for at least 30 
seconds, then restart the server. If the same 
error is detected repeatedly, contact your sales 
representative. C117 BMC internal exception BMC internal error was detected. 

C118 BMC A/D timeout error. BMC A/D timeout error was detected.

C119 SDR repository corrupt. BMC error or illegal SDR data was 
detected. 

C11A SEL corrupt. BMC error or illegal system event log 
data was detected. 
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Error Message Cause Solution 

C11B BMC Mezzanine card is not 

found. 

BMC Mezzanine card is not installed. Contact your sales representative. 

C11C BMC Mezzanine partition 

is invalid. 

A format error was detected in BMC 
Mezzanine card. 

C11D BMC is in Forced Boot 

Mode. 

Detected that BMC is in Forced Boot 
Mode. 

Unplug the power cord, wait for at least 30 
seconds, then restart the server. At that time, 
check the jumper switch setting on 
motherboard. If the same error is detected 
repeatedly, contact your sales representative.

D483 BP SROM data invalid An invalid data was detected in system 
backplane. 

Contact your sales representative. 

D484 BP SROM data read error Failed to read data in system 
backplane. 

D485 MB SROM data invalid An invalid data was detected in CPU/IO 
board. 

D486 MB SROM data read error Failed to read data in CPU/IO board. 
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(2) Error messages on a virtual LCD 

In EXPRESSSCOPE Engine 3 web browser window, you can confirm virtual LCD error messages (for details on 
the virtual LCD, refer to "EXPRESSSCOPE Engine 3 User’s Guide"). 

 

The table below shows the error messages displayed on upper and lower lines, cause, and solution. 

 

 

Messages displayed on an upper LCD line 

 

Message  
on Upper LCD Line 

Description Solution 

XXXX BIOSXXXX Displayed while POST is running. This is not an error. 

POST Completed 
Successfully 

Displayed when POST completes normally. This is not an error. 

POST ERROR 
XXXX 

Error XXXX was detected during POST. Check the message displayed on LCD, and take an 
appropriate action. 

System Simplex The system is operating in simplex mode. This is not an error. 

System Duplex CPU/IO module is operating in duplex 
mode. 

This is not an error. 

Split mode CPU/IO module is operating in split mode. This is not an error. 

CPU Broken A CPU failure was detected. Contact your sales representative. 

IO Broken An I/O unit failure was detected. Contact your sales representative. 

 

 

Message displayed on 
upper LCD line 

Message displayed on 
lower LCD line 
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Messages displayed on a lower LCD line 

 

Message on Lower LCD Line Description Solution 

VBAT Lower Non-Critical A voltage abnormality was 
detected. 

Contact your sales representative. 

VBAT Upper Non-Critical 

VBAT Lower Critical 

VBAT Upper Critical 

Baseboard Temperature1 Lower Non-Critical A temperature abnormality was 
detected. 

It is possible that a fan has failed or is 
clogged. Contact your sales 
representative. Baseboard Temperature1 Upper Non-Critical 

Baseboard Temperature1 Lower Critical 

Baseboard Temperature1 Upper Critical 

Baseboard Temperature2 Lower Non-Critical 

Baseboard Temperature2 Upper Non-Critical 

Baseboard Temperature2 Lower Critical 

Baseboard Temperature2 Upper Critical 

CPU1_DIMM Area Temperature Lower 
Non-Critical 

CPU1_DIMM Area Temperature Upper 
Non-Critical 

CPU1_DIMM Area Temperature Lower 
Critical 

CPU1_DIMM Area Temperature Upper 
Critical 

CPU2_DIMM Area Temperature Lower 
Non-Critical 

CPU2_DIMM Area Temperature Upper 
Non-Critical 

CPU2_DIMM Area Temperature Lower 
Critical 

CPU2_DIMM Area Temperature Upper 
Critical 

Processor1 Thermal Control Upper 
Non-Critical 

Processor1 Thermal Control Upper Critical 

Processor2 Thermal Control Upper 
Non-Critical 

Processor2 Thermal Control Upper Critical 

DUMP Request ! The dump button was pressed. Wait until collecting the memory dump 
data has finished. 

Power Supply1 Failure detected  A power supply unit abnormality 
occurred. 

Make sure that the power cord is 
plugged in. If this does not resolve the 
problem, contact your sales 
representative. 

Processor Missing No CPU is installed. Contact your sales representative and 
request CPU or motherboard 
replacement. 

Processor1 Thermal Trip The power was forcibly turned off 
due to a CPU temperature 
abnormality. 

Contact your sales representative. 

Processor2 Thermal Trip 

Sensor Failure Detected. Abnormality in a sensor was 
detected. 

Contact your sales representative. 
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Message on Lower LCD Line Description Solution 

SMI timeout  A timeout occurred while 
servicing system management 
interrupts. 

IPMI Watchdog timer timeout (Power off) A watchdog timer timeout 
occurred. 

System Front FAN1 Lower Non-Critical A fan alarm was detected. It is possible that a fan has failed or is 
clogged. Contact your sales 
representative. System Front FAN2 Lower Non-Critical 

System Front FAN3 Lower Non-Critical 

System Front FAN4 Lower Non-Critical 

System Front FAN5 Lower Non-Critical 
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6.3  List of Windows Event Logs 

 

Note Confirm also "Chapter 1 (8.12 Event Logs)". 

 

 

OS 

 Event log 

 ID 
Source Type Message (Description) 

Timing Action 

  

 

System Event Log for all Windows OS 

 System Event Log 

 51 

Cdrom Warning Error detected on the device \Device\CdRom0 during the paging 
operation. 

Upon OS installation This event may be registered in the event viewer, but this does not 
affect system operation. 

  

 

Windows Server 2012 

 System Event Log 

 

46 

volmgr Error Failed to initialize crash dump. 

 When installing an OS Go to the following Microsoft website for details: 
http://support.microsoft.com/kb/2756313 

 

134 

Microsoft-Windows-Time-
Service Warning 

NtpClient was unable to set a manual peer to use as a time source 
because of DNS resolution error on 'time.windows.com,0x9'. NtpClient 
will try again in 15 minutes and double the reattempt interval thereafter. 
Error: (0x80072AF9) 

 When installing an OS, starting system, 
or applying Starter Pack 

If this event is not logged after connecting with Internet, this event does 
not affect system operation. 

 

7023 

Service Control Manager Error 
The Network List Service terminated with the following error:  
Device is not ready. 

 When installing an OS If this event is logged only upon OS installation and is not logged 
repeatedly, it does not affect system operation. 

http://support.microsoft.com/kb/2756313�
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7023 

Service Control Manager Error 
The IP Helper service terminated with the following error:  
The specified service is invalid, or valid device is not associated with the 
service. 

 When installing an OS If this event is logged only upon OS installation and is not logged 
repeatedly, it does not affect system operation. 

 

10010 

Microsoft-Windows- 
DistributedCOM Error The server {XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX} did not 

register with DCOM within the required timeout.  

 When installing an OS Go to the following URL for detailed information. 
http://support.microsoft.com/kb/956479/ 

 

10149 

Microsoft-Windows- 
WinRM Warning The WinRM service is not listening for WS-Management requests.  

 When installing an OS 

If this event is logged together with ID 7036 "Service Control Manager 
(Windows Remote Management (WS-Management) service is changed 
to halt state.), it does not affect system operation. 
If these events are not in pair and WinRM Event 10148 (The WinRM 
service is not listening for WS-Management requests.) is output 
immediately after this event, it is not problem in system operation. 

  

 Application Event Log 

 

1015 

Microsoft-Windows- 
Security-SPP Warning Description: Detailed information of HRESULT 

Returned hr=0xC004F022, original hr=0x80049E00 

 When installing an OS Unless the event is registered after license authentication, this event 
does not affect system operation. 

 

1530 

Microsoft-Windows-User 
Profiles Service Warning 

Windows detected your registry file is still in use by other applications or 
services. The file will be unloaded now. The applications or services that 
hold your registry file may not function properly afterwards. 

 When applying Starter Pack This event does not affect system operation unless sign-in to Windows 
is disabled. 

 

8198 

Microsoft-Windows- 
Security-SPP Error 

License Activation (SLUI.exe) failed with the following error code:  
hr=0x80070057 

 Upon OS installation or at system startup

Unless the event is registered after license authentication, this event 
does not affect system operation. Go to the following URL for detailed 
information. 
http://support.microsoft.com/kb/921471/ 
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 Application Event Log and Service Log 

 104 

Microsoft-Windows- 
DeviceSetupManager Error Could not start DSM service. Result=0x800706B5 

When installing an OS If this event is logged only upon OS installation and is not logged 
repeatedly, it does not affect system operation. 

 

200 

Microsoft-Windows- 
DeviceSetupManager Warning A connection to the Windows Update service could not be established. 

 While the system is in use If this event is not logged after connecting with Internet, this event does 
not affect system operation. 

 

201 

Microsoft-Windows- 
DeviceSetupManager Warning A connection to the Windows Metadata and Internet Services (WMIS) 

could not be established. 

 While the system is in use If this event is not logged after connecting with Internet, this event does 
not affect system operation. 

 

202 

Microsoft-Windows- 
DeviceSetupManager Warning The Network List Manager reports no connectivity to the internet. 

 While the system is in use If this event is not logged after connecting with Internet, this event does 
not affect system operation. 

 

1001 

Microsoft-Windows- 
Dhcp-Client Error 

Your computer was not assigned an address from the network (by the 
DHCP Server) for the Network Card with network address <MAC 
address>. 
The following error occurred: 0x79.  
Your computer will continue to try and obtain an address on its own from 
the network address (DHCP) server. 

 Upon OS installation or when applying 
Starter Pack This event does not affect system operation unless occurred repeatedly.

 

12520 

Microsoft-Windows- 
Hyper-V-VMMS Warning Auto-generating a self-signed certificate for server authentication.  

 While the system is running This event is logged at shutdown for activation of Windows Server 2012 
Hyper-V, however, it does not affect system operation. 

 

14100 

Microsoft-Windows- 
Hyper-V-VMMS Warning Shutting down physical computer. Stopping/saving all virtual machines .

 While the system is running This event is logged at shutdown for activation of Windows Server 2012 
Hyper-V, however, it does not affect system operation. 

 

15350 

Microsoft-Windows- 
Hyper-V-VMMS Error Virtual Infrastructure Drive (VID) is not running. 

 While the system is running This event is logged at shutdown for activation of Windows Server 2012 
Hyper-V, however, it does not affect system operation. 
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Windows Server 2008 R2 

 System Event Log  

 1 

iScsiPrt Error Initiator failed to connect to the target. Target IP address and TCP Port 
number are given in dump data. 

When Windows Server 2008 R2 is 
operating while iSCSI is recognized 

Go to the following Microsoft website for details. 
http://support.microsoft.com/kb/976072/en-us 
 

 

11 

Disk Error 
The driver detected a controller error on Device\HarddiskX \DRX. 
Note: A different number replaces X depending on the connection 

status of the disk. 

 
Upon connecting with a USB device, 
remote media, and/or Virtual Flash USB 
Device  

When the below values are 00 in Details in the event logs → Display, 
this event does not affect system operation. 
 
<Word format> 
0000: 0068030E 00000001 00000000 C004000B 
0008: 00000103 00000000 00000000 002D0800 
0010: 00000000 00000000 000427B7 00000000 
0018: FFFFFFFF 00000006 00000040 00000000 
0020: 12060000 10000008 00000000 0000003C 
0028: 00000000 86BAA280 00000000 86BDB008 
0030: 00000000 00000000 00000000 00000000 
0038: 00000000 00000000 00000000 00000000 
0040: 00000000 00000000 00000000 00000000 
0048: 00000000 00000000 00000000 00000000 
0050: 00000000 00000000 
 
<Byte format> 
0000: 0E 03 68 00 01 00 00 00   ..h..... 
0008: 00 00 00 00 0B 00 04 C0   .......A 
0010: 03 01 00 00 00 00 00 00   ........ 
0018: 00 00 00 00 00 08 2D 00   ......-. 
0020: 00 00 00 00 00 00 00 00   ........ 
0028: B7 27 04 00 00 00 00 00   ・'...... 
0030: FF FF FF FF 06 00 00 00   yyyy.... 
0038: 40 00 00 00 00 00 00 00   @....... 
0040: 00 00 06 12 08 00 00 10   ........ 
0048: 00 00 00 00 3C 00 00 00   ....<... 
0050: 00 00 00 00 80 A2 BA 86   ....?￠o? 
0058: 00 00 00 00 08 B0 BD 86   .....°?? 
0060: 00 00 00 00 00 00 00 00   ........ 
0068: 00 00 00 00 00 00 00 00   ........ 
0070: 00 00 00 00 00 00 00 00   ........ 
0078: 00 00 00 00 00 00 00 00   ........ 
0080: 00 00 00 00 00 00 00 00   ........ 

0088: 00 00 00 00 00 00 00 00 

 

134 

Microsoft-Windows- 
Time-Service Warning 

NtpClient was unable to set a manual peer to use as a time source 
because of DNS resolution error on''. 
NtpClient will try again in 3473457 minutes and double the reattempt 
interval thereafter. 

 Upon OS Installation This event does not affect system operation. 

 

 Application Event Log 

 1015 

Microsoft-Windows- 
Security-SPP Warning 

Description: Detailed information of HRESULT 
Returned hr=0xC004F022, original hr=0x80049E00 

Upon OS Installation Unless the application event is registered after license authentication, 
this event does not affect system operation. 

 

1534 

Microsoft-Windows- 
User Profiles Service Warning 

Profile notification of event Create for component 
{56EA1054-1959-467f-BE3B-A2A787C4B6EA} failed 

 Upon OS Installation This event does not affect system operation. 

http://support.microsoft.com/kb/976072/en-us�
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8193 

VSS Error 

Volume Shadow Copy Service error: Unexpected error calling routine 
IOCTL_DISK_GET_DRIVE_LAYOUT_EX 
(\\?\mpio#disk&ven_nec&prod_istorage_2000&rev_2800#1&7f6ac24&0
&303030303030303933313030303735373030323934#{ GUID }) - 
BuildLunInfoForDrive. 
hr = 0x80070013, This media is write-protected. 

 
When you import a transportable 
shadow-copy to another server that has 
a read-only volume while operating 
Windows Server 2008 R2: 

Go to the following Microsoft website for details: 
http://support.microsoft.com/kb/2003016/en-us 
 

 

12289 

VSS Error 

Unexpected error 
DeviceIoControl(¥¥?¥storage#volume#_??_mpio#disk&ven_nec&prod
_istorage_1000&rev_1000#1&7f6ac24&0&3030303030303030313030
30303032383030304636#{ GUID}#0000000000007  
e00#{ GUID }-00000000000002B8,  
x00560000,0000000000000000,0,00000000004866D0,4096,[0]) 
Hr = 0x80070013, This media is read-only volume. 

 
When you import a transportable 
shadow-copy to another server that has 
a read-only volume while operating 
Windows Server 2008 R2: 

Go to the following Microsoft website for details: 
http://support.microsoft.com/kb/2003016/en-us 

 

12289 

VSS Error 

Volume shadow copy service error: unexpected error  
DeviceIoControl(¥¥?¥fdc#generic_floppy_drive#6&6a032c4&0&0 
#{ GUID }-00000000000002B0,0x00560000,  
0000000000000000,0,00000000001EC0E0,4096,[0]) 
hr = 0x80070001, function is incorrect. 

 
When you import a transportable 
shadow-copy to another server that has 
a floppy disk drive while operating 
Windows Server 2008 R2: 

Go to the following Microsoft website for details: 
http://support.microsoft.com/kb/2003968/en-us 

  

 Applications and Services Logs  

 Microsoft-Windows-Kernel-EventTracing/Admin 

 

2 

Microsoft-Windows- 
Kernel-EventTracing Error Session "" failed to start with the following error:  

0xC000000D 

 When running an OS for the first time This event does not affect system operation. 

 

3 

Microsoft-Windows- 
Kernel-EventTracing Error Session "Microsoft-Windows-Setup" stopped due to the following error: 

0xC000000D 

 When running an OS for the first time This event does not affect system operation. 

 Microsoft-Windows-Dhcp-Client/Admin 

 

1001 

Microsoft-Windows- 
Dhcp-Client Error 

Your computer was not assigned an address from the network (by the 
DHCP Server) for the Network Card with network address 
0x50E549A98325. The following error occurred: 0x79. Your computer 
will continue to try and obtain an address on its own from the network 
address (DHCP) server. 

 When installing an OS, running an OS 
for the first time, or applying Starter Pack

If this event is logged when installing an OS, running an OS for the first 
time, or while applying Starter Pack, it does not affect system operation.

  

http://support.microsoft.com/kb/2003016/en-us�
http://support.microsoft.com/kb/2003016/en-us�
http://support.microsoft.com/kb/2003968/en-us�
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6.4  Error Message on Windows Server 

If a fatal error occurs on the server after startup of Windows Server, the screen of display unit change blue, and 
detailed error information is displayed. 

 

Take a note of on-screen message and contact your sales representative. 

The server does not display details of error message immediately after Windows Server 2012 is installed. Take 
a note of on-screen message and contact your sales representative. 

At the occurrence of error, the server executes memory dump automatically, and stores the memory dump data 
in arbitrary directory. (Refer to Chapter 1 (5.1 Memory Dump (Debug Information)) in Installation Guide 
(Windows). Copy the dump file onto a media such as LTO so that you can provide it to your sales representative 
when requested. 

 

Important Ignore the virtual memory shotage message and proceed when restarting.  

 

Note Before copying a dump file onto media, make sure that the memory dump is surely saved. 
Open Event Viewer, confirm that the event log of Save Dump is recorded and memory 
dump is saved. 

 

A message "Virtual memory is short. Add system memory or quit application." may appear during operation. 

In such a case, do the following: 

1. Add physical memory. 

2. Change paging file size (physical memory capacity * 1.5 or larger). 

In addition, a warning message is displayed when an error occurs on internal device or peripheral devices (e.g., 
hard disk drive, network, or printer). Take a note of message displayed, and contact your sales representative. 

 

 

Background color is "Blue". 

 
               Your PC ran into a problem and needs to restart. We’re just collecting some error 

info, and then we’ll restart for you. (0% complete) 
。 

                

                If you’d like to know more, you can search online later for this error. NMI_HARDWARE_FAILURE 

 

Example on Windows Server 2008 R2 Example on Windows Server 2012 
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7. Collecting Failure Information 

If the server fails, you can collect failure information by using the following method. 

The failure information is to be collected only at the request of your sales representative. 

 

Important When the system restarts after a failure has occurred, a message may appear 

indicating virtual memory shortage. Ignore this message and proceed with starting 

the system. Restarting the system may result in an inability to properly collect 

information. 

 
 

7.1  Collecting Failure Information Occurred on Server 

 

Follow steps below to collect various failure information that occurred on the server. 

1.  On the machine where NEC ESMPRO Agent is installed, run the following program from Explorer.  
%EsmDir%\tool\collect.exe 

%EsmDir% denotes the folder where NEC ESMPRO Agent is installed. (Default: C:\ESM) 

2.  Event logs are output to %EsmDir%\tool\log. 
Collect all the logs in %EsmDir%\tool\log. 

 

Tips Be sure to collect logs in log folder under %EsmDir%\tool, not the folder %EsmDir%\log.

 
Event logs can be collected by using Product Info Collection Utility. See Chapter 3 (8. NEC Product Info 
Collection Utility) for details. 
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7.2  Collecting Event Logs 

Take steps below to collect various event logs that occurred on the server. 

 

Tips If a STOP error, system error, or stall occurs, restart the system and then follow the 
steps below. 

 

7.2.1  Windows Server 2012 

1. Click Settings from Charms bar. 

(Or, right-click the left bottom of screen, and click Event Viewer from the menu displayed. The screen 

shown in Step 5 appears.) 

<Select Settings> <Select Event Viewer> 

 

 

 

2.  Click Control Panel in Settings. 
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3. Click System and Security in Control Panel. 

 

4. Click Administrative Tools → View event logs from System and Security. 

 

5. Select a type of log in Windows Logs. 

Application records events related to applications. 

Security records events related to security.  

System records events that occurred in Windows system components. 
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6. Select Save All Events As... from Action menu. 

 

7. Enter the file name of the archived log in File name. 

8. Select the type of the log file you want to save in Save as type, and then click Save. 

 

7.2.2  Windows Server 2008 R2 

1.  Select Administrative Tool and then Event Viewer from Control Panel. 

2.  Select the type of log in Windows Logs. 
Application records events related to running applications. 
Security records events related to security.  
System records events that occurred in Windows system components. 

3.  Select Save All Event As... from Action menu.  

4.  Enter the file name of the archived log in File name. 

5.  Select the type of the log file you want to save in Save as type, and then click Save. 
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7.3  Collecting Configuration Information 

This section describes how to collect information on hardware configuration and internal specifications. 

 

Tips If a STOP error, system error, or stall occurs, restart the system and then follow the 
procedure below. 

 

7.3.1  Windows Server 2012 

1. Click Search from Charms bar. 

(Or, right-click the left bottom of screen, and click Run from the menu displayed.) 

<Select Search> <Select Run> 

 

 

 

2. Enter msinfo32.exe in text box, and then press <Enter> key. 

Search Run 

 

3. System Information starts. 

4. From File menu, click Export. 

5. Enter the file name to save in File Name, and then click Save. 
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7.3.2  Windows Server 2008 R2 

1.  Select Run from Start menu. 

2.  Enter msinfo32.exe in Open text box, and then click OK. 

3.  System Information starts. 

4.  From Files menu, click Export. 

5.  Enter the file name to save in File Name, and then Click Save. 

 

 

7.4  Collecting User-Mode Process Dump  

Diagnostic information related to application errors can be collected. 

For details, refer to Chapter 1 (5.2 How to Create a User-Mode Process Dump File) in "Installation Guide 
(Windows)". 

 



7. Collecting Failure Information 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 82

Chapter 1  Maintenance 

7.5  Collecting Memory Dump 

If an error occurs, the dump file can be saved to acquire necessary information. You can specify any location for 
saving the dump. For details, refer to Chapter 1 (5.1 Memory Dump (Debug Information)) in "Installation Guide 
(Windows)". 

 

Consult with your sales representative before dumping the memory. Dumping the memory while the server is in 
operating normally will affect the system operation. 

 

Important Ignore the virtual memory shotage message and proceed when restarting.  

Do not reset during dumping memory. 

 

If a failure occurs and you want to collect memory dump, press the DUMP switch on CPU/IO module of primary 
side for 4 to 8 seconds. 

 

Important Pressing the DUMP switch excessively shorter or longer will fail to collect 
memory dump. 

 

Press the DUMP switch by inserting the pointed tool such as ballpoint pen into the switch hole. 

 

Important Do not use anything that easily breaks such as pencil, toothpicks, or plastic.

 

The memory dump is stored in the specified location.  
Memory dump is not collected depending on CPU status (e.g. CPU stall). 

 

 

If the server fails to restart after executing memory dump, forcibly reset the server. See Chapter 1 (10.2 Forced 
Shutdown). 

 

 

DUMP(NMI) switch 
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8. Troubleshooting 

If this system does not work correctly, check it according to the contents of the following checklist before 
sending it for repair.  

• The server does not work normally. 

→ See "8.1 Problem of Powering on". 

→ See "8.4 Problem of Starting OS". 

→ See "8.5 Problem of Windows STOP Error". 

→ See "8.6 Problem of Internal Devices and Other Hardware". 

→ See "8.7 Problem of OS Operation". 

→ See "8.10 Problem of Optical Disk Drive and Flash FDD". 

• Failed to start from EXPRESSBULDER. 

→ See "8.2 Problem of Starting EXPRESSBUILDER". 

→ See "8.8 Problem of Starting EXPRESSBUILDER on Windows". 

• Failed to install OS. 

→ See "8.3 Problem of Installing OS". 

• NEC ESMPRO does not work normally. 

→ See "8.9 Problem of Bundled Software". 

→ Refer to NEC ESMPRO Agent Installation Guide stored in EXPRESSBUILDER. 

• Active Upgrade does not work normally. 

→ See "8.11 Active Upgrade". 

• Event logs 

→ See "8.12 Event Logs". 

• Failed to setup Windows. 

→ See "8.3 Problem of Installing OS". 

If the server still does not work normally, See the following topics in this chapter before suspecting failure. 

• Error message 

→ See "6. Error Messages". 

• NEC ESMPRO Manager 

→ Refer to NEC ESMPRO Manager Installation Guide stored in EXPRESSBUILDER. 

• Collect failure information  

→ See "7. Collecting Failure Information". 

• Recovery of Windows system 

→ See "9. Windows System Recovery". 

If the trouble persists, contact your service representative. 
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8.1  Problem of Powering on 

[?] Fail to power on the server: 

 Is the server properly supplied with power? 

 Check if the power cord is connected to a power outlet (or UPS) that meets the power specifications 
for the server. 

 Make sure to use the power cord provided with the server. Check the power cord for broken shield or 
bent plugs. 

→ Make sure the power breaker for the connected power outlet is on. 

→ If the power cord is plugged to a UPS, make sure the UPS is powered and it supplies power. Refer 
to the manual that comes with the UPS for details. 
Power supply to the server may be linked with the connected UPS using the BIOS SETUP utility of 
the server. 

 Did you press the POWER switch? 

→ When power cord is connected, the initialization of management controller starts. During 
initialization, the POWER LED is unlit. To power on the server, press the POWER switch after the 
POWER LED is lit green. 

 Did you install the CPU/IO module properly? 

→ Check if the CPU/IO module is properly installed in the server. Secure the CPU/IO module with 
screw located on the module removable handle.  

[?] The screen does not turn on: 

 Wait until the NEC logo appears. 

[?] POST fails to complete: 

 Are the DIMMs installed? 

→ Check if DIMMs are installed correctly. 

 Is the memory size large? 

→ The memory check may take a time if the memory size is large. Wait for a while. 

 Did you perform any keyboard or mouse operation immediately after you started the server? 

→ If you perform any keyboard or mouse operation immediately after start-up, POST may 
accidentally detect a keyboard controller error and stops proceeding. In such a case, restart the 
server. Do not perform any keyboard or mouse operation until the BIOS start-up message appears 
when you restart the server. 

 Does the server have appropriate memory boards or PCI card? 

→ Operation of the server with unauthorized devices is not guaranteed. 

 Did you install the CPU/IO module properly? 

→ Check if the CPU/IO module is properly installed in the server. Secure the CPU/IO module with 
screw located on the module removable handle.  
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8.2  Problem of Starting EXPRESSBUILDER 

[?] Unable to start EXPRESSBUILDER: 

 Did you insert EXPRESSBUILDER DVD before starting the server? 

→ Restart the server and retry. 

 Are BIOS settings correct? 

→ Configure the boot order so that the optical disk drive will be the first to start up. 
<Menu to check: Boot> 

 Is a message displayed when starting EXPRESSBUILDER with text base? 

→ Take an appropriate action according to the on-screen message. 

Error [Message ID:Z3002] : 

Description: Failed to detect a DVD drive or a flash drive. 
Action: Check if hardware is connected properly. 

Error [Message ID:Z3003] : 

Description: Failed to read a file. 
Action: Check if DVD is damaged. 

 Is a message such as the following displayed? 

→ Take an appropriate action according to the table below. 

Message Solution 

EXPRESSBUILDER does not support this computer.  

Insert EXPRESSBUILDER disc for the computer and click OK

to restart the computer.  

Run the correct version of 
EXPRESSBUILDER. 

Failed to get the hardware parameters on the motherboard.

Check if EXPRESSBUILDER is for this computer or if the 

motherboard has failed. 

Contact your sales 
representative. 

Failed to find a file. EXPRESSBUILDER disc has 
stains or cracks or the optical 
disk drive is faulty. 
Contact your sales 
representative. 

Failed to open a file. 

Failed to get the parameters of a file. 

Failed to save a file. 

Failed to copy a file. 

An undefined error occurred. Contact your sales 
representative. 
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8.3  Problem of Installing OS 

[?] Unable to install OS: 

 Is the Hard Disk Drive properly installed?  

→ Make sure that the Hard Disk Drive is installed securely and that cables are properly connected. 

[?] Unable to install Windows: 

 Have you checked precautions for installation? 

→ Refer to "Installation Guide (Windows)". 

[?] A product key was not requested: 

→ If you install using the backup DVD-ROM, entering the product key is not required. 

[?] When Starter Pack is executed on Windows Server 2008 R2, the below message is sometimes 

displayed for a moment upon shutdown: 

 

→ No problems for system operation. 
For details, refer to the Microsoft website below: 
http://support.microsoft.com/kb/975777/en-us 

[?] The following features are installed when Windows Server 2008 R2/Windows Server 2008 IIS is 

installed using EXPRESSBUILDER: 

 Windows Process Activation Service 

– Process Model 

– Configuration APIs 

 Remote Server Administration Tool 

– Role Administration Tools 

– Web Server (IIS) Tools 

→ The features listed above are activated because they are required for the installation of IIS basic 
features. 

[?] The Telnet Service is not installed: 

→ Adjust the computer name to 14 characters or less, and then install the Telnet Service according to 
the following procedure: 

How to install the Telnet Service 

1. Click Run on Start menu. 

2. Enter tlntsvr/service in the Open box, and then click OK. 

3. Click Start menu, point to Control Panel, click Administrative Tools, and then click 
Services to confirm whether the Telnet Service is registered. 

* When the installation of Telnet Service is finished, there is no problem if the computer name is 
set to 15 characters or more. 

1 program still needs to close:
(Waiting for) Task Host Window 

http://support.microsoft.com/kb/975777/en-us�
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[?] Fails to execute "Create a parameter file for Windows OS": 

→ "Create a parameter file for Windows OS" must be run using Microsoft® HTML Application host. 
If it does not start, associate the file type with Microsoft® HTML Application host via the following 
process. 

1. Select Run in Windows Start menu. 

2. Enter %windir%\system32\mshta.exe/register. 

[?] Cannot configure the details of network adapter: 

→ You cannot configure the details of network adapter during setup of NEC Express5800/ft servers. 
You can configure this after the startup of Windows. 

[?] Rebooted during the setup: 

→ Refer to Chapter 1 (3.1.3 Disabling OS Boot Monitoring Feature) in Installation Guide, and set the 
parameter of this machine’s OS Boot Monitoring feature to correct value.  

[?] ft Server Control Software UPDATE Disk is not included: 

→ ft Server Control Software UPDATE disk is used to update ft Server Control Software; it may not 
be shipped with the equipment. 

[?] Windows can be operated after a setup but each module or PCI board is not duplicated. (Status 

LED on the CPU/IO module does not light green): 

 Did you abort the installation during a setup such as by closing a window of the programs that are 
running? 

→ Installation will be aborted if you finish the programs that are running such as by closing a window. 
Although the operation on Windows will be feasible, modules or PCI boards will not be duplicated 
properly if you abort the installation. In this case, you need to reinstall OS according to Chapter 1 
(2. Setting Up the Operating System) in Installation Guide. 

[?] DISK Access LED is lit in amber: 

 Did you properly setup the duplex of HDDs? 

→ DISK Access LED will be lit in amber, if a setup for duplex is not performed. See Chapter 1 (6.1 
Error Messages by LED Indication) for details about the indication status of LED. 
See Chapter 2 (1. Disk Operations), and set up the duplex of HDDs. 

[?] During setting up, Error or Warning logs are recorded in System and Applications Event Log: 

→ During installing Operating System and ft Server Control Software, due to a temporary state of the 
system under installation, Error or Warning logs are recorded in System and Applications Event 
Log. When setup is completed as a procedure of Installation Guide, and the system is duplicated, 
the system operation is normal. 
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8.4  Problem of Starting OS 

[?] Unable to start OS: 

 Are Hard Disk Drives properly installed? 

→ Install Hard Disk Drives properly. 

 Is SAS cable connected to Hard Disk Drive correctly? 

→ Connect the SAS cable properly. 
If the SAS cable is not recognized as connected although the above action has been taken, the 
Hard Disk Drive may be faulty. Contact your sales representative. 

 Is the EXPRESSBUILDER DVD inserted? 

→ Eject the EXPRESSBUILDER DVD and reboot. 

[?] Machine repeats rebooting at startup: 

 Is CHKDSK executed at machine startup? 

→ Run the BIOS SETUP utility at rebooting and change parameters as follows:  
(Change BIOS settings) 
Change Server - OS Boot Monitoring to Disabled. 

For details, see Chapter 3 (1. System BIOS). 

* After completion of CHKDSK, restart the machine and change the above setting back to 
Enabled and continue the operation.  
 

CHKDSK is executed in the following conditions:  

– CHKDSK is scheduled to be executed at next system startup 

– Corruption of file system is detected since the previous startup until shutdown  

– Inconsistency (corruption) of file system is detected while mouting at system startup  

 Is the value of OS Boot Monitoring in the BIOS setting appropriate? 

→ Change the value of OS Boot Monitoring to suit your environment.See Chapter 3 (1. System 
BIOS) for details. 

[?] Wake On LAN does not function: 

 Is the AC power supplied to both CPU/IO modules? 

→ If the AC power supplied to only one of the CPU/IO module, Wake On LAN may become 
unavailable. Supply the AC power to both of CPU/IO modules. 

 Is the network adapter configured on OS? 

→ On the OS, go to Start - Administrative Tool - Computer management and select the Device 
Manager. Double click Stratus emb-82576 2-Port Gigabit Adapter #n under the network adapter, 
then select the following option from Power Management tab: 
Wake On Magic Packet from power off state. 

 

Note Wake On Magic packet is unavailable even if it is checked. 
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 Is Hub/Client fixed as 1000M? 

→ Check the following configurations: 
– Set the Hub as "Auto-Negotioation". 
– Set the Client as "Auto-negotiate best speed". 

 

Important For both Hub/Client, you cannot use Wake On LAN feature from standby state with 

the 1000M fixed configuration. 

 

 Do you send Magic Packet to only one of the duplexed LAN? 

→ If you use Wake On LAN under duplexed LAN, you need to send Magic Packets to all of the 
duplexed LAN pair(s). 

→ This server uses the Locally Administered Address which you set in LAN teaming as MAC 
address during OS running. If the server does not wake with MAC address of each CPU/IO 
modules, you should use the Locally Administered Address. 

 Did you send Magic Packet to 10G LAN port? 

→ Wake On LAN feature is not supported for 10G LAN port . 

[?] The following message appears when logging in the system: 

  

 Have you finished license authentication for Windows product? 

→ The above message will appear if you use Windows product with the unauthenticated license. 
Select Get genuine now and proceed license authentication. 
The above message is an example of request for license authentication. The message displayed 
on screen may differ from this depending on the license. 

[?] Fail to duplex CPUs: 

→ Check if the memory configuration is correct. 

→ Check if third-party CPUs or memory (DIMM) are used. 

[?] Fail to duplex modules due to difference of BIOS version: 

 Is ft server utility - System Configuration - Auto Firmware Update disabled? 

→ Change setting to Enabled and integrated module again. The BIOS of primary module is used for 
both modules to duplex the modules. It is recommended to reduce system load as much as 
possible. 
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8.5  Problem of Windows STOP Error 

[?] The screen turns blue during OS boot: 

→ Wait for the period of time you set at BIOS Boot Monitoring; after the boot module is 
automatically swapped, the server will be rebooted and the OS will start up. 
If OS Boot Monitoring is set to Disabled or Start and Recover - System Error - Restart 
automatically in system property is unchecked, you must start OS manually. To start the OS 
manually, install only a disk containing system file and start it. Or, perform Disk Boot from another 
CPU/IO module. 

[?] Cannot turn the power OFF at the blue screen (STOP error screen): 

→ If you want to turn off the power at the blue screen, execute forced shutdown (continue to press the 
power switch for 4 seconds). If you press the switch briefly instead of holding it, the server will not 
power off. 

[?] The system does not operate according to the configured settings of "Automatic Restart" at the 

occurrence of error: 

→ The system may or may not restart automatically even if the "Automatic Restart" settings are 
made at occurrence of an error is set. If the system does not restart automatically, restart it in 
manual mode. 

 



8. Troubleshooting 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 91

Chapter 1  Maintenance 

8.6  Problem of Internal Devices and Other Hardware 

[?] Fail to access the internal or external devices (or such devices fail to operate): 

 Are cables properly connected? 

→ Make sure that the interface cables and power cord are properly connected. Also make sure that 
the cables are connected in the correct order. 

 Is the power-on order correct? 

→ When the server has any external devices connected, power on the external devices first, then the 
server. 

 Did you install drivers for connected optional devices? 

→ Some optional devices require specific device drivers. Refer to the manual that comes with the 
device to install its driver. 

 Is option board setting correct? 

→ Usually, no PCI device settings need to be changed. However, depending on the board to be set, 
special setting may be required. Refer to the manual that comes with the board for details to make 
correct settings. 

[?] The keyboard or mouse does not work: 

 Is the cable properly connected? 

→ Make sure that the cable is connected to the connector on the front or rear of the server. 

 Are the keyboard and mouse are compliant with Express5800/ft series? 

→ Operation of the server with unauthorized devices is not guaranteed. 

[?] Screen freezes, keyboard and mouse are disabled: 

→ If the amount of memory is large, it takes time to copy the memory in dual mode and the system 
stops working temporarily during the copying, but it is not system trouble. 

[?] Unable to access the Hard Disk Drive 

 Is the Hard Disk Drive supported by the server? 

→ Operation of any device that is not authorized by NEC is not guaranteed. 

 Is the Hard Disk Drive properly installed? 

→ Check the Hard Disk Drive installation status and the cable connections. 

[?] Unable to configure dual disks: 

→ Unless you perform mirroring (including reconfiguration after failed disks are replaced) in correct 
order, the mirror may not be (re)configured. Check if the steps were correct. 

[?] Disk access LEDs on the disks are off: 

→ The LEDs may seem to be off when an excessive amount of access causes the frequent blinking. 
Check if the LEDs are blinking green when the access is reduced. 
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[?] Unavailable disks are displayed on Disk Management: 

→ Follow the instruction below:  

Disk Status Description  Action  

 

A message Foreign is displayed when 
the dynamic disk used on another 
system is mounted. 

[To use data of the disk] 
Import the disk. 
 
[To make the disk usable] 
Initialization is required to use this disk. 
Initialize this disk to convert it to a usable disk.
 
<Note> 
The data on disks are lost when initialized. 
Make sure to back up the data before 
initializing disk. 

 

A message Missing is displayed when 
the dynamic disk is broken or removed.

Delete the mirror on the disk when mirror 
volume is on missing disk. 
After deleting the mirror, right-click Missing 
disk and execute Remove disk. 

 

A message Not Initialized is displayed 
when there is no signature on the disk. 

Right-click on the disk and execute Initialize 
Disk to convert it to a usable disk. 
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8.7  Problem of OS Operation 

[?] Windows operation is unstable: 

 Have you installed the Starter Pack? 

→ If the network driver is installed after OS is installed, Windows operation may become unstable. 
Install the Starter Pack by according to Chapter 1 (Installing Starter Pack) in "Installation Guide 
(Windows)". 

[?] After the system is restored from the backup tool, Windows is misbehaving: 

→ Update the system by using EXPRESSBUILDER (refer to Chapter 2 Installing the Bundled 
Software in "Installation Guide (Windows)". 

[?] The server is not found on the network: 

 Is the cable connected properly? 

→ Securely connect the proper cable to the network port on the rear of the server. Additionally, make 
sure that the cable conforms to the network interface standards. 

 Are BIOS settings correct? 

→ You can disable the internal network controller using the BIOS setup utility. Check the settings with 
BIOS setup utility.  

 Have you completed protocol and services settings? 

→ Verity that the network driver for the server network controller has been installed. Also verify that 
protocol such as TCP/IP or various services have been properly specified.   

 Is the transfer speed correct? 

→ You can change the transfer speed or configure the setting for onboard LAN controller from OS.  
Be sure to specify the same same transfer speed and duplex mode as those on connected hub. If 
you specify Auto Detect, make sure that Auto Detect is also specified for the connected hub. 
Fix the transfer speed by using Device Manager. Select and right-click the network adapter to 
change the transfer speed from the tree on Device Manager, and select Properties from the 
displayed menu. When the Properties window appears, select the Link tab, and select the item 
that matches to the connected HUB from the list box of Speed and Duplex. If you click OK, 
configuration selected in Speed and Duplex will be effective.  

 Is the transfer spped of 10G LAN port ‘100Mbps’? 

→ If you specify 100Mbps, make sure that Auto-Negotiation is specified for the connected hub. Other 
than Auto-Negotiation is not supported by 10G LAN port. 

[?] Power-saving feature does not work: 

→ The server does not support power-saving feature specified in Power Option. 

[?] Message "New Hardware Found" appears: 

→ Such a message may appear at the system startup or when a CPU/IO module is replaced and 
incorporated into the system. This is due to the server’s operating specifications and does not 
cause any problem. 
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[?] A CPU/IO module cannot be integrated: 

→ When you integrate a PCI module when replacing, starting and diagnosing the PCI module, 
following events may be recorded on System in Event Viewer, and the duplex process may fail: 

Source: srabid 

Type: Error 

Event ID: 16474 

Description: Diagnostics failure of XX: 'IO GbEnet OUI Verification 1, D821 ' (Ftn=xxxx 
Info=xxxx,xxxx） 

Source: srabid 

Type: Error 

Event ID: 16395 

Description: XX is now STATE_BROKEN /REASON_DIAGNOSTICS_FAILED 

"XX" refers to the PCI module ID. If it is PCI module 0, it is shown as "10"; if it is PCI module 1, it is 
shown as "11". As to "xxxx", the value differs depending on circumstances when errors occur. 
If the above events are recorded, follow the below prcedure to integrade the PCI module. 

(1) Select the PCI module that failed to integrate on the ft server utility. 
(2) Select Clear under MTBF clear. 
(3) Select Start to start the PCI module. 

→ When a componet fails and is reintegrated, the following message may be recorded to the system 
event log and the process is stopped. Such event indicates that the component’s MTBF is below 
the threshold and it is judged that repair is necessary. Thus the reintegration process cannot be 
completed. Generally replacement of the component will be required, so contact your sales 
representative. If reintegraating the component without repair is required for some reason, consult 
your sales agent. It is possible to perform reintegration forcefully. 

Source: srabid 

Event ID: 16395 

Description: xx is now STATE_BROKEN / REASON_BELLOW_MTBF 
(xx denotes device number.) 

[?] Screen under changing (distorted display) can be seen when screen resolution is changed: 

→ If screen resolution is changed while the entire system is under high load, screen under changing 
(distorted display) may be seen.  
This is because screen update is taking time to complete due to high load in the system. This is not 
because an error is occuring. The screen will return to normal if you wait awhile. 

[?] Screen does not appear after changing screen size: 

→ The screen may not appear if failover occurs on the system when screen size is changed. 
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[?] ESMFTPolicy log is not recorded when CPU module or PCI module changes to SIMPLEX state: 

→ ESMFTPolicy log is not recorded immediately when CPU module or PCI module changes to 
SIMPLEX state. It is recorded if the module is still SIMPLEX state after a certain period. 

Source: ESMFTPolicy 

Type: Warning 

Event ID: 2050 

Description: [CPU module or PCI module] changed to SIMPLEX state. 

On this server, this event is recorded as follows: 

Immediately after startup: 
CPU module or PCI module is still SIMPLEX state after 50 minutes has elapsed from system 
startup. 

While the system is running: 
CPU module or PCI module is still SIMPLEX state after 30 minutes has elapsed from change 
state. 

Thus, if the system is recovered to DUPLEX state within 30 minutes after change state, this 
warning event is not recorded. 
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8.8  Problem of Starting EXPRESSBUILDER on Windows 

[?] Cannot read documents: 

 Do you have Adobe Reader installed correctly in your system? 

→ To read documents, Adobe Reader needs to be installed in your computer. 

 Is your browser Internet Explorer? 

→ Internet Explorer sometimes displays the Information bar to enforce security. Click the Information 
bar to display the documents. 

[?] The menu does not appear: 

→ The Autorun feature is disabled at this server. 
When you start menu, run \autorun\dispatcher_x64.exe after setting EXPRESSBUILDER DVD. 

[?] Some menu items are grayed out: 

 Is your system environment correct? 

→ Some software requires administrator privilege or needs to be operated on the server. Run on the 
appropriate environment. 

→ Confirm the settings of [Regional and Language Options]. Set the language settings of each tab to 
English (US). 
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8.9  Problem of Bundled Software 

[?] NEC ESMPRO Agent (for Windows): 

→ For details of NEC ESMPRO Agent (for Windows), see "NEC ESMPRO Agent Installation Guide 
(Windows)" in EXPRESSBUILDER or its help. 

 

Supplementary explanation for NEC ESMPRO Agent (Windows) 

 Device ID in Alert Report 

→ Some Express5800/ft series reports use unique device IDs which correspond to the devices listed 
in the table below as the device identification information. 

Device name Device ID 

CPU module 0 0 
DIMM slot 1 on CPU module 0 0/1 
DIMM slot 2 on CPU module 0 0/2 
DIMM slot 3 on CPU module 0 0/3 
DIMM slot 4 on CPU module 0 0/4 
DIMM slot 5 on CPU module 0 0/5 
DIMM slot 6 on CPU module 0 0/6 
DIMM slot 7 on CPU module 0 0/7 
DIMM slot 8 on CPU module 0 0/8 
DIMM slot 9 on CPU module 0 0/9 
DIMM slot 10 on CPU module 0 0/10 
DIMM slot 11 on CPU module 0 0/11 
DIMM slot 12 on CPU module 0 0/12 
DIMM slot 13 on CPU module 0 0/13 
DIMM slot 14 on CPU module 0 0/14 
DIMM slot 15 on CPU module 0 0/15 
DIMM slot 16 on CPU module 0 0/16 
CPU1 on CPU module 0 0/21 
CPU2 on CPU module 0 0/22 
CPU module 1 1 
DIMM slot 1 on CPU module 1 1/1 
DIMM slot 2 on CPU module 1 1/2 
DIMM slot 3 on CPU module 1 1/3 
DIMM slot 4 on CPU module 1 1/4 
DIMM slot 5 on CPU module 1 1/5 
DIMM slot 6 on CPU module 1 1/6 
DIMM slot 7 on CPU module 1 1/7 
DIMM slot 8 on CPU module 1 1/8 
DIMM slot 9 on CPU module 1 1/9 
DIMM slot 10 on CPU module 1 1/10 
DIMM slot 11 on CPU module 1 1/11 
DIMM slot 12 on CPU module 1 1/12 
DIMM slot 13 on CPU module 1 1/13 
DIMM slot 14 on CPU module 1 1/14 
DIMM slot 15 on CPU module 1 1/15 
DIMM slot 16 on CPU module 1 1/16 
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Device name Device ID 

CPU1 on CPU module 1 1/21 
CPU2 on CPU module 1 1/22 

PCI module 0 10 
PCI slot 1 on PCI module 0 10/1 
PCI slot 2 on PCI module 0 10/2 
PCI slot 3 on PCI module 0 10/3 
PCI slot 4 on PCI module 0 10/4 
SCSI adaptor on PCI module 0 10/5 
Ethernet board 1 on PCI module 0 10/6 
Ethernet board 2 on PCI module 0 10/12 
PCI module 1 11 
PCI slot 1 on PCI module 1 11/1 
PCI slot 2 on PCI module 1 11/2 
PCI slot 3 on PCI module 1 11/3 
PCI slot 4 on PCI module 1 11/4 
SCSI adaptor on PCI module 1 11/5 
Ethernet board 1 on PCI module 1 11/6 
Ethernet board 2 on PCI module 1 11/12 
SCSI enclosure 0 10/40 
SCSI slot 1 on SCSI enclosure 0 10/40/1 
SCSI slot 2 on SCSI enclosure 0 10/40/2 
SCSI slot 3 on SCSI enclosure 0 10/40/3 
SCSI slot 4 on SCSI enclosure 0 10/40/4 
SCSI slot 5 on SCSI enclosure 0 10/40/5 
SCSI slot 6 on SCSI enclosure 0 10/40/6 
SCSI slot 7 on SCSI enclosure 0 10/40/7 
SCSI slot 8 on SCSI enclosure 0 10/40/8 
SCSI enclosure 1 11/40 
SCSI slot 1 on SCSI enclosure 1 11/40/1 
SCSI slot 2 on SCSI enclosure 1 11/40/2 
SCSI slot 3 on SCSI enclosure 1 11/40/3 
SCSI slot 4 on SCSI enclosure 1 11/40/4 
SCSI slot 5 on SCSI enclosure 1 11/40/5 
SCSI slot 6 on SCSI enclosure 1 11/40/6 
SCSI slot 7 on SCSI enclosure 1 11/40/7 
SCSI slot 8 on SCSI enclosure 1 11/40/8 

 

* "SCSI" includes SAS. 
* For R320c-E4 and R320d-E4, PCI slot 3 and PCI slot 4 do not exist on the PCI module. 

 

 LAN Monitoring Threshold 

→ Because the Express5800/ft series detects hardware faults on the network in the driver level, NEC 
ESMPRO Agent does not monitor line faults. Thus, the value set for "Line fault occurrence rate" 
of a LAN tab of NEC ESMPRO Agent properties is not used. 
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 Temperature/voltage error occurs on the CPU/PCI modules 

→ At the time when a temperature or voltage error occurs on CPU/PCI module (CPU/IO module), 
necessary actions will differ depending on their status as shown below. You can check the status 
of each module from the Information of server state/constitution of NEC ESMPRO Manager or 
ft server utility. 

Status Operation 

Duplex Stop the failed CPU/PCI module (CPU/IO module). 

Other than Duplex, Empty Shut down the system. 

 

Tips • If the status is "Empty", the module is not mounted. Sensor monitoring is not 
conducted. 

• If disks are mounted on CPU/IO modules, the status of both modules is "Simplex" 
while the disks are mirrored. Temperature or voltage error occurring during disk 
mirroring will result in the system to shut down. 

 

 The detail information of alert is displayed as "Unknown":  

→ Detail information of some alert displayed on the AlertViewer may be displayed as "Unknown". 

 The display of ft server utility is incorrect: 

→ If you open the ft server utility immediately after the system starts up, the tree may not be 
displayed correctly due to high load of the system. Wait for a while, and start ft server utility again. 

 Module status is shown "Fault": 

→ PCI modules (IO modules) and modules under the SCSI enclosure have impact on each other. For 
example, when the "Status" item of a module changes to "fault", it may be caused by other module 
error. Check the status of the other modules referring to alert message. 

 Various logs cannot be referred in ESRAS Utility: 

→ ESRAS Utility is not used with this server model. 

 Temperature/voltage error occurs on the CPU/PCI modules: 

→ At the time when a temperature or voltage error occurs on CPU/PCI module (CPU/IO module), 
necessary actions will differ depending on their status as shown below. You can check the status 
of each module from the Information of server state/constitution of NEC ESMPRO Manager or 
ft server utility. 

 
Status Operation 

Duplex Stop the failed CPU/PCI module 
(CPU/IO module). 

Simplex Shut down the system. 

 
→ Remove the disk in the following procedure. 

1. If the status is "Empty", the module is not mounted. Sensor monitoring is not conducted. 

2. If disks are mounted on PCI modules (IO modules), the status of both modules is "Simplex" 
while the disks are mirrored. Temperature or voltage error occurring during disk mirroring will 
result in the system to shut down. 

 The status of network port is displayed as an error: 

→ If a network port is not used (not connected to cable), set it to "Disable" in Network Connections 
from Control Panel. If the network ports to be disabled has dual LAN settings (AFT function), 
remove the dual LAN settings before disable it. 
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 Alert notification of monitored events 

→ In SNMP alert, the message text length is limited to 511 bytes. If the message text exceeds 512 
bytes is sent, you need to verify the full length message on Event Viewer of sender machine. To 
display the message text exceeding 512 bytes on Alert Viewer, use TCP/IP In-Band. 
Since the message text exceeds 511 bytes when CPU or PCI module is degraded, you need to 
verify ESMFTPolicy event on the sender machine. 

[?] NEC ESMPRO Manager: 

→ For details of NEC ESMPRO Manager, see "NEC ESMPRO Manager Installation Guide" in 
EXPRESSBUILDER or its help. 

 

Supplementary explanation about Information of server state/constitution of NEC ESMPRO Manager 

 Status Color after Mounting a Hard Disk Drive 

→ When creating a new mirror, the status of SCSI Enclosure and SCSI Slot of Information of 
server state/constitution will continue to change frequently after you mount a hard disk until the 
mirror is completed. During this process, the status color may turn to abnormal, but when the 
mirror is created successfully, it will return normal. 

 CPU Information 

→ The CPU information can be viewed by selecting System – CPU in the Information of server 
state/constitution screen. 

→ If you select CPU Module – CPU in the ft System tree, unknown or incorrect information appears 
in some information items. 

 Change of hardware configuration 

→ If you dynamically change the configuration of the CPU or PCI module (IO module), Information of 
server state/constitution tree may not be displayed correctly. In such a case, wait for about 5 
minutes, open Information of server state/constitution again. 

 Display immediately after system startup 

→ If you open Information of server state/constitution immediately after the system starts up, the 
tree or the state may not be displayed correctly due to high load of the system. In about 20 minutes 
after the system startup, open Information of server state/constitution again. 

 Floppy Disk Drive Name 

→ After unplugging and plugging the PCI module of the primary side, the floppy disk drive name of 
I/O Device in Information of server state/constitution may be different from the name that is 
recognized by the OS. 
Check the floppy disk drive name on Explorer. 

 Flash FDD information 

→ After turning on/off the POWER switch of CPU/IO module, the flash FDD name of I/O Device in 
Information of server state/constitution may be different from the name that is recognized by 
the OS. 
Check the Flash FDD name on the browser such as Explorer. 
If Flash FDD is added or removed while the system is running, the result is reflected to I/O Device 
in Information of server state/constitution at the next system startup. 

 Display when the PCI module (IO module) is running in the simplex mode. 

→ When only the PCI modules (IO modules) is running in the simplex mode (non-duplexed mode), 
the Information of server state/constitution cannot display the status of the SCSI Enclosure 
and Mirror Disk correctly. To check if the duplex mode is changed to the simplex mode, check the 
event log or AlertViewer log, or the status color of the PCI module by the Information of server 
state/constitution. 
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 SCSI Status while PCI module is Starting or being Stopped: 

→ While the PCI module is starting or being stopped, the status of SCSI Enclosure, SCSI Slot, and 
Mirror Disk in Information of server state/constitution may become unstable, and incorrect 
status may be displayed temporarily.  

 Display of an Unmounted Sensor 

→ An unmounted sensor is indicated as "Unknown" on Information of server state/constitution. 

Ex: Information of server state/constitution - Enclosure - Temperature 

Temperature information 

Location: DIMM2 Temp#0 
Temperature: Unknown 
Threshold: Disabled 
Status: Unknown 

 

 Pop-up "Constitution Information has changed." is displayed. 

→ If you are seeing Information of server state/constitution, pop-up is displayed when hardware 
constitution on the monitored server is changed (such as attaching or removing CPU module or 
PCI module). The information on the screen is updated afterwards. 

 System Environment Monitoring 

→ Monitoring of temperature, fan and voltage under Enclosure in Information of server 
state/constitution is set to enable and cannot be changed to disable by default. 
Information of server state/constitution - Enclosure - Temperature  
Information of server state/constitution - Enclosure - Fan  
Information of server state/constitution - Enclosure - Voltage 

 Information of the keyboard/mouse  

→ When plugging or unplugging CPU/IO module, the keyboard information under the I/O Device in 
the Information of server state/constitution may be displayed incorrectly. Restart the system. 

 Status of SCSI Slots and Mirrored Disks at High Load: 

→ When the system load is high, the status of SCSI slots and mirror disks may not be obtained, and 
incorrect status may be displayed temporarily.  

 Display of chipset type of CPU module: 

→ If Ivy Bridge is installed, the chipset type is not correctly displayed. 
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8.10  Problem of Optical Disk Drive and Flash FDD 

[?] Unable to access or play optical disks such as CD-ROMs: 

 Is the CD-ROM properly set in the optical disk drive tray? 

→ There is a holder in the tray to secure the disk. Make sure that the disk is securely placed in the 
holder. 

[?] Unable to access or play DVD/CD-ROMs: 

 Is the DVD/CD-ROM supported by the server? 

→ For a disk such as a CD with copy guard which does not conform to the CD standard, the playback 
of such a disk with the optical disk drive is not guaranteed. 

→ The DVD/CD-ROM for Macintosh is not supported. 

[?] Unable to eject a disk using the eject button: 

→ Eject the disk in the following procedure. 

1. Press the POWER switch to turn off the server (POWER LED is off). 

2. Use a 100 mm long metal pin that is 1.2 mm 
in diameter (or uncoil a thick paper clip) and 
insert it into the forced eject hole at the front 
of the tray. Keep pressing slowly until the tray
comes out. 

 
Important • Do not use anything that easily breaks such as toothpicks or plastic. 

• If you still cannot eject the disk, contact the maintenance service 
company. 

 
3. Pull the tray out with your hands. 

4. Remove the disk. 

5. Push the tray back to its original position. 

[?] Fail to access (read or write) to the Flash FDD: 

 Is the Flash FDD write-protected? 

→ Place the write-protect switch on the Flash FDD to the "Write-enabled" Position. 

 Is the Flash FDD formatted? 

→ Use a formatted Flash FDD. Refer to the manual that comes with the OS for formatting. 

 Is another Flash FDD or a floppy disk drive connected to this server besides this Flash FDD? 

→ One Flash FDD can only be connected to a USB connector of this server.  
If another Flash FDD or a floppy disk drive connected to this server, use it after removing this. 

[?] The Flash FDD doesn’t operate normally after failover: 

 Reconnect Flash FDD once after removing. 

→ When the server process failover with the Flash FDD connected, the Flash FDD is not normally 
recognized. In that case, once remove the Flash FDD, and reconnect to this server. 

[?] Icon of drive A is changed to that of removable disk: 

→ Does not cause any problem. 

 

Forced eject hole
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8.11  Active Upgrade 

 

If necessary, you can collect information about the Active Upgrade process and resolve problems by: 

• Saving the activity log to a file. 

• Viewing the status of your application services 

• Viewing the status of your installed software 

• Verifying if RDR disks are resynchronizing. 

• Learning about general problems and solutions. 

 

(1) Saving the Activity Log to a File 

If necessary, you can save the contents of the activity log to a file for later viewing. 

(a) To save the activity log to a file 

1.  Right-click on the activity log, and select Save to File in the shortcut menu. 

2.  On the Save Upgrade Log page, specify the folder name in which to save the file and the file name. 

Tips • If you have just completed an Active Upgrade session, you can also save the activity 
log by clicking Save Log on the Finish page. 

• Related topics: 
Chapter 2 (1.5.4 (9) "Viewing Active Upgrade Process Status" in Installation Guide. 

 

(2) Verifying the Status of Application Services 

At various stages of the Active Upgrade process, you can optionally verify the status of services you specified 
for control on the Application Services page of the Active Upgrade Console. 

 

(a) To verify the status of a service 

1.  Click Start - Administrative Tools - Computer Management. 

2.  Click Services and Applications - Services. 

3.  Search for an applicable service from the list of services and view its current Status and Startup Type. 

For example, while the system is in split mode, any service you selected for control by the Active Upgrade 
Console should be stopped (blank Status field) and its Startup Type should be Disabled on the Upgrade Side of 
the system. 

Tips Related topics (Installation Guide): 

• Chapter 2 (1.5.2 (4) Managing Applications during the Upgrade Process) 

• Chapter 2 (1.5.3 (5) Selecting Application Services to Control) 

• Chapter 2 (1.5.4 (9) Viewing Active Upgrade Process Status) 
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(3) Verifying the Status of Installed Software 

While you are running in split or merge mode, or after you have finished the Active Upgrade process, you might 
want to verify the status of the software packages that you installed. 

If necessary, you can view a list of most of the programs present on your system in the Programs and 
Features control panel shown below. 

 

Programs and Features Control Panel 

 

If you installed any Windows updates, select View installed updates to display the installed updates. 

 

Important If your system is in split mode, view Programs and Features of Control Panel on the 

Upgrade Side. The Running Side does not show the new software that was installed 

on the Upgrade Side. 

 

Tips Related topics (Installation Guide): 

• Chapter 2 (1.5.4 (2) (g) Running Software Installers) 

• Chapter 2 (1.5.4 (9) Viewing Active Upgrade Process Status) 
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(4) Verifying If RDR Disks Are Resynchronizing 

When you complete or abort the Active Upgrade process, the system reestablishes the mirrors between the 
RDR partner disks in each CPU/IO modules. If you intend to initiate another upgrade process, you must wait for 
the resynchronization to complete before you do so. 

You can tell if a disk is resynchronizing by viewing the LEDs on the front panel of the disk. For information about 
interpreting the LEDs, see Chapter 1 (6.1 Error Messages by LED Indication). 

(a) Disk status 

You can also view the status of your disks using one of the following methods: 

• Verify the disks on the Disk Selection page. Any volume that is in red is simplexed (and thus, probably still 
resynching). When a disk volume is only green, it is duplexed and you can start another upgrade.  
For more about the disk status on the Disk Selection page, refer to Chapter 2 (1.5.3 (3) Selecting Disks to 
Upgrade) in Installation Guide. 

• Verify the status of RDR virtual disk in RDR Utility. Follow the steps below. 

 

(b) To view the status of an RDR virtual disk in RDR Utility 

 

Important Before performing Active Upgrade process again, make sure that the value of Status 

property for all RDR virtual disk are "None". 

 

1. On RDR Utility, click Logical Disk Information. 

2. Click one of the RDR Virtual Disk items (RDR Virtual Disk x). 

3. Check the value of the Status property, which displays Resync nn% (where nn is the percentage 
completed) while the disk is resynchronizing. When the resync process is finished, the value is 
None. 

 

Tips Related topics (Installation Guide): 

• Chapter 2 (1.5.3 (3) Selecting Disks to Upgrade) 

• Chapter 2 (1.5.4 (1) Performing a Readiness Check) 

• Chapter 2 (1.5.4 (9) Viewing Active Upgrade Process Status) 
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(5) General Problems and Solutions 

Troubleshooting: Readiness Check 

The table below describes some common problems that could prevent your system from passing the readiness 
check. 

Error Action 

IO board nn is unsafe to pull Verify that all critical system resources (including disks, Ethernet PCI adapters, and 
VTMs) are configured correctly and duplexed. Refer to Chapter 2 (1.5.2 (2) 
Prerequisites) in Installation Guide for more information. 

RDR disk is not duplexed If you recently ran an upgrade session, wait for the RDR resynchronization process 
to complete before running another upgrade session. Refer to Chapter 1 (8.11 (4) 
Verifying If RDR Disks Are Resynchronizing) for more information.  

Embedded NIC not teamed Use the PROset utility to configure your Ethernet PCI adapters into teams. All 
embedded Ethernet PCI adapters must be teamed. Refer to Chapter 2 (1.5.2 (2) 
Prerequisites) in Installation Guide for more information about configuring Ethernet 
PCI adapters. 

No IP address on Upgrade 
ready team 

Use the Network Connections in Control Panel to assign an IP address 
(preferably a static IP address) to the Ethernet team. Refer to Chapter 2 (1.5.2 (2) 
Prerequisites) and (1.5.2 (3) Recommendations) in Installation Guide for more 
information about configuring Ethernet PCI adapters. 

Team does not have link on 
both sides 

Ensure that an embedded Ethernet team has at least one adapter in each CPU- I/O 
enclosure with an active network link. Verify that the network cables are plugged in 
on both sides, and that the Ethernet team has a valid IP address. Refer to Chapter 2 
(1.5.2 (2) Prerequisites) and (1.5.2 (3) Recommendations) in Installation Guide for 
more information about configuring Ethernet PCI adapters. 

Active Upgrade may fail. 
Check DHCP server 

The Active Upgrade Console cannot obtain IP addresses from your DHCP server. If 
possible, assign static IP addresses to your Ethernet teams and VTMs to avoid 
problems during the Active Upgrade process. 

 

Important Never perform hardware maintenance, such as removing and replacing system 

components, while the Active Upgrade process is running. If you experience a 

problem that prevents the Active Upgrade process from completing successfully, 

you should always be able to abort the upgrade session to restore your system to its 

original state.  
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Troubleshooting: Custom Actions  

The following tables describes some common problems with custom actions. 

 

Error Action 

The executable filename does 
not exist. 

Ensure that the executable file associated with your custom action is located in the 
directory you specified during the configuration process. Also, ensure that the 
custom action is located on a system disk, otherwise the Upgrade Side will lose 
access to the executable while the system is in split mode. 

Custom action failed with exit 
value n 

Check the output for the custom action for errors. Refer to Chapter 2 (1.5.3 (8) (d) 
Viewing Standard Output and Error Stream) in Installation Guide for more 
information. 
You must correct the problem and click Retry in the Active Upgrade Console to retry 
the current upgrade request (which also runs the custom action again). The Active 
Upgrade process will not continue until the executable for your custom action runs 
successfully. 
If possible, test and debug the executable outside of the Active Upgrade process. 
Ensure that it terminates with exit value 0 and that it completes in a timely manner.

 

Troubleshooting: Miscellaneous Problems  

 

Problem Action 

Active Upgrade console fails 
to start 

Wait a minute, and try to start Active Upgrade Console again. 
If the problem persists, it might mean that the Active Upgrade Console cannot 
communicate with related services on your local system. If your system is running a 
network firewall solution, check the firewall logs for blocked communications and 
explicitly add these items to your trusted zone.  
For information about configuring Windows Firewall, refer to Chapter 2 (1.5.2 (9) 
Configuring Windows Firewall for the Active Upgrade Process) in Installation Guide.

Failed to disable PCI device: 
QLogic Fibre Channel Adapter 

If you have installed QLogic SANsurfer Fibre Channel HBA Software to upgrade the 
BIOS in your host bus adapter, you should uninstall this utility when you are done 
upgrading the BIOS.  
If the utility remains on your system, it may retain access to storage system 
resources and prevent certain storage operations. In this case, the Active Upgrade 
Console cannot split system resources because it cannot disable the HBA on the 
Upgrade Side.  
To resolve the problem, you must abort the upgrade, uninstall SANsurfer, restart the 
system (or stop the SANsurfer service), and restart the upgrade process. 

The underlying connection 
was closed: Unable to connect 
to the remote server. 

If your system is running a network firewall solution, check the firewall logs for 
blocked communications and explicitly add these items to your trusted zone. For 
information about configuring Windows Firewall, refer to Chapter 2 (1.5.2 (9) 
Configuring Windows Firewall for the Active Upgrade Process) in Installation Guide. 

A connection attempt failed 
because the connected party 
did not properly respond... 

Unable to see the disc that 
should exist in Disk 
Management in Computer 
Management. 

Go to Disk Management and execute Disk Rescan. When the disk status appears 
Missing or Offline, right click the disk and select Disk Reactivation to verify the 
disk status becomes Online. 

 

Tips Related topics (Installation Guide): 

• Chapter 2 (1.5.4 (9) Viewing Active Upgrade Process Status) 
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8.12  Event Logs 

 

Note Confirm also "Chapter 1 (6.3 List of Windows Event Logs)". 

 
Collection of event logs may be requested by maintenance personnel at occurrence of failure. 

This section describes collected event logs. 

See Chapter 1 (7.2 Collecting Event Logs) for how to collect event logs. 

 

[?] "The NMS Service terminated unexpectedly" is recorded in the system event log: 

→ Although the following log may be recorded in the system event log when starting the system, or 
after exchanging CPU/IO modules, there is no real problem on operation.  

Change of a setup with PROSet II will become invalid if NMS service stops, but you can change a 
setup normally because NMS service will be automatically started when PROSet II is started. 

Source: Service Control Manager 

Event ID: 7031 

Description: The NMS service terminated unexpectedly. This has occurred 1 time(s). The 
following corrective action will be taken in 0 milliseconds: No action". 

[?] ACPI log is recorded in the system event log: 

→ The following log may be recorded in the system event log when reinstalling OS, but there is no 
problem with the system operation.  

Type: Error 

Source: ACPI 

Event ID: 6 

Description: IRQARB: ACPI BIOS does not contain an IRQ for the device in PCI slot 1, function 
0. 

[?] VDS Basic Provider log is recorded in the system event log: 

→ The following log may be recorded when starting Virtual Disk Service or setting duplex of disks. 
This log is recorded because the virtual controller driver involved in the disk duplex does not have 
path information properties, but there is no problem with the system operation. 

Source: VDS Basic Provider 

Type: Error 

Event ID: 1 

Description: Unexpected failure. Error code: 490@01010004 
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[?] srae1qexpress, sraixgbt, iANSMiniport-related logs are recorded in the system event log: 

→ The logs of the source "srae1qexpress", "sraixgbt", or "iANSMiniport" are the logs about the duplex 
of the network. The following logs may be recorded in the system event log after starting the 
system or after setting duplex, but there is no problem on operation. 

Source: iANSMiniport 

Type: Warning 

Event ID: 35 

Description: Initializing "Virtual Team Adaptor" that lack adapter "Number of missed adaptors". 
Check if all adapters exist and function properly.  

Source: iANSMiniport 

Type: Warning 

Event ID: 13 

Description: "Physical Adaptor" is invalid in the team.  

Source: iANSMiniport 

Type: Warning 

Event ID: 11 

Description: The following adapter link is not connected: "Physical Adaptor". 

Source: iANSMiniport 

Type: Error 

Event ID: 16 

Description: "Virtual Team Adaptor": the last adapter lost the link.  
The team network lost the connection.  

Source: iANSMiniport 

Type: Warning 

Event ID: 22 

Description: The primary adapter did not detect the following probe: "Physical Adaptor".  
Reason: The team may be divided. 

Source: srae1qexpress 

Type: Warning 

Event ID: 27 

Description: "Physical Adaptor" Network link has been disconnected.  

Source: sraixgbt 

Type: Warning 

Event ID: 27 

Description: "Physical Adaptor" Network link has been disconnected. 

The log above gets output in the process of system start up or dual mode setting. When the log is 
recorded, there is no problem to the system by the above warning if the status of the adapter in the 
team is "Active" or "Standby". For the status of the adapter, check in properties of the team 
adapter from the Device Manager.  
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[?] ESMCommonService related log is recorded in the system event log: 

→ Following event log is recorded while the system operation in some cases. The log indicates 
detection of an event that is not critical event for the server operation, and the event is amendable. 
This doesn’t affect the system as long as the event never occurs repeatedly. 

Source: ESMCommonService 

Type: Warning 

Event ID: 1309 

Description: ECC 1 bit error occurred on the system bus. 

[?] EvntAgnt log is recorded in the application event log: 

→ This event does not have any influence to the system not to SNMP services. Thus no 
measurement is required. 

Source: EvntAgnt 

Event ID: 1003 

Description: TraceFileName parameter not located in registry; Default trace file used is ???. 
「Source: EvntAgnt 

Event ID: 1015 

Description: TraceLevel parameter not located in registry; Default trace level used is 32. 

[?] Event log which warn CPU load monitoring is registered: 

→ If NEC ESMPRO Agent cannot get performance information from the OS due to a temporary 
resource shortage or high load ratio on the system, it will record the following event log. However, 
there is no real problem on operation. (In the description, Y and x represent alphanumeric 
characters. YYYY may not be acquired.) 

Source: ESMCpuPerf 

Type: Information 

Event ID: 9005 

Description: Cannot get system performance information now (YYYY Code=xxxx). 
（YYYY Code=xxxx） 

If NEC ESMPRO Agent cannot get information, it will treat the load ratio as 0%. So, if NEC 
ESMPRO Agent cannot get information continuously, the CPU load ratio may appear lower than 
the actual value. 

[?] The following system event of ACPI is logged: 

→ This event may be registered during the re-installation, it is not a problem in operating the system. 

Source: ACPI 

Type: Error 

Event ID: 6 

Description: ACPI BIOS does not contain an IRQ for the device in PCI slot 1, function 0. 

[?] Fibre Channel (N8803-038) related log is recorded in the System Event log: 

→ The following events may be recorded at the OS startup or when the module is switched including 
occurrence of module failure. This log indicates that the system has detected a non-fatal, 
correctable event for the server operation. This does not affect the system as long as this event is 
recorded consecutively. 

Source: ql2300 

Type: Error 

Event ID: 11 
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Description: Driver detected control error on \Device\Raid\Port?. 
Data : Word 
0000 : 0018000f 00680001 00000000 c004000b 
0010 : f0200000 00000000 00000000 00000000 
0020 : 00000000 00000000 00000000 00000000 
0030 : 00000000 c004000b 00000000 00000000 

Note 1: "?" indicates the board number. 

Note 2: When value is only 0xf0200000 or 0xf0260000 that is indicated in 0x0010 
word. The value is displayed in Detail tab. 

[?] Error logs are recorded while in maintenance operation: 

→ While in maintenance operation, such as detaching an PCI module, the following events may be 
recorded. These logs show that the PCI module was detached. 
This does not affect the system operation. 

Source: PlugPlayManager 

Type: Error  

Event ID: 12 

Description: The device ‘XXX’ disappeared from the system without first being prepared for 
removal. 

[?] Error logs are recorded while dumping memory: 

→ If DUMP process starts with DUMP switch or system clash, there is a possibility that the following 
log is registered on the system event log after reboot. 

source: srabid 

type: error 

ID: 4096 

Description: CpuBoard dump, to file [file path], has failed because the CpuBoard is not holding a 
valid memory dump image (0xd) 

If the following log is registered on the system event log after reboot, DUMP process saves the 
DUMP file on the HDD. (Please ignore the above log.) 

source: Microsoft-Windows-WER-SystemErrorReporting 

type: error 

ID: 1001 

Description: The computer has rebooted from a bugcheck. The bugcheck was: 
[XXX]([XXX],[XXX],[XXX],[XXX]). 
A dump was saved in: [file path name]. 
(XXX depends on condition.) 

[?] srae1qexpress or sraixgbt logs are recorded in System Event Log: 

→ The following log may recorded in System Event Log. 

source: srae1qexpress or sraixgbt 

type: warning 

ID: 40 

Description: [physical adapter name] Intel smart speed feature lowered the link speed than the 
maximum speed. 

This event log is recorded when the initial link speed cannot be retained. Quality defect of cable or 
noise may cause this event. Check the cable and connection status. 
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9. Windows System Recovery 

Recover the Windows system by following the instructions below if the files necessary to operate Windows are 
corrupt. 

 

Note • After recovering the system, be sure to install each driver and Starter Pack according 
to Chapter 1 (Installing Starter Pack) in "Installation Guide (Windows)". 

• If Hard Disk Drive cannot be recognized, you cannot recover the Windows system. 

 

 

9.1  Recovery of Windows Server 2012 

If the Windows does not start correctly, you can recover it using the feature of the Windows installation disc. 
To run this feature, start the installation disc, and then choose Repair your computer in Windows Setup 
wizard. 
We recommend that this option is performed by the system administrator. 
 

 

9.2  Recovery of Windows Server 2008 R2 

If Windows does not start for some reason, you can recover Windows using the system recovery option. Be sure 
to perform this operation under the supervision of a user or administrator who has a thorough knowledge of this 
option. For details, refer to Windows Help. 

 



10. Resetting and Clearing the Server 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 113

Chapter 1  Maintenance 

10. Resetting and Clearing the Server 

Refer to this section if the server does not work or if you want to set BIOS settings back to the factory settings. 

 

 

10.1  Software Reset 

If the server halts before starting the OS, press <Ctrl> + <Delete> + <Alt> keys. This clears all the data in 
progress in memory, and restarts the server. 

 

Note To reset the server when it is not frozen, make sure that no processing is in 
progress 

 

 

10.2  Forced Shutdown 

Use this function when an OS command does not shut down the server, POWER Switch does not turn off the 
server, or software reset does not work. 

Continue to hold POWER Switch of the server for at least 4 seconds. The power is forcibly turned off. (To turn 
on the power back again, wait at least 30 seconds after turning off the power). 

 

Note If the remote power-on function is used, cycle the power once to load the OS after 
the power has been forcibly turned off, and then turn off the power again by 
shutting down the OS. 

 

Press the POWER switch for 4 seconds or longer. 
The server is forcedly powered off. 

 

 

Press this switch for 4 seconds or longer. 



10. Resetting and Clearing the Server 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 114

Chapter 1  Maintenance 

10.3  Clearing BIOS Settings (CMOS Memory) 

To set the BIOS settings back to the factory default settings (clearing CMOS memory), use the internal jumper 
switch. 

You can also clear the password set in the BIOS Setup utility (SETUP) by using the same way.  

 

Tips When the server works, use the BIOS setup utility (SETUP) to return the settings to 
the factory defaults. 

 

To clear the password or the CMOS memory, use the corresponding jumper switch illustrated in the figure 
below. 

 

Important Do not change any other jumper switch settings. Any change may cause the 

server to fail or malfunction. 

 

CMOS Clear Jumper
(CMOSCLR) 

PASSWORD Clear Jumper 
(PASSCLR) 

Protect (factory 
default) 

Protect (factory 
default) 

Clear Clear 
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The following instructions show how to clear the CMOS memory and the password. 

 

WARNING  

  

  

  

  

 

Be sure to observe the following precautions to use the server safety. Failure to 

observe the precautions may cause death or serious injury. For details, refer to

Safety precautions in Precautions for Use in "User’s Guide". 

• Do not disassemble, repair, or alter the server. 

• Do not remove lithium batteries. 

• Disconnect the power plug before installing or removing the server. 

  

 

CAUTION  

  

  

  

 

Be sure to observe the following precautions to use the server safely. Failure to 

observe the precautions may cause burns, injury, and property damage. For 

details, refer to Safety precautions in Precautions for Use in "User’s Guide". 

• Make sure to complete installation. 

• Do not get your fingers caught. 

• Avoid installing under extreme temperature conditions. 

    

 

Important Take anti-static measures before operating the server. For detailed 

information on static electricity, see Chapter 2 (6.1.2 Anti-static Measures). 
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Clearing CMOS memory 

1. Disconnect AC power cords from CPU/IO modules 0 and 1. 

2. Remove CPU/IO module 0, and remove its top cover. 
See Chapter 2 (6.4 CPU/IO Module). 

3. Confirm the position of Clear CMOS Jumper. 

4. Change jumper switch to "CMOS CLR" position. 

5. Assemble the CPU/IO module 0. 

6. Connect AC power cords to CPU/IO modules 0 and 1 at the same time. 

7. Confirm that PRIMARY LED of CPU/IO module 0 goes on after a while. 
If PRIMARY LED of CPU/IO module 1 is lit, disconnect AC power cords from both CPU/IO modules, 
wait for 30 seconds, and connect them at the same time. 

8. When the POWER LEDs on CPU/IO modules 0 and 1 starts blinking, press the POWER switch to turn 
on the server. 

9. If the following warning message appears, press the POWER switch to power off the server. 
(POST proceeds even when the warning message is displayed.) 
 WARNING 

 8006: System configuration data cleared by Jumper. 

10. Disconnect AC power cords from CPU/IO modules 0 and 1. 

11. Remove CPU/IO module 0, and remove its top cover. 

12. Change jumper switch setting to its original position (Protect). 

13. Assemble the CPU/IO module 0. 

14. Connect AC power cords to CPU/IO modules 0 and 1 at the same time. 

15. Confirm that PRIMARY LED of CPU/IO module 0 goes on after a while. 
If PRIMARY LED of CPU/IO module 1 is lit, disconnect AC power cords from both CPU/IO modules, 
wait for 30 seconds, and connect them at the same time. 

16. When the POWER LEDs on CPU/IO modules 0 and 1 starts blinking, press the POWER switch to turn 
on the server. 

17. When the following message appears, press the <F2> key to start BIOS SETUP utility. 
  Press <F2> SETUP, <F4> ROM Utility, <F12> Network 

18. On Save & Exit menu of BIOS SETUP, select Load Setup Defaults, and then Save Changes and 
Exit. 
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Clearing a password 

1. Disconnect AC power cords from CPU/IO modules 0 and 1. 

2. Remove CPU/IO module 0, and remove its top cover. 
See Chapter 2 (6.4 CPU/IO Module). 

3. Confirm the position of Clear Password Jumper. 

4. Change jumper switch to "PASS CLR" position. 

5. Assemble the CPU/IO module 0. 

6. Connect AC power cords to CPU/IO modules 0 and 1 at the same time. 

7. Confirm that PRIMARY LED of CPU/IO module 0 goes on after a while. 
If PRIMARY LED of CPU/IO module 1 is lit, disconnect AC power cords from both CPU/IO modules, 
wait for 30 seconds, and connect them at the same time. 

8. When the POWER LEDs on CPU/IO modules 0 and 1 starts blinking, press the POWER switch to turn 
on the server. 

9. If the following warning message appears, press the POWER switch to power off the server. 
(POST proceeds even when the warning message is displayed.) 
 WARNING 

 8007:SETUP Menu Password cleared by Jumper.  

10. Disconnect AC power cords from CPU/IO modules 0 and 1. 

11. Remove CPU/IO module 0, and remove its top cover. 

12. Change jumper switch setting to its original position (Protect). 

13. Assemble the CPU/IO module 0. 

14. Connect AC power cords to CPU/IO modules 0 and 1. 
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11. System Diagnostics 

The System Diagnostics runs several tests on the server. 

From the Tool menu of EXPRESSBUILDER, select Test and diagnostics to diagnose the system. 

 

11.1  Test Items 

The following items are tested in System Diagnostics. 

• Memory 

• CPU cache memory 

• Hard disk drive  

 

Important Before executing the system diagnostics, be sure to disconnect the LAN 

cable and external I/O devices (e.g., Fibre Channel and iStorage). Executing 

the system diagnostics with them connected may affect the network or the 

system that is running. 

 

Tips On checking hard disk drives, no data is written to the disk. 

 

 

11.2  Startup and Exit of System Diagnostics 

Start up System Diagnostics in the following procedure. (If the server is running, shutdown the system.) 

 

1.  Start up EXPRESSBUILDER and select Tool menu from Boot menu. 

For information on starting up EXPRESSBUILDER, see Chapter 3 (5. Details of EXPRESSBUILDER). 

 

Note In case Language selection menu appears, select English. 

 

2.  Select Test and diagnostics. 

3.  Select End-User Mode (Basic) to start System Diagnostics. This process takes about three minutes. 
When the diagnostics is completed, the screen display changes as shown below. 

See eupro_ug_en.pdf in the \isolinux\diag folder of EXPRESSBUILDER for the End-User Mode 
(Professional) feature. 

Supervisor-Mode is intended for maintenance personnel. 
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Diagnostics tool title 
Shows the name and version of the diagnostic tool. 

Test window title 
Shows the progress of the diagnostics. “Test End” is displayed when the diagnostics completes. 

Test results 
Shows the start, end, and elapsed time and completion status of the diagnostics. 

Guideline 
Shows the details of the keys to operate window. 

Test summary window 
Shows the results of each test. Move the cursor and press <Enter> key on the cursor line to display the 
details of the test. 

When an error is detected by the System Diagnostics, the relevant test result in the Test summary 
window is highlighted in red, and “Abnormal End” is displayed in the result on the right side. 
Move the cursor to the test that detected the error, and press <Enter > key. Take notes about the error 
message that has been output to the Detail Information screen and contact the store where you 
purchased the product or your maintenance service company. 

 

Test window title

Test results

Test summary window 

Guideline 

Diagnostics tool title
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4.  Follow the guideline shown at the bottom of the screen, and press <Esc> key. 
The Enduser Menu below is displayed. 

 
<Test Result> 
Shows the diagnostics completion screen of the above diagnostics. 

<Device List> 
Shows a list of connected devices. 

<Log Info> 
Shows the log information of the diagnostics. Log information can be saved. To save it, connect a FAT 
formatted removable media, and then select Save(F). 

<Option> 
Optional features can be used from this menu. 

<Reboot> 
Reboots the hardware. 

 

5.  Select Reboot in Enduser Menu. 
The server restarts. Remove EXPRESSBUILDER DVD from the drive. 

 

System Diagnostics is now completed. 
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12. Offline Tools 

 

Offline tools are used for maintenance, failure analysis, and the settings of the server.  

 

12.1  Starting Offline Tools 

Start up the offline tools at the following steps. 

 

1.  Turn on the peripheral devices and then the server. 

2.  Press <F4> key while the message below is displayed. 

Press <F2> SETUP, <F4> ROM Utility, <F12> Network 

 
3.  Keyboard Selection Menu appears after POST completion. 

The following menu is displayed, after choosing a keyboard type. 

 
 

4.  Choose Maintenance Utility or BMC Configuration to start each tool. 

See the next section #12.2 Features of Offline Tools" for more information. 

 

Off-line TOOL MENU 

Maintenance Utility 

BMC Configuration 

Exit 
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12.2  Features of Offline Tools 

The offline Tools offer the following features. 

 
Note Disable RDX by setting RDX to hibernate mode before starting the offline tools.  

 

Off-line Maintenance Utility 

The Off-line Maintenance Utility is started when Maintenance Utility is selected. The Off-line Maintenance 
Utility is used for preventive maintenance and failure analysis for this product. When you are unable to start 
NEC ESMPRO due to a failure, the Off-line Maintenance Utility can be used to check the cause of the 
failure. 

 

Note The Off-line Maintenance Utility is intended for maintenance personnel. Consult with your 
service representative if any trouble that requires Off-line Maintenance Utility occurred. 

 
 

After starting up the Off-line Maintenance Utility, the following features are available to run. 

– IPMI Information Viewer 
Displays System Event Log (SEL), Sensor Data Record (SDR), and Field Replaceable Unit (FRU) in 
Intelligent Platform Management Interface(IPMI) and also back up such logs. 
Using this feature, system errors and events can be investigated to locate the component to be 
replaced. You can also clear the SEL area, and specify the operation when the SEL area becomes 
full. 

 
Tips DIMM information (DIMMx FRU#y) displayed when you select Display Most 

Recent IPMI Data → Field Replaceable Unit (FRU) List is the one for CPU/IO 
module on primary side. 

For the CPU/IO module on opposite side, the following message will be displayed, 
however, it is not a failure. 

WARNING! 
No Information. 
The Device is not detected or it is broken. 

 
– System Information Viewer 

Displays information on processor (CPU), BIOS. 
Also output the information to a text file. 

– System Information Management 
Set the information specific to your server (Product information, Chassis information). 

BMC Configuration 

– It is used for setups of alert functions by Baseboard Management Controller (BMC) and remote 
control functions by PC for Management. 
See Chapter 3 (2. BMC Configuration) for more information. 
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Configuring and Upgrading the System 

 
This chapter describes procedure for change configuration and installing internal option devices. 

 
1. Disk Operations 

Describes how to duplex hard disk drives and how to replace the failed hard disk drives. 
 

2. Change Drive Letter 

Describes how to add, change, or remove drive letters. 
 

3. Duplex LAN Configuration 

Describes how to configure duplex LAN. 
 

4. Express5800/ft Series Service Program Configuration 

Describes service programs used for Express5800/ft series. 
 

5. Installing Optional Devices 

Describes procedure for installing, replacing, or removing internal option devices. 
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1. Disk Operations 

Express5800/ft series duplexes disks to secure data by using "Rapid Disk Resync (RDR) function". This section 
describes operations such as configuration of dual settings to disks and replacement of disks. 

 

Tips CPU/IO module has a processor function part and IO function part. In this section, the 
processor function part is referred to as CPU module and IO function part PCI module. 

 
 

1.1  Starting RDR Utility and Its Screen 

Starting RDR Utility  

Click Start → RDR Utility to start RDR Utility. 

(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 
 

Screen 

 

* In RDR Utility, PCI module names correspond as follows: 
PCI module (CPU/IO module 0) － PCI module 10 
PCI module (CPU/IO module 1) － PCI module 11 
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Left pane 

The tree shows disks inserted into the built-in slots and virtual disks (RDR Virtual Disks) created by RDR. 
Right-click a disk on the tree to display the menu for setting RDR. By looking at the tree, you can know 
which disk corresponds to which disk of the Windows’ Disk Management and whether RDR is set to the 
disk.  

For example, in the case of the disk selected in the figure above:  

Ex:  Slot1 – Harddisk1–LUN2–PLEX0 

 (1) (2) (3) 

(1) Corresponds to the number of Windows’ Disk Management. In this example, this disk is the 
Disk1 on Disk Management.  

(2) Corresponds to the number of a virtual disk created by RDR setting. In this example, this disk is a 
disk which makes up the RDR Virtual Disk 2 (only appears for disks with RDR setting). 

(3) This section appears only for disks with RDR setting.  

 

Tips Specify disks to correspond on the RDR Utility screen. 
The correspondence of disk number displayed on Disk Management and the drive letters 
may change when the system is restarted. 

 

Right pane 

The properties of the disk selected in the left pane are shown.  

In the figure above, the properties of the disk inserted to the Slot 1 of the PCI module 10.  

 

Tips The RDR Utility display is not updated automatically. Therefore, update it by clicking 
Refresh from Action on the menu or pressing <F5> after performing operations to disk 
such as inserting/removing a disk, specifying/removing the RDR setting.  
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1.2  Disk Operations Using the RDR (Rapid Disk Resync) Function 

This section explains the disk operation by the RDR (Rapid Disk Resync) function. 

 
 

1.2.1  RDR (Rapid Disk Resync) 

RDR function of ft control software secures reliability by making disks duplexed per disk.  

Duplexing disks by the RDR function enables the disks to be resynchronized in a short period of time when their 
mirror has been broken due to causes such as CPU/IO module replacement. 

Setting RDR to disks duplexes the disks of paired slots as shown in the figure below and Windows (ex. Disk 
Management and Device Manager) recognizes paired disks as a single virtual disk. 

 

Corresponding slots 

 

Slots corresponding to the mirroring process 

 
 

Corresponding slots 

PCI module 10 (CPU/IO module 0) slot 0 ←→ PCI module 11 (CPU/IO module 1) slot 0 

PCI module 10 (CPU/IO module 0) slot 1 ←→ PCI module 11 (CPU/IO module 1) slot 1 

PCI module 10 (CPU/IO module 0) slot 2 ←→ PCI module 11 (CPU/IO module 1) slot 2 

PCI module 10 (CPU/IO module 0) slot 3 ←→ PCI module 11 (CPU/IO module 1) slot 3 

PCI module 10 (CPU/IO module 0) slot 4 ←→ PCI module 11 (CPU/IO module 1) slot 4 

PCI module 10 (CPU/IO module 0) slot 5 ←→ PCI module 11 (CPU/IO module 1) slot 5 

PCI module 10 (CPU/IO module 0) slot 6 ←→ PCI module 11 (CPU/IO module 1) slot 6 

PCI module 10 (CPU/IO module 0) slot 7 ←→ PCI module 11 (CPU/IO module 1) slot 7 

* In RDR Utility, PCI module names correspond as follows: 
PCI module (CPU/IO module 0) － PCI module 10 
PCI module (CPU/IO module 1) － PCI module 11 

 

slot1 slot3 slot5 slot7 

slot0 slot2 slot4 slot6 

slot0 slot2 slot4 slot6 

slot1 slot3 slot5 slot7 
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Important [Cautions for using the RDR function] 

• Be sure to specify RDR to all disks inserted into the built-in slots and make 
duplex settings.  

• For a disk to set RDR, use a new or physically formatted disk which has the 
same capacity. 

• For a disk to be inserted, use a new or physically formatted disk which has the 
same capacity as the synchronization source. If such a disk is not used, disks 
are not duplexed successfully. 

• As for physical format, see Chapter 3 (3.3 Physical Formatting of Hard Disk 
Drive). 
 

• Create a data disk partition after configuring the RDR. If you create a data disk 
partition before configuring the RDR, the partition’s drive letters may be deleted 
when the RDR is configured. Change drive letters see Chapter 2 (2. Change Drive 
Letter). 

• Disk may become offline when RDR is set. In this case, use "Disk Management" 
to make it online. 

 

Tips [Tips for using the RDR function] 

• RDR can be set only to the disks inserted into the built-in slots of Express5800/ft 
series.  

• RDR can be set only to the basic disk. If spanning or stripe volume is needed, first set 
RDR to basic disk, and select Disk Management to convert the disk to dynamic disk.

• If the system is shutdown (or restarted) while the mirror is broken, or a long time (30 
minutes or longer) has passed after the mirror is broken, the mirror resynchronization 
target will be the entire area of the partition existing on the disk. 
For example, if the mirroring has been broken due to a CPU/IO module failure, when 
you shut down the system and replace the CPU/IO module in such a state, the entire 
area of the partition existing on the disk needs to be resynchronized. 
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1.2.2  Making disks duplex by RDR 

The following describes the procedure to set duplex configuration to disks by RDR.  

In this example, the disks of the Slots 1 of the PCI modules 10 and 11 are duplexed.  

 
 

1. Insert a new disk to a built-in slot. 

(In this example, a disk is inserted to the Slot 1 of the PCI module 10.)  

 

Important For a disk to be inserted, use a new or physically formatted disk which has the same 

capacity as the synchronization source. If such a disk is not used, disks are not 

duplexed successfully. 

 

Tips As for physical format, see Chapter 3 (3.3 Physical Formatting of Hard Disk Drive). 

 
When a disk is inserted, a popup window asking for rebooting the system may be displayed, but there is no 
need to reboot it. Select Restart Later and close the popup window. 

 

2. From Start, select Administrative Tools and start 
Computer Management. On the tree in the left pane, 
click Storage Area - Disk Management.  
 

3. If the inserted disk is indicated as Not Initialized in the 
right pane, right-click the disk and initialize it.  

 
When a disk is initialized, a popup window asking for 
rebooting the system may be displayed, but there is no 
need to reboot it. Select Restart Later and close the 
popup window. 

 

 
4. Click Start → RDR Utility to start RDR Utility. 

(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

 

Tips • If the inserted disk does not appear on the tree, from the menu of RDR Utility, select 
Action and click Refresh or press <F5> to update the display after awhile. 

• The display of RDR Utility is not updated automatically. Therefore, update it every time 
after you perform disk operations described below. 
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5. On the left tree of RDR Utility, right-click a disk to set 
RDR and click Create RDR Virtual Disk. 

Depending on the disk condition, RDR setting may take 
some time and RDR Utility may pause for a few 
minutes. There is no error, so wait until the process is 
completed. 

 
 
 
 
 
 
 

If the system restart pop-up message appears. If you 
click Yes, the OS is restarted automatically after two 
minutes. 
Perform Step 6 and the subsequent steps. 

 

 

 

 
 
 

 
6. Insert a disk to set duplex configuration into the corresponding slot. 

(In this example, a disk is inserted into the Slot 1 of the PCI module 11.) 

When a disk is inserted, a popup window asking for rebooting the system may be displayed, but there is no 
need to reboot it. Select Restart Later and close the popup window. 
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7. On the left tree of RDR Utility, right-click a disk to set RDR and click Add physical Disk To RDR Virtual 
Disk. 
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8. Confirm that synchronizing disks are started and the DISK ACCESS LEDs and the display of RDR utility 
change as shown below: 

Synchronizing 

 DISK ACCESS LED 
RDR Utility 

Op State: State Status 

Source disk Amber 
(Blinking) 

Simplex – 

Destination disk Amber 
(Blinking) 

Syncing – 

RDR Virtual Disk – Simplex Resync x % 
(x=0,4,8,･･･96) 

 

 

 

Important Restarting the server interrupts synchronization process. Do not restart the server 

during synchronization. 

 

Tips • The time required for synchronization varies depending on the partition size on the 
disk. 
For a 136 GB partition, it takes about 100 minutes. When the partition does not exist on 
the disk, the synchronization is completed immediately after the RDR is set. However, 
when the dynamic disk is used, the time required for synchronization depends on the 
disk size regardless of whether or not the partition exists on the disk. For a 136 GB 
disk, it takes about 100 minutes. 

• When the partition does not exist on the disk, the DISK ACCESS LED is turned off on 
the source disk and the destination disk, and the status become Online. 

• DISK ACCESS LED momentarily lights green when disk is accessed. If the disk is 
accessed while the amber LED is blinking (during synchronizing), the LED seems to 
light green and amber alternately. 
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Synchronization completed 

 DISK ACCESS LED 
RDR Utility 

Op State: State Status 

Source disk Green 
(Blinking) 

Duplex – 

Destination disk Green 
(Blinking) 

Duplex – 

RDR Virtual Disk – Duplex None 

 

Tips When the partition does not exist on the disk, the DISK ACCESS LED is turned off on the 
source disk, and the status become Online. 

 

 

 

Tips When a new partition is created on the disk where RDR is configured, the created partition 
area is synchronized automatically. 

When the system is halted without shutting down Windows properly, for example, by 
pressing the POWER switch, the entire area of the partition on the synchronized disks will 
be resynchronized after the system is restarted. 
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1.2.3  Removing duplex configuration of RDR disks 

This section describes how to remove duplex configuration from the disk with RDR setting.  

In the example below, the duplex setting of the disks in the Slot 1 of the PCI modules 10 and 11 is removed. 

 

Important Do not release the RDR setting of the system disk. 

 

Tips • After running the command, RDR settings will be cancelled but other data will remain.

• You cannot release the duplex setting of the dynamic disk. 

• The display of RDR Utility is not updated automatically. Therefore, update it every time 
you check the status of disks by clicking Refresh from Action on the menu or pressing 
<F5>. 

 
1.  Click Start → RDR Utility to start RDR Utility. 

(On Windows Server 2008 R2, select Start → 
All Programs → RDR → RDR Utility to start 
RDR Utility.) 

2.  Right-click a disk you want to cancel RDR from 
the tree in the left pane, and select Delete RDR 
configuration on Physical Disk. 

3.  Click Yes on confirmation dialog box. 

   

4.  Confirm that RDR of the relevant disk is cancelled. 
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5.  Cancel the RDR of disk of the corresponding slot in the same manner. 

 

 

 

 

 

 

 

If the cancelled disk is not displayed properly on Disk Management after the RDR is cancelled. execute the 
following: 

1.  Exit Disk Management. 

2.  Open Computer Management – Service and execute "Virtual Disk (vds)". 

3.  Open Disk Management. 

If the disk contains a partition which cannot be unmounted, the OS needs to be restarted when canceling RDR. 
In that case, the system restart pop-up message appears. If you click Yes, the OS is restarted automatically 
after two minutes: 

 

Tips A partition on the disk where the RDR setting is removed is assigned an arbitrary drive 
letter by the auto mount function of the OS. If you want to reassign the drive letter of the 
partition properly, use Disk Management. See Chapter 2 (2. Change Drive Letter). 
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1.2.4  Other features of RDR Utility 

(1) Commands for physical disks 

(a) Remove Physical Disk From RDR Virtual Disk 

All data including RDR settings on a physical disk can be deleted. 

 

Tips After running the command, the physical disk becomes an empty basic disk without RDR 
settings. 

This command can only be run on physical disks in Duplex/Syncing state. 

 
1.  Click Start → RDR Utility to start RDR Utility. 

(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Right-click a target disk on the tree in the left pane, and click Remove Physical Disk from RDR Virtual 
Disk. 

3.  In the Remove Physical Disk From RDR Virtual Disk dialog box, click Yes. 

4.  In the Remove Physical Disk From RDR Virtual Disk dialog box, click OK. 

 

(b) Clear Hard MTBF 

When a hardware failure occurs to a disk, the mean time between failures (MTBF) is counted and the value 
is saved. In RDR Utility, the value is displayed at MTBF:HardCurrent and MTBF: HardNumberOfFaults. 
These MTBF values can be cleared by the Clear Hard MTBF command. 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Rght-click a target disk on the tree in the left pane, and click Clear Hard MTBF. 

3.  In the Clear Hard MTBF dialog box, click OK. 

 

(c) Clear Soft MTBF 

When a software failure occurs to a disk, the mean time between failures (MTBF) is counted and the value 
is saved. In RDR Utility, the value is displayed at MTBF: SoftCurrent and MTBF:SoftNumberOfFaults. 
These MTBF values can be cleared by the Clear Soft MTBF command. 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Right-click a target disk on the tree in the left pane, and click Clear Soft MTBF. 

3.  In the Clear Soft MTBF dialog box, click OK. 
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(d) Resynchronize This Physical Disk From RDR Virtual Disk 

Disks whose synchronization by RDR is cancelled can be resynchronized. 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Right-click a target disk in the left pane and click Resynchronize This Physical Disk From RDR Virtual 
Disk. 

3.  In the Resynchronize This Physical Disk From RDR Virtual Disk dialog box, click OK. 

4.  Confirm that the resynchronization starts and the status of disks changes as shown below: 

 
Resynchronizing 

 DISK ACCESS LED 
RDR Utility 

Op State: State Status 

Source disk  Amber 
(Blinking) 

Simplex – 

Destination disk  Amber 
(Blinking) 

Syncing – 

RDR Virtual Disk – Simplex Resync x % 
(x: Progress percentage)

 

Tips DISK ACCESS LED momentarily lights green when disk is accessed. If the disk is 
accessed while the amber LED is blinking (during synchronizing), the LED seems to light 
green and amber alternately. 

 
 

Synchronization completed 

 DISK ACCESS LED 
RDR Utility 

Op State: State Status 

Source disk Green 
(Blinking) 

Duplex – 

Destination disk Green 
(Blinking) 

Duplex – 

RDR Virtual Disk – Duplex None 
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(e) Set As Active RDR Plex 

A physical disk can be set as "Active RDR Plex" by a command. 

Active RDR Plex is the disk on which data reading process is performed when Load Balancing of RDR 
Virtual Disk is off. 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Right-click a target disk in the left pane and click Set As Active RDR Disk. 

3.  In the Set As Active RDR Plex dialog box, click OK. 

Active RDR Plex can be viewed from Active RDR Plex of RDR Virtual Disk. (In the image below, the 
disk in the slot 1 of PCI module 10 is set to Active RDR Plex among physical disks constructing RDR 
Virtual Disk 2.) 
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(2) Commands for RDR Virtual Disk 

(a) Verify RDR Virtual Disk 

Whether the synchronization by RDR is performed normally can be checked. 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Right-click RDR Virtual Disk x in the left pane and click Verify RDR Virtual Disk. 

3.  In the Verify RDR Virtual Disk dialog box, click OK. 
The progress of verification can be viewed using RDR Utility. 

 Verifying Verification completed  

Status of RDR Virtual Disk x Verify x % 
(x=0,4,8,･・･,96) 

None 

 

Note • The verification process is automatically performed every 1 month. 

• The setting for automatic verification process is stored in Task Scheduler of Windows 
OS in the following format. You can change interval of automatic verification by using 
Windows OS Task Scheduler. 
Task name: RdrVerifyLun X (X: Virtual disk number) 
 Example: RdrVerifyLun 1 (when the virtual disk number is 1) 

• The time required for verification depends on the disk size and load. 
For 136GB disk, it takes about 40 minutes. 

 

(b) Stop Verify RDR Virtual Disk 

Verification of RDR virtual disk in progress can be stopped. 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Right-click RDR Virtual Disk x in the left pane and click Stop Verify RDR Virtual Disk. 

3.  In the Stop Verify RDR Virtual Disk dialog box, click OK. 

(c) Set Resync Priority 

Priority of synchronization by RDR can be specified. By changing the priority, I/O load during 
synchronization can be reduced. 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Right-click RDR Virtual Disk x in the left pane and click Set Resync Priority. 

3.  When a dialog box appears, select Low, Normal or High (a default is Normal) and click OK. 

4.  In the Set Resync Priority dialog box, click OK. 
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(d) Set RDR LUN Load Balancing 

On or off of load balancing can be specified. 

When the load balancing is on (default), the read process is performed alternately from two physical disks 
forming the RDR Virtual Disk to improve performance. When it is off, the read process is performed from the 
physical disk specified as Active RDR Plex. 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Right-click RDR Virtual Disk x in the left pane to change the priority and click Set RDR LUN Load 
Balancing. 

3.  When a dialog box appears, select On or Off (a default is On) and click OK. 

4.  In the Set RDR LUN Load Balancing dialog box, click OK. 
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1.3  Replacing Failed Hard Disk Drives 

The following describes how to locate and replace the failed hard disk drive. 

 

Important The failed hard drive disk should be replaced with the server powered on. 

 
 

1.3.1  How to Locate Failed Disks 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  From the tree on the left pane of RDR Utility, select each disk and check the values of MTBF: Current 
and MTBF:NumberOfFaults in the right pane.  

 
Description of each MTBF value 

Property name Description  Normal value* 

MTBF: HardCurrent Mean time between hardware failures.  Unknown 

MTBF: SoftCurrent Mean time between software failures. Unknown 

* The normal value denotes the value of when no error has occurred.  
 

If either of the values is different from the normal value, the disk has an error.  
 

1.3.2  Procedures to Replace Failed Disks 

This section describes a procedure for replacing a disk when a failure occurs to a disk that is duplexed by 
the RDR function.  

Important • Do not update RDR Utility frequently immediately after inserting a disk. 

• For a disk to be inserted, use a new or physically formatted disk which has the 
same capacity as the disk of the corresponding slot (in this example, the disk in 
slot 1 of the PCI module 10) 

 

Tips • The display of RDR Utility is not updated automatically. Therefore, update it every time 
you check the status of disks by clicking Refresh from Action on the menu or pressing 
<F5>. 

• When the disk is physically formatted and recycled, the inserted disk might be 
automatically set to RDR. 

 
 

Here, an example that a failure of the disk in slot 1 of the PCI module 10 is explained. 

1.  Click Start → RDR Utility to start RDR Utility. 
(On Windows Server 2008 R2, select Start → All Programs → RDR → RDR Utility to start RDR Utility.) 

2.  Remove the disk in the slot 1 of the PCI module 10. 

3.  Wait for at least 15 seconds, and insert a new disk to the slot 1 of the PCI module 10 
If a popup window asking for rebooting the system is displayed, select Restart Later and close the 
popup window. 

4.  Right-click on the inserted disk after inserting the disk and execute Add Physical Disk To RDR Virtual 
Disk. 
When Add Physical Disk To RDR Virtual Disk completes, the synchronization process starts. 
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5.  Confirm that the DISK ACCESS LEDs and the display of RDR Utility change as shown below: 

Synchronizing 

 DISK ACCESS LED 
RDR Utility 

Op State: State Status 

Source disk Amber 
(Blinking) 

Simplex – 

Destination disk Amber 
(Blinking) 

Syncing – 

RDR Virtual Disk – Simplex Resync x % 
(x=0,4,8,･･･96) 

 

 

Important If the system is rebooted during synchronization, the process cannot be completed. 

Do not restart the system until the synchronization is completed. 

 

Tips • The time required for synchronization varies depending on the partition size on the 
disk. 
For a 136 GB partition, it takes about 100 minutes. When no partition exists on the disk, 
synchronization is completed immediately after the RDR is set. 
However, when the dynamic disk is used, the time required for synchronization 
depends on the disk size regardless of whether or not a partition exists. For a 136 GB 
disk, it takes about 100 minutes.  

• DISK ACCESS LED momentarily lights green when disk is accessed. If the disk is 
accessed while the amber LED is blinking (during synchronizing), the LED seems to 
light green and amber alternately. 
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Synchronization completed 

 DISK ACCESS LED 
RDR Utility 

Op State: State Status 

Source disk  Green 
(Blinking) 

Duplex – 

Destination disk  
 

Green 
(Blinking) 

Duplex – 

RDR Virtual Disk – Duplex None 
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2. Change Drive Letter 

To add, change or delete drive letters, follow the steps below. Before making any changes, thoroughly read the 
Express5800/ft series-specific precautions and general precautions for Windows.  

 

Express5800/ft series-specific precautions 

When connecting an optional Flash FDD, drive letters may change from A to B or from B to A by switching 
CPU/IO modules. This does not affect the operation of the server. Access the Flash FDD with the changed drive 
letter. 
 

General precautions for Windows 

• Drive letter of system volume or boot volume cannot be changed.  

• Up to 26 drive letters can be used on a computer. "A" and "B" are drive letters for Flash FDD. Generally, 
hard disk drives are assigned "C" to "Z", but for network drives, drive letters are assigned in a reverse order 
("Z" to "C").  

• Because many of Windows programs refer to specific drive letters, cautions are required for assigning drive 
letters. For example, the Path environment variable specifies a program name and a specific drive letter.  

• For performing the procedure above, you need to be a member of Backup Operators group or 
Administrators group, or you need to have appropriate authorization.  

 
1.  Select Start - Administrative Tools and open Computer Management.  

2.  In the console tree of Computer Management, click Disk Management.  

3.  Right-click a target partition, logical drive or volume and click Change Drive Letter and Paths….  

4.  Perform one of the following:  

– To assign a drive letter, click Add…, a drive letter to use, then OK.  

– To change a drive letter, click the drive letter to change, Change…, a drive letter to use, then OK.  

– To delete a drive letter, click the drive letter to delete then Remove.  
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3. Duplex LAN Configuration 

The Express5800/ft series builds a duplex LAN configuration by using "Stratus emb-82576 2-Port Gigabit 
Adapter" or "Stratus emb-X540 2-Port Copper 10 Gigabit Adapter(*)" mounted as standard on the CPU/IO 
module and the additional LAN card "Stratus 82576 2-Port Copper Gigabit Adapter" or "Stratus X540 1-Port 
Copper 10 Gigabit Adapter". 

(*) Express5800/R320c-E4 and R320d-E4 do not have this adapter. 

 

3.1  Overview 

The duplex LAN configuration is of three types as described below: 

 

Adapter Fault Tolerance (AFT) 

AFT is a feature that places more than one LAN adapters on the same switch, and automatically switches 
the process of the active adapter to the standby adapter when any trouble occurred on the active adapter. 

Usually the active adapter is used for communication. Spanning Tree Protocol (STP) of the switch must be 
disabled. 

Adaptive Load Balancing (ALB) 

ALB includes features of AFT, and enhances the throughput by distributing packet transmission by using 
LAN adapters simultaneously. 

Receive Load Balancing (RLB) is enabled by default. Disable RLB and remove adapter priority when using 
ALB. 

Switch Fault Tolerance (SFT) 

SFT is a feature that provides redundant network, as two adapters are connected to corresponding two 
switches. One is allocated to the active adapter and the other is allocated to the standby adapter. Usually 
the active adapter is used for communication. 

Spanning Tree Protocol (STP) function is required to construct the path redundancy on the switch devices. 

When you construct the environment, you need to set the switch priority in order to maintain the path to the 
active adapter after the path information is updated if a switch on the path is broken. In addition, you need to 
set the priority to use the standby adapter's switch if the active adapter's switch is broken. 

The other modes, "Static Link Aggregation", "IEEE 802.3ad Link Aggregation", and "Virtual Machine Load 
Balancing" do not contribute to enhancement of network redundancy. When a fault occurs, the communication 
performed on the controller with the fault is not taken over by the standby controller but lost. 

 



3. Duplex LAN Configuration 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 145

Chapter 2  Configuring and Upgrading the System 

3.2  Rules of Duplex Configuration on Express5800/ft series 

Ensure to make the setting of duplex network configuration on the server. 

When building duplex configuration, be sure to use both adapters of CPU/IO module 0 and of 1. 

 

Example1) Configure the duplex network which enhances the availability by using all adapters.  

 

 

 

Example 2) Configure the duplex network which corresponds to multiple LAN connection.  

 

 

 

CPU/IO module 1CPU/IO module 0

Network 

Network 2 

Network 1 

CPU/IO module 1CPU/IO module 0
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3.3  Configuring Duplex LAN 

The following explains how to configure duplex/dual LAN. 

The screen images used in this section are for Windows Server 2008 R2. 

 

Note • Because the configuration from the remote site may fail, you need to log on as an 
Administrator or a member of Administrators group. 

• A team assigned to the virtual network by Hyper-V Virtual Network Manager cannot be 
used in Active Upgrade. 
When you use Active Upgrade, at least one team not assigned to virtual network is 
required. 

• Before replacing the back panel of CPU I/O module, 1000BASE-T 2ch board set 
(N8804-009), or 10GBASE-T 1ch board set (N8804-011), be sure to remove duplex 
LAN, and create a team after the replacement. 
See Chapter 2 (3.4 Removing Duplex LAN) for how to remove duplex LAN. 
See Chapter 2 (3.3 Configuring Duplex LAN) for how to configure duplex LAN. 

• The screen images are subject to change because of the network driver 
version.Substitute as appropriate when content has been modified. 

 

(1) Start Device Manager.  

Select Start - Administrative Tool - Computer Management - Device Manager. 

 

Note If network adapters are duplicated as shown below, remove all network adapters from 
Device Manager, and select Action – Scan for hardware changes. 

Stratus emb-82576 2-Port Gigabit Adapter 
Stratus emb-82576 2-Port Gigabit Adapter 
Stratus emb-82576 2-Port Gigabit Adapter #2 
Stratus emb-82576 2-Port Gigabit Adapter #2 

The display will be as follows when the actions are performed properly. 

Stratus emb-82576 2-Port Gigabit Adapter 
Stratus emb-82576 2-Port Gigabit Adapter #2 
Stratus emb-82576 2-Port Gigabit Adapter #3 
Stratus emb-82576 2-Port Gigabit Adapter #4 

When using 10GBASE-T, the network adapter names are shown in "Stratus X540 1-Port 
Copper 10 Gigabit Adapter" and "Stratus emb-X540 2-Port Copper 10 Gigabit Adapter". 
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(2) Create team adapter. 

1.  Select a target Network Adapter. Right-click on it and select Properties from the menu displayed to 
show the Properties window. 

 

2.  Select the Teaming tab on the properties dialog box. Select the Team this adapter with other 
adapters, and then click the New Team… button. 

 

Screen when using Stratus emb-82576 2-Port Gigabit Adapter and  

Stratus 82576 2-Port Copper Gigabit Adapter 

 

 



3. Duplex LAN Configuration 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 148

Chapter 2  Configuring and Upgrading the System 

 

Screen when using Stratus emb-X540 2-Port Copper 10 Gigabit Adapter  

and Stratus X540 1-Port Copper 10 Gigabit Adapter 

3.  Enter the team name and click Next. 

 
 

Note Specify the team name with 3 or more characters. 

If the team name is specified with 3 or less characters, creating the secondary team will fail 
with the following pop-up message displayed: 
"Failed to create a team." 
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4.  Select the adapters to include in the team and click Next. 

 
 

Note Check "PCI bus" and "Function (*)" of adapters to be included in the team. 
Use adapters of the same functionality. Create a team with an adapter having smaller PCI 
bus number and an adapter having larger PCI bus number. 

(*) "Function" can be verified in General tab of Properties window. 

PCI bus: Smaller value (PCI module #0 side) 
Larger value (PCI module #1 side) 

Function: 0 (Port #0 side) 
1 (Port #1 side) 

Example: 

Team 0 
PCI bus (smaller value), Function 0 (Port #0 side) 
PCI bus (larger value), Function 0 (Port #0 side) 

Team 1 
PCI bus (smaller value), Function 1 (Port #1 side) 
PCI bus (larger value), Function 1 (Port #1 side) 

 
5.  Select Adapter Fault Tolerance, Adaptive Load Balancing, or Switch Fault Tolerance as a team 

type (Usually select Adapter Fault Tolerance). Click Next.  

 
 

Note Virtual Machine Load Balancing is displayed when Hyper-V feature is enabled. 
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6.  Select Standard Server from the dropdown list on "Select a profile to apply to the team", and click 
Next. 

 
 

Note The dialog box "Select a profile to apply to the team" may not be displayed.  
In such a case, go to Step 7. 

 
7.  Click Finish. 

 

 



3. Duplex LAN Configuration 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 151

Chapter 2  Configuring and Upgrading the System 

(3) Setting team adapter 

 

1.  Start Command prompt and enter as follows to check the physical MAC address of team adapter. 
> ipconfig /all 

 

2.  Select the Team Adapter you have set from Device Manager. Right-click on it and select Properties 
from the menu displayed to show the Properties dialog box. 
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3.  Specify the physical address (MAC address) of team adapter as follows: 

– Select the Advanced tab on the properties dialog box. Select Locally Administered Address from 
the Settings list box. 

– Enter the MAC address of a Team Adapter, which you have checked in Step 1, in the Value text box. 

– Click OK. 

 

4.  Disable probe function when the team configured with only two adapters. 

– Select the Advanced tab in the Properties window. Select Probes from the Settings list box. 
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– Click Properties button. Probes dialog appears. Turn off the Send Probes in the dialog. 

 

– Click OK. 

The Probe setting is not displayed when Switch Fault Torelance (SFT) feature is specified.  
Go to Step 5. 

 

Note When Probe is enabled in an environment where the team is configured with two adapters, 
if either of adapters fails, the other (healthy) adapter may be recognized as failed. If the 
team is configured with four adapters, you do not need to disable Probe. 

 
5.  When you select Adaptive Load Balancing as a team type, you need to disable Receive Load Balancing 

and delete the adapter priority. 

– Select the Advanced tab on the properties dialog box. Select Receive Load Balancing from the 
Settings: list box, and then select Disabled from the Value: drop down list. 

 

– Click OK to apply a change. The dialog will close. 

– Show the properties dialog again. 

– Select the Settings tab on the properties dialog box and click Modify Team button to display the 
dialog box. 
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– Select the adapter that the priority is set, and then press the Remove Priority button to remove the 
priority. 

 

– Click OK to close dialog box. 
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3.4  Removing Duplex LAN 

This section describes how to remove duplex/dual LAN. 

 

Note • Because the configuration from the remote site may fail, you need to log on as an 
Administrator or a member of Administrators group. 

• Do not remove duplex LAN in any other procedure than described below. Doing so 
may affect the files required for configuring/removing the team. 

 
1.  Select Start - Administrative Tool - Computer Management - Device Manager. 

2.  Select the Team Adapter of which you want to remove duplex/dual LAN. Right-click on it, and then 
select Properties from the menu displayed to show the properties dialog box.  

 

3.  Select the Settings tab in the properties dialog box and click the Remove Team button. 

 

4.  The confirmation dialog box appears. Click Yes button. 
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4. Express5800/ft Series Service Program 
Configuration 

Express5800/ft series uses the following service programs, in addition to dedicated drivers. 

 

Service program names shown in [Services] 
Services that can be 

stopped 
Services required to 

keep operating 

ftSys eService  ○ 

ftSys Maintenance and Diagnostics (MAD)  ○ 

ftSys RPC Provider  ○ 

ftSys SSN  ○ 

ftSys RAS  ○ 

Windows Management Instrumentation  ○ 

SNMP Service ○  

Alert Manager Main Service ○  

Alert Manager Socket(S) Service ○  

ESMFSService ○  

ESMCommonService ○  

ESRAS Utility Service ○  

ESMPS ○  

ESMBmcConfigMonitoring ○  

Virtual Disk(vds)  ○ 

DHCP Client  ○ 

 

Important • The programs listed in "Services required to keep operating" are necessary for 
the Express5800/ft series operation. Do not stop these services. 
When minimizing the number of operating service programs temporarily is 
required, the programs listed in "Services that can be stopped" may be stopped: 
Make sure to restart the operations of stopped service programs immediately 
after the backup processes are completed. 

• .NET Framework and Visual C++ library (Microsoft Visual C++ Redistributable) 
are installed together with ft Server Control Software when setting up this server.
These components are required for operating service programs dedicated to ft 
server. Do not uninstall them. 

 

Tips Service programs dedicated to ft server are as follows: 

• ftSys eService 
This service outputs SEL (System Event Log). 

• ftSys Maintenance and Diagnostics (MAD) 
This service provides ft control management and diagnostics functions. 

• ftSys RPC Provider 
This service manages WMI configuration and status. 

• ftSys SSN and ftSys RAS 
This service controls communications between modules (when such as executing the 
Active Upgrade). 
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5. Installing Optional Devices 

This section describes procedures to add/remove optional devices and replace failed components. 

 

Important • Optional devices described in this chapter may be installed or removed by the 
user. However, NEC does not assume any liability for damage to optional 
devices or the server or malfunctions of the server resulted from installation by 
the user.  

• Use only the devices and cables specified by NEC. You will be charged to repair 
damages, malfunctions, and failures caused by the use of any devices or cables 
not specified for use with this server even within the warranty period. 

 

5.1  Before Starting Work 

5.1.1  Safety precautions 

 

Observe the following notes to install or remove optional devices safely and properly. 

 

WARNING  

  

  

  

  

Be sure to observe the following precautions to use the server safety. Failure to 

observe the precautions may cause death or serious injury. For details, refer to Safety 

precautions in Precautions for Use. 
 

• Do not disassemble, repair, or modify the server. 

• Do not look into the DVD-ROM drive. 

• Do not remove the lithium battery, NiMH battery, or Li-ion battery. 

  

 

CAUTION  

  

  

  

Be sure to observe the following precautions to use the server safely. Failure to 

observe the precautions may cause burns, injury, and property damage. For details, 

refer to Safety precautions in Precautions for Use in User's Guide. 

• Do not install CPU/IO module with its cover removed. 

• Make sure to complete component installation. 

• Do not pinch your finger(s). 

• Pay attention to hot components. 
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5.1.2  Anti-static measures 

 

The server contains electronic components sensitive to static electricity. Avoid failures caused by static 
electricity when installing or removing any optional devices. 

 

Wear wrist straps (arm belts or anti-static gloves). 

Wear wrist straps on your wrists. If no wrist strap is available, touch an unpainted metal part of the cabinet 
before touching a component to discharge static electricity from your body. 

Touch the metal part regularly when working with components to discharge static electricity. 

Select a suitable workspace. 

Work with the server on the anti-static or concrete floor. 

When you work with the server on a carpet where static electricity is likely to be generated, make sure take 
anti-static measures beforehand. 

Use a worktable. 

Place the server on an anti-static mat to work with it. 

Clothes 

Do not wear a wool or synthetic cloth to work with the server. 

Wear anti-static shoes to work with the server. 

Take off any metal accessories you wear (ring, bracelet, or wristwatch) before working with the server. 

Handling of components 

Keep any component in an anti-static bag until you actually install it to the server. 

Hold a component by its edge to avoid touching any terminals or parts. 

To store or carry any component, place it in an anti-static bag. 

 

5.1.3  Pre-upgrade verification 

If you add on optional devices onto this server, some devices require specific ft server software version (s). 

If the optional device requires specific version number (s), take the following procedure before adding the 
devices. 

 

1.  Confirm the required ft server control software’s version, Refer to the User’s Guide provided with the 
device, check the NEC website, or contact your sales representative. 

2.  Verify the version of the ft control software on your system. 

3.  After confirming that the version of ft control software is appropriate to the optional device, add the 
device onto the server. 

For more information on how to verify the working ft server control software version, refer to Chapter 1 (3.14 
Confirming the ft Server Control Software Version (for Windows Server 2012)) or (4.15 Confirming the ft Server 
Control Software Version (for Windows Server 2008 R2)) in Installation Guide. 
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5.1.4  Preparing your system for upgrade 

 

Note the following, when installing or replacing devices, to improve the performance of Express5800/ft series. 

 

• With the Express5800/ft series, devices can be replaced during the continuous operation. 
Take extreme care for electric shock and damage to the component due to short-circuit. 

• Optional devices cannot be installed or removed during continuous operation. 
After shutting down OS, check that the server is powered off, disconnect all power cords and interface 
cables from the server before installing or removing the optional devices. 

• To remove the CPU/IO module during the continuous operation, disable the intended module (place the 
module off-line) by using either of the following methods: 

– ft server utility of the NEC ESMPRO Agent 

– NEC ESMPRO Manager from the management PC on the network 

After a new module is installed to the server, enable the module using the ft server utility or the NEC 
ESMPRO Manager. 

 

Tips The system is defaulted to automatically boot the module, once installed. For more 
information, see Chapter 1 (4.7 Setup of System Operation). 

 
• Make sure to provide the same hardware configuration on both CPU/IO modules (except SAS board). 

• Use the same slots and sockets on both groups. 

• Do not install those devices having different specifications, performance, or features. 

• Before removing the set screws from the CPU/IO modules, place the desired module off-line using the ft 
server utility or the NEC ESMPRO Manager. 
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5.2  Available Option Devices 

Option devices that can be added, removed, or replaced are as follows: 

 

• 2.5-inch hard disk drive 
The server can contain up to 16 hard disk drives. 
Install hard disk drives in 2.5-inch hard disk drive bay at front of the server. 

 

• DIMM 
Up to 256 GB (16 16-GB DIMMs) can be installed. 
After removing the CPU/IO module, install DIMMs in DIMM sockets on motherboard of the server. 

 

• Processor (CPU) 
Up to two CPUs can be installed. 
After removing the CPU/IO module, install CPU in CPUs sockets of the server. 

 

• PCI card 
Up to two cards can be installed on R320c-E4 or R320d-E4 model, or up to 4 cards on R320c-M4 or 
R320d-M4 model. 
After removing the CPU/IO module, install PCI card in PCI card slot of the server. 

 



5. Installing Optional Devices 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 161

Chapter 2  Configuring and Upgrading the System 

5.3  2.5-inch Hard Disk Drive 

 

The 2.5-inch hard disk drive bays in front of the server can mount up to 16 hard disk drives with the 2.5 inch 
width exclusive trays. 

 

Important • Do not use any hard disks that are not authorized by NEC. Installing a third-party 
hard disk may cause a failure of the server as well as the hard disk.  

• Purchase hard disks of the same model in pair. Contact your sales agent for hard 
disk drives optimum for your server. 

 

The operation is executed on the created mirror volume with installed hard disk drive pairs such as slot 0 on 
CPU/IO module 0/1, slot 1 on CPU/IO module 0/1, slot 2 on CPU/IO module 0/1. (The OS is installed on the 
mirror volumes that consist of the hard disks in the slot 0.) 

 

Slots to execute the mirroring process 

 

Empty slots in the 2.5-inch hard disk drive bay contain dummy trays. The dummy trays are inserted to improve 
the cooling effect in the server. Always insert the dummy trays in the slots with no hard disks drive installed. 

 

 

Slot 0 Slot 2 Slot 4 Slot 6 Dummy tray

Slot 1 Slot 3 Slot 5 Slot 7 

CPU/IO module 0

CPU/IO module 1
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5.3.1  Installing 2.5-inch Hard Disk Drive 

 

Follow the procedure below to install the hard disk drives. Install the hard disk drives from a smaller slot number 
to large number on CPU/IO module 0/1, from slot 0 to slot through slot 7. 

 

Important • See Chapter 2 (5.1.2 Anti-static measures) and Chapter 2 (5.1.4 Preparing your 
system for upgrade) before starting installing or removing options. 

• You must mount two HDDs that form dual disk configuration before starting the 
OS. 

 

Tips You can install a hard disk drive without shutting down the OS. 

In this case, you can skip Step 1 "Shutdown the OS" and Step 8 "Press the POWER switch 
to power on". 

 

1.  Shut down the OS.  
The system turns off automatically. 

2.  Remove the front bezel. 

3.  Identify the slot to which you want to install a hard disk drive. 

4.  If a dummy tray is inserted in a slot you want to install the hard disk drive, remove the dummy tray. 

 

Important Keep and store the dummy tray for future use. 

 

 

5.  Unlock the hard disk drive.  
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6.  Firmly hold the handle of the hard disk drive to install and insert the drive into the slot.  

 

Note • Insert the hard disk drive until the lever hook touches the server frame. 

• Check the direction of the lever. Insert the hard disk drive with the lever unlocked. 

 

 
7.  Slowly close the lever. When the lever is locked, you will hear a click sound. 

 

Important Be careful not to pinch your finger(s) between the lever and tray. 

 

Note Check the hook of the lever is engaged with the frame. 

 

 
8.  Press the POWER switch to power on. 

9.  Install the front bezel. 

10.  See Chapter 2 (1.2.2 Making disks duplex by RDR) to set the dual disk configuration. 
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5.3.2  Removing 2.5-inch Hard Disk Drive 

 

Follow the procedure below to remove the hard disk drive. 

 

Important See Chapter 2 (5.1.2 Anti-static measures) and Chapter 2 (5.1.4 Preparing your 
system for upgrade) before starting installing or removing options. 

 

1.  Shut down the OS. 
The system turns off automatically. 

2.  Remove the front bezel. 

3.  Push the lever of the hard disk to unlock the drive, 
and pull the handle toward you.  

4.  Hold the handle and hard disk drive to pull them off.  

5.  Install the dummy tray in an empty tray according to 
procedures described in Chapter 2 (5.3.1 Installing 
2.5-inch Hard Disk Drive). 
Ensure to install the dummy slot in the empty slot to 
improve the cooling effect within the server. 
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5.3.3  Replacing 2.5-inch Hard Disk Drive 

 

Follow the procedure below to remove the failed hard disk drive. The hard disk drive is replaced with new device 
with the server powered on. 

 

Important • See Chapter 2 (5.1.2 Anti-static measures) and Chapter 2 (5.1.4 Preparing your 
system for upgrade) before starting installing or removing options. 

• You can replace a hard disk drive during continuous operation.  

 

(1) Replacing the Hard Disk Drive 

1.  Locate the failed hard disk drive.  
When a hard disk drive fails, the DISK ACCESS LED on the hard disk drive’s handle lights amber.  

2.  Remove the failed hard disk according to Chapter 2 (5.3.2 Removing 2.5-inch Hard Disk Drive). 

3.  Follow the steps in Chapter 2 (5.3.1 Installing 2.5-inch Hard Disk Drive) to install a new hard disk drive. 

 

Note • The hard disk drive to be installed for replaced must have the same specifications as 
its mirroring hard disk drive. 

• Use unsigned hard disk drive for replacement. To use the signed disk, it is necessary 
to recover the duplex configuration according to Chapter 3 (1. Disk Operations) after 
formatting the disk physically. 
As to physical format, see Chapter 3 (3.3 Physical Formatting of the Hard Disk Drive).

 
4.  Restore the redundant configuration. 

See Chapter 2 (1.3 Replacing Failed Hard Disk Drives). 
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5.4  CPU/IO Module 

 

To replace a CPU (processor, DIMM (memory), PCI card, you need to remove the CPU/IO module.  

 

Important • See Chapter 2 (5.1.2 Anti-static measures) and Chapter 2 (5.1.4 Preparing your 
system for upgrade) before starting installing or removing options. 

• To install or remove CPU or DIMM, first power off the server before removing the 
CPU/IO module. 

• Removing the module being operating may cause unexpected trouble. Use the 
management software (e.g., ft server utility or NEC ESMPRO Manager) to isolate 
the module to be removed so that the module is removed when it is stopped, 
without fail. 
Then remove the relevant module after verifying the Status LED on the CPU/IO 
module. See Chapter 1 (6.1 Error Messages by LED Indication) for details of the 
Status LED. 

• When replacing both CPU/IO modules, replace one module and wait until dual 
configuration is established to replace the other module. If you replace the both 
modules simultaneously, establishing dual CPU/IO module configuration can 
result in interruption of the whole system. 
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5.4.1  Removing CPU/IO Module 

 

Follow the procedure below to remove the CPU/IO module. 

 

1.  Stop the CPU/IO module you want to remove. 

To this end, use the ft server utility of the NEC ESMPRO Agent installed to your server or the 
Information of server state/constitution of the NEC ESMPRO Manager. 

For the detailed procedure, see Chapter 1 (4. Maintenance of Express5800/ft series). 

 

NEC ESMPRO Manager 

Select ft System - CPU Module - CPU Module (to be removed) - Maintenance - Bring Up/Bring 
Down - Bring Down. 
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ft server utility 

Select ftServer - CPU Module - CPU Module (to be removed) - Bring Up/Bring Down - Down. 

 

 

Repeat the steps above for the PCI module and confirm that the status of the CPU/IO module and 
the IO module (PCI module) are "Removed".  

 

Tips When removing CPU/IO module 0, select Bring Down for CPU module (ID:0) and PCI 
module (ID:10)  

 

2.  Remove the front bezel 

3.  Disconnect the power cord of a module to be removed.  
The stopper will go down when you disconnect the cable. 

 

 

 

 

 

 

 

Note Check whether the stopper goes down after disconnecting the power cord. If you 
disconnect the cable and the stopper does not go down, you cannot pull out the CPU/IO 
module in the next step. 

 

Stopper 
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4.  Loosen the screws securing the CPU/IO module handle to press down the handle.  

 

Important Before you pull out a CPU/IO module, check the rear of the server to make sure 

cables for connection with peripheral equipment or network are disconnected.  

If any cables are connected, keep a record of where the cables are connected and 

disconnect all cables from the module you are going to remove. 

 

Tips If you cannot disconnect the LAN cable easily, disconnect while pressing the latch with a 
slotted screwdriver. 

 

 

5.  Hold the black levers of the CPU/IO module and pull it off. 
Pull it off until it is locked and stopped. 

 

Important • Do not hold part other than the handle to pull the module.  

• Handle the CPU/IO module carefully. Do not drop the module or bump it against 
parts in the device when you remove it.  
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6.  The CPU/IO module is locked on the way and cannot be pulled out. Lower the lock on the side of CPU/IO 
module to unlock it, and then pull it out. 

 

 

7.  Pull out the CPU/IO module gently and carefully, and place it on a flat and sturdy table. 
Avoid the dusty or humid place. 

 

This allows you to access the devices in the CPU/IO module. For more information on how to handle these 
devices, see the associated sections. 

 

 

Lock 
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5.4.2  Installing CPU/IO Module 

Follow the procedure below to install the CPU/IO module:  

 

Important • See Chapter 2 (5.1.2 Anti-static measures) and Chapter 2 (5.1.4 Preparing your 
system for upgrade) before starting installing or removing options. 

• Insert the black lever slowly and fasten the screws tightly. Be careful not to 
cause a shock to the device at this time.  

 

1.  Firmly hold the CPU/IO module with both hands and insert it into the rack.  
Hold the CPU/IO module in such a way that its back panel connector faces the back of the rack and 
engage the guides of the module and chassis, and insert it slowly. 

 

2.  Push up the black levers placed on the left and right sides of the front of the CPU/IO module, and fasten 
them with screws. 

 

Important • Secure the handle with the screws. If it is not secured by the screws, the 
operation of the CPU/IO module will be unstable. 

• In some system statuses or settings, auto start up or integration does not take 
place when the module is connected. In such a case, check the status by using 
the ft server utility or "Information of server state/constitution" of NEC ESMPRO 
Manager, and then start up the CPU/IO modules. 

 

3.  Connect the cables for connecting the peripheral devices and network. 

4.  Hold the stopper with your hand and insert the cable of the installed module. 

5.  The installed CPU/IO module will be automatically started. 
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5.5  DIMM 

The DIMM (dual inline memory module) is installed to the DIMM socket on motherboard in the CPU/IO module 
of the Express5800/ft series. 

The motherboard of CPU/IO module has 16 sockets for DIMM. 

 

Tips • Maximum memory capacity depends on server model as follows: 
Up to 256GB (16GB x 16) 

• In the error messages and logs in POST, NEC ESMPRO, or Off-line Maintenance 
Utility, the DIMM connector may be described as "group". The number next to "group" 
corresponds to the slot number shown in the figure on the next page. 

 

Important • The DIMM is extremely sensitive to static electricity. Make sure to touch the 
metal frame of the server to discharge static electricity from your body before 
handling the DIMM. Do not touch the DIMM terminals or onboard parts with a 
bare hand or place the DIMM directly on the desk. 

• Make sure to use the DIMM authorized by NEC. Installing a third-party DIMM may 
cause a failure of the DIMM as well as the server. Repair of the server due to 
failures or damage resulted from installing such a board will be charged. 

• Before adding or removing DIMMs, power off the server and detach the CPU/IO 
module. 

• See Chapter 2 (5.1.2 Anti-static measures) and Chapter 2 (5.1.4 Preparing your 
system for upgrade) before starting installing or removing options. 

 

 

CPU/IO board in the CPU/IO module 

 

DIMM slot 1 
DIMM slot 2 
DIMM slot 3 
DIMM slot 4 

DIMM slot 8 
DIMM slot 7 
DIMM slot 6 
DIMM slot 5 

DIMM slot 9 
DIMM slot 10 
DIMM slot 11 
DIMM slot 12 

DIMM slot 16 
DIMM slot 15 
DIMM slot 14 
DIMM slot 13 
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Precautions 

Note the following to install, remove, or replace DIMM. 

 

• DIMM 9 through 16 are available only when the processor #2 is installed. 

• To install DIMM, install the product with the same serial number to the same slots of the CPU/IO modules 0 
and 1. 

• See the following table to install additional DIMM. 

Allowable DIMM 
capacity 

Slot number to install DIMM 

No. of 
CPUs 

Capacity
(GB) 

1 2 3 4 8 7 6 5 9 10 11 12 16 15 14 13

1 4 4                

8 4  4              

12 4  4     4         

16 4  4   4  4         

20 4 4 4   4  4         

24 4 4 4 4  4  4         

28 4 4 4 4  4 4 4         

32 4 4 4 4 4 4 4 4         

32 8  8   8  8         

48 8 4 8 4 4 8 4 8         

64 8 8 8 8 8 8 8 8         

64 16  16   16  16         

96(*) 16 8 16 8 8 16 8 16         

128(*) 16 16 16 16 16 16 16 16         

2 4 4                

8 4        4        

12 4  4      4        

16 4  4      4  4      

24 4  4     4 4  4     4

32 4  4   4  4 4  4   4  4

40 4 4 4   4  4 4 4 4   4  4

48 4 4 4   4 4 4 4 4 4   4 4 4

56 4 4 4 4  4 4 4 4 4 4 4  4 4 4

64 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4

64 8  8   8  8 8  8   8  8

96 8 4 8 4 4 8 4 8 8 4 8 4 4 8 4 8

128 8 8 8 8 8 8 8 8 8 8 8 8 8 8 8 8

128 16  16   16  16 16  16   16  16

192(*) 16 8 16 8 8 16 8 16 16 8 16 8 8 16 8 16

256(*) 16 16 16 16 16 16 16 16 16 16 16 16 16 16 16 16

 

(*) R320c-M4 or R320d-M4 model only 
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5.5.1  Installing DIMM 

 

Follow the procedure below to install the DIMM.  

 

1.  Shut down OS. 
The sever turns off automatically. 

2.  Disconnect the power cords from the outlets. 

3.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

4.  Remove three screws (two on the front and one on the rear), and remove the top cover of the CPU/IO 
module. 

 

5.  Open the cable clamp of air duct. 
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6.  Disconnect cables. 

 

7.  Remove the air duct. 

 

8.  Locate the socket you are mounting the DIMM. 

9.  Remove the dummy memory module by opening the levers on both sides of the DIMM slot. 

 

 

Important Keep and store the removed dummy memory module with care. 

 

Air duct 

Dummy memory module DIMM socket 
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10.  Insert a DIMM into the DIMM socket vertically. 

After the DIMM is completely inserted into the socket, the levers are automatically closed. 

 

 
 

Note Pay attention to the direction of the DIMM.  
The terminal of the DIMM has a cutout to prevent incorrect insertion. 

 

11.  Attach the air duct, cable, and cable clamp. 

 

12.  Place the top cover of the CPU/IO module and secure it with three screws. 

 

 

SAS1
SAS2
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13.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 

14.  Connect the power cords. 

15.  Press the POWER switch to power on the server. 

16.  Verify that POST displays no error message. 
If POST displays an error message, write it down and see the POST error message list in Chapter 1 (6.2 
POST Error Message). 

17.  After starting the OS, set the paging file size to at least the recommended value (1.5 times the installed 
memory size). (Refer to Chapter 3 (3.1 Before Starting Setup) in Installation Guide. 
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5.5.2  Removing DIMM 

 

Follow the procedure below to remove the DIMM.  

 

Important At least one DIMM is required to operate the server. 

 

1.  Shutdown OS. 
The system turns off automatically. 

2.  Disconnect the power cords from the outlets. 

3.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

4.  Remove three screws (two on the front and one on the rear), and remove the top cover of the CPU/IO 
module. 

 

5.  Open the cable clamp of air duct. 
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6.  Disconnect cables. 

 

7.  Remove the air duct. 

 

8.  Open the levers attached on both sides of the socket of the DIMM to be removed.  
It will be unlocked and the DIMM can be removed. 

 

9.  Attach the dummy memory module. 

Air duct 
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10.  Attach the air duct, cable, and cable clamp. 

 

11.  Place the top cover of the CPU/IO module and secure it with three screws. 

 

12.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 

13.  Connect the power cords. 

14.  Press the POWER switch to power on the server. 

15.  Verify that POST displays no error message. 
If POST displays an error message, write it down and see the POST error message list in Chapter 1 (6.2 
POST Error Messages). 

 

 

5.5.3  Replacing DIMM 

 

Follow the procedure below to replace a failed DIMM. 

1.  Identify the failed DIMM by viewing the memory slot error LED. 

2.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

3.  Replace the DIMM. 

4.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 

5.  Start up the CPU/IO module using NEC ESMPRO Manager or ft server utility. 

 

SAS1 
SAS2 
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5.6  Processor (CPU) 

 

In addition to the standard CPU (Intel® Xeon® Processor), you can operate the system by adding one CPU. 

 

Important • The CPU is extremely sensitive to static electricity. Make sure to touch the metal 
frame of the server to discharge static electricity from your body before handling 
the CPU. Do not touch the CPU terminals or onboard parts with a bare hand or 
place the CPU directly on a desk. 

• Make sure to use the CPU specified by NEC. Installing a third-party CPU may 
cause a failure of the CPU as well as the server. Repairing the server due to 
failures or damage resulting from these products will be charged even if it is 
under guarantee. 

• Before adding or removing a CPU, power off the server and then remove the 
CPU/IO module. 

• See Chapter 2 (5.1.2 Anti-static measures) and Chapter 2 (5.1.4 Preparing your 
system for upgrade) before starting installing or removing options. 

 

 

 

 

CPU1 
(Standard CPU) 

CPU2 
(Additional CPU) 
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5.6.1  Installing CPU 

 

Follow the steps below to install a CPU and heat sink. 

 

1.  Shut down the OS.  
The server is automatically powered off. 

2.  Disconnect the power cords from the outlets. 

3.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

4.  Remove the air duct according to Chapter 2 (5.5.2 Removing DIMM). 

5.  Verify the location of the CPU socket. 

6.  Remove four screws that secure the dummy heat sink. Remove the dummy heat sink. 

 

Important Keep and store the removed dummy heat sink and four screws with care. 

 

 

 

7.  Remove the protective cover from processor (CPU) socket. 

 

Important Keep and store the removed protective cover with care. 

 

 

Dummy heat sink
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8.  Push down the lever marked with " →" to unlatch from the hook, and open the lever until it stops. 

 

9.  Push down the lever marked with "← " to unlatch from the hook, and open the lever until it stops. 

 

10.  Lift the plate.  

 

11.  Place the CPU on the socket gently and carefully. 
For easy installation, hold edges of CPU with your thumb and index fingers so that the notch is aligned 
with the key on the CPU socket. 

 

Important • Be sure to hold the CPU only at the edges.  

• Pay attention not to touch the bottom of the CPU (pin section). 

 

Note • Insert the CPU while aligning the notch on the processor with the key on the CPU 
socket. 

• Bring down the CPU straight without tilting or sliding it in the socket. 

 

 

 

Notch 

Key 

Pin mark

Pin mark
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12.  After pressing the CPU softly against the socket, and close the plate. 

 
13.  Fix the CPU by pushing down the lever marked with "← " 

 
14.  Fix the CPU by pushing down the lever marked with " →" 

 

15.  Place the heat sink on the CPU. 

 

Important Do not touch the cooling sheet that is attached on the back of the heat sink with your 

hand. 
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Important If you install additional CPU, ensure that the fins of the additional CPU’s heat sink 

are in the same direction as those of the standard CPU. 

 

16.  Secure the heat sink with four screws. 

 

Important Tentatively secure the screws diagonally with the order as shown in the figure 

below, check that the heat sink is attached to the CPU socket in parallel, then tighten 

the screws diagonally. 

 

1

3

4

2  
17.  Install the air duct according to Chapter 2 (5.5.1 Installing DIMM). 

18.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 

19.  Connect the power cords. 

20.  Press the POWER switch to power on the server. 

21.  Verify that POST displays no error message. 
If POST displays an error message, write it down and see the POST error message list in Chapter 1 (6.2 
POST Error Messages). 

 

5.6.2  Removing CPU 

Remove the heat sink and CPU in the reverse procedure of installation.  

 

Heat sink of 
additional CPU 

Heat sink of 
standard CPU 

装置前面Front of 
server 



5. Installing Optional Devices 
 

 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 186

Chapter 2  Configuring and Upgrading the System 

5.6.3  Replacing CPU 

Take the steps below to replace the failed CPU. 

 

1.  Identify the failed CPU by viewing Event Log. 

2.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

3.  Install the new heat sink and CPU. 

4.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 

5.  Start the CPU/IO module from NEC ESMPRO Manager or ft server utility. 
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5.7  PCI Card 

 

Either two or four PCI cards can be installed to the CPU/IO module. 

Important The PCI card is extremely sensitive to static electricity. Make sure to touch the metal 

frame of the server to discharge static electricity from your body before handling the 

PCI card. Do not touch the PCI card terminals or onboard parts by a bare hand or 

place the PCI card directly on the desk. 

See Chapter 2 (5.1.2 Anti-static measures) and Chapter 2 (5.1.4 Preparing your 
system for upgrade) before starting installing or removing options. 

 

5.7.1  Precautions 

Note the following to install or replace PCI card. 

• To make a dual PCI card configuration, install the same type of board (i.e., having the same specifications 
and performance) to the same slot for each group. 
When a PCI card is installed to one group, another identical PCI card should be installed to the same slot in 
another group. This rule is applied to the case of removal. 

 

 

PCI1 PCI2 

R320c-E4, R320d-E4 model (without PCI riser card)  

PCI2 PCI1 PCI4 PCI3 PCI Riser card 

R320c-M4 model, R320d-M4 model (with PCI riser card) 
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List of option PCI cards and installable slots (R320c-E4, R320d-E4 model) 

N code 
Product 

name 

 PCI-1 PCI-2

Remarks 
PCI slot performance PCIe 2.0 x4 lane

Slot size Low Profile 

PCI card type x8 socket 

N8804-009 1000BASE-T 2ch board set ○ ○ *1 

N8804-011 10GBASE-T 1ch board set ○ ○ *1 *2 

N8803-038 Fibre Channel board set ○ ○ *1 

N8803-039 SAS board ○ ○ *2 

 
*1: Exact the same card must be mounted into the same slot for each CPU/IO module 0, 1. 
*2: Up to one card can be installed for each CPU/IO module and up to two boards can be installed for each device. 
 

List of option PCI cards and installable slots (R320c-M4, R320d-M4 model) 

N-code 
Product 

name 

 PCI-1 PCI-2 PCI-3 PCI-4 

Remarks 
PCI slot performance PCIe 2.0 x4 lane PCIe 2.0 x8 lane 

Slot size Low Profile Full Height 

PCI card type x8 socket 

N8804-009 1000BASE-T 2ch board set ○ ○ ○ ○ *1 

N8804-011 10GBASE-T 1ch board set – – ○ ○ *1 *2 

N8803-038 Fibre Channel board set – – ○ ○ *1 

N8803-039 SAS board ○ ○ ○ ○ *2 

 
*1: Exact the same board must be mounted into the same slot for each CPU/IO module 0, 1. 
*2: Up to one board can be installed for each CPU/IO module and up to two boards can be installed for each device. 
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5.7.2  Installing PCI Card 

Follow the procedure below to install the board to be connected to the PCI card slot. 

 

Note To install the PCI card, make sure the shape of the board connector matches with the 
shape of the PCI card slot connector. 

 

(1) Installing Low Profile PCI Card 

 

1.  Shut down the OS.  

2.  The server is automatically powered off. 

3.  Disconnect the power cords from the outlets. 

4.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

5.  Remove one screw that secures the stopper and 
remove the stopper.  

6.  Verify the location of the CPU socket.  

7.  Remove the PCI bracket cover. 

 

Important Keep and store the removed PCI bracket cover with care. 

 

 

Stopper 
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8.  Install a PCI card in a PCI slot. 

9.  Install the stopper and secure it with one screw. 

10.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 

11.  Connect the power cords. 

12.  Press the POWER switch to power on the server. 

13.  Verify that POST displays no error message. 
If POST displays an error message, write it down and see the POST error message list in Chapter 1 (6.2 
POST Error Messages). 

14.  After the OS has started, proceed to steps in Chapter 2 (5.7.5 Setup of Optional PCI Card). 
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(2) Installing Full Height PCI Card 

1.  Shut down the OS.  
The server is automatically powered off. 

2.  Disconnect the power cords from the outlets. 

3.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

4.  Remove one screw that secures the stopper and 
remove the stopper. 

5.  Remove three screws that secure the PCI riser card, 
and remove the PCI riser card from the motherboard. 

6.  Remove one screw that secures the stopper and 
remove the stopper from the PCI riser Card. 

7.  Verify the location of the PCI slot. 

 

 

Stopper 

Stopper 
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8.  Remove the PCI bracket cover. 

 

Important Keep and store the removed PCI bracket cover with care. 

 

 
 

9.  Install a PCI card in a PCI slot. 

 

10.  Install the stopper and secure it with one screw. 

11.  Install PCI riser card on the motherboard and secure 
it with three screws. 
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12.  Install the stopper and secure it with one screw. 

13.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 

14.  Connect the power cords. 

15.  Press the POWER switch to power on the server. 

16.  Verify that POST displays no error message. 
If POST displays an error message, write it down and see the POST error message list in Chapter 1 (6.2 
POST Error Message). 

17.  After the OS has started, proceed to steps in Chapter 2 (5.7.5 Setup of Optional PCI Card). 

 

5.7.3  Removing PCI Card 

 

To remove PCI card card, follow the reverse procedure of the installation and install the slot cover.  
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5.7.4  Replacing PCI Card 

 

Follow the procedure below to replace the failed PCI card.  

 

(1) N8803-039 SAS board 

 

1.  Identify the failed board by viewing Event Log. 

2.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

3.  Remove the PCI bracket, then remove the PCI card.  

4.  Replace the board and secure it. 

5.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 

6.  Connect the network cable and cables for option devices. 

7.  The installed CPU/IO module will start automatically. 

8.  Confirm that the PCI card is correctly recognized by POST and OS. 

 

(2) N8803-038 Fibre Channel board set 

 

1.  Identify the failed board by viewing Event Log. 

2.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

3.  Configure WWPN of Fibre Channel board to be installed (setting/confirming access control) by using 
control software such as iStorageManager. 

4.  Remove the PCI bracket, then remove the PCI card. 

5.  Replace the board and secure it. 

6.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 

7.  Connect the network cable and cables for option devices. 

8.  The installed CPU/IO module will start automatically. 

9.  Confirm that the PCI card is correctly recognized by POST and OS. 

(3) 1000BASE-T board set (N8804-009), 10GBase-T 1ch board set (N8804-011) 

1.  Identify the failed board by viewing Event Log. 

2.  Remove the duplex LAN according to Chapter 2 (3.4 Removing Duplex LAN). 

3.  Remove the CPU/IO module according to Chapter 2 (5.4.1 Removing CPU/IO Module). 

4.  Remove the PCI bracket, then remove the PCI card. 

5.  Replace the PCI card and secure it. 

6.  See Chapter 2 (5.4.2 Installing CPU/IO Module) and install the CPU/IO module. 
The installed CPU/IO module starts automatically. 

7.  Confirm that the PCI card is correctly recognized by POST and OS. 

8.  Create a team according to Chapter 2 (3.3 Configuring Duplex LAN). 

9.  Connect the network cable and cables for option devices. 
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5.7.5  Setup of Optional PCI Card 

 

Important To enable the fault-tolerant feature of the optional device, the identical PCI cards 

must be installed to the slots with the same number in CPU/IO module 0 and CPU/IO 

module 1.  

For the supported connecting devices, contact your sales agent. 

 

(1) N8804-009 1000BASE-T 2ch board set, N8804-011 10GBASE-T 1ch board set 

 

Important For LAN cable’s connector, use a RJ-45 connector which is compliant with IEC8877 

standard. If any other connector is used, it may not be removed easily.  

 

• Slots to install optional PCI cards 

See "List of option PCI cards and installable slots" in Chapter 2 (5.7.1 Precautions). 

• Driver installation procedure 

Install N8804-009 1000BASE-T 2ch board set or N8804-011 10GBASE-T 1ch board set, and restart the 
system. 

After starting the system, the driver will be installed automatically. When the system is started, New 
Hardware Found window may appear.  

• Configure duplex LAN 

See Chapter 2 (3. Duplex LAN Configuration). 

• Configure network 

 

Tips To perform this procedure, you have to log on the system as an Administrator or a member 
of the Administrators group. 

 

Follow steps below to specify transfer speed and duplex mode for the driver. 

 

Note If the check box in Internet Protocol (TCP/IP) is unchecked, first check and then configure 
the IP address. 

 

(1) Launch Device Manager. 

(2) Expand network adapter tree and double-click Added NIC. 
The Properties dialog box of network adapter appears. 
The name of LAN card is as follows: 
Stratus 82576 2-Port Copper Gigabit Adapter 
Stratus X540 1-Port Copper 10 Gigabit Adapter 

(3) Select the Link speed tab, and configure value of Speed and Duplex to match those of the hub. 

(4) Click OK on Properties dialog box of network adapter. 

(5) By the same procedure, configure another network adapter. 
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Add/remove protocol or services if needed. On Network Connections, go to Local Area connection 
property’s dialog box. 

 

Note It is recommended to add Network monitor as one of the services.  
Network monitor can monitor frames (or packets) sent or received by a computer where 
Network monitor is installed. This is a useful tool to analyze network failure.  

Refer to Chapter 1 (5.3  Installing Network Monitor) in Installation Guide for the installation 
procedure. 

 

(2) N8803-038 Fibre Channel Board Set 

• Slots to install optional PCI cards 

See "List of option PCI cards and installable slots" in Chapter 2 (5.7.1 Precautions). 

• Driver installation procedure 

Install N8803-038 Fibre Channel board and start the system. 
After starting the system, the driver will be installed automatically. When the system is started, New 
Hardware Found window may appear. 

 

Important • StoragePathSavior is necessary to connect NEC iStorage using N8803-038 Fiber 
Channel boards.  

• Mount N8803-038 Fibre Channel boards after completing the OS installation. 
They are used in a pair. Mount each controller on the slot of the same position of 
each PCI module. 

 
• Driver for Fibre Channel controller 

The following programs may be installed on the server at shipment. These programs are also installed when 
you re-install an OS by using EXPRESSBUILDER DVD, and displayed on Programs and Features page. 

These programs are driver for Fibre Channel controller. They are installed even if no Fibre Channel 
controller is connected with the server to enable the additionally installed controller can be detected 
automatically. 

– QInstaller 

– QLogic Adapter Drivers and Management Software Installer 

– SANsurfer FC HBA Manager 

QInstaller is installed only when the server has no Fibre Channel controller connected. If the server has 
Fibre Channel controller connected, QInstaller will not appear on Programs and Features page, however, it 
is not the problem. 

(3) N8803-039 SAS Board 

• Slots to install optional PCI cards 

See "List of option PCI cards and installable slots" in Chapter 2 (5.7.1 Precautions). 

• Driver installation procedure 

Install N8803-037 SAS board and start the system.  
After starting the system, the driver will be installed automatically. When the system is started, New 
Hardware Found window may appear. 
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NEC Express5800 Series 
Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4 

Useful Features 
This chapter describes convenient features for using the server. Refer to this chapter according to your purpose 
and need. 

 

1. System BIOS 

Describes how to set the System BIOS settings and parameters. 
 

2.  BMC Configuration 

Describes the BMC Configuration Utility in Off-line Tool of the server. 
 

3.  SAS Configuration Utility 

Describes the SAS Configuration Utility of the server. 
 

4.  Flash FDD 

Describes the Flash FDD. 
 

5.  Details of EXPRESSBUILDER 

Describes the EXPRESSBUILDER attached to the server. 
 

6.  EXPRESSSCOPE Engine 3 

Describes EXPRESSSCOPE Engine 3. 
 

7.  NEC ESMPRO 

Describes NEC ESMPRO Agent and NEC ESMPRO Manager, applications to manage and monitor the 

server. 
 

8. NEC Product Info Collection Utility 

Describes the device information collection utility. 
 

9. Express Report Service / Express Report Service (HTTPS) 

Describes Express Report Service / Express Report Service (HTTPS), a service to notify of a fault 

information automatically. 
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1. System BIOS 

You can check and change the parameters using the BIOS Setup utility (SETUP). 

 

 

1.1  Starting SETUP 

Turn on the server and proceed with POST. 

After a while, the following message appears at the bottom left of the screen. 

Press <F2> SETUP, ...  (* a different message may appear depending on the environment) 

If you press <F2>, SETUP will start after POST, and the Main menu appears. (You can also start SETUP by 
pressing <F2> key while expanding option ROM.) 

 

 

1.2  Parameter Descriptions 

The SETUP utility has the following six major menus. 

• Main 

• Advanced 

• Security 

• Server 

• Boot 

• Save & Exit 

These menus have submenus for relevant items. Selecting submenus allows you to configure further detailed 
parameters. 
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1.2.1  Main 

If you start up the SETUP utility, the Main menu is displayed first.  

 

For details about the options, see the table below. 

 

Option Parameter Descriptions 

BIOS Information – – 

BIOS Version – The BIOS version is displayed (display only). 

Build Date MM/DD/YYYY The BIOS build date is displayed (display only). 

Access Level [Administrator] 
User 

The current access level (Administrator or User) is 
displayed (display only). 
If no password is set, Administrator is displayed. 

Memory Information – – 

Total Memory – The total capacity of installed memory is displayed 
(display only). 

System Date WWW MM/DD/YYYY Set the system date. 

System Time HH:MM:SS Set the system time 

   [    ]: Factory settings

 

Tips Be sure to confirm that the date and time in the BIOS parameters are correctly 
configured. 

Check the system clock monthly. Additionally, if you implement the server in a 
system that requires highly accurate time, use of a time server (an NTP server) is 
recommended. 

If the system time becomes considerably slow or fast over time even though you 
regularly adjust it, contact the dealer where you purchased the server or the 
maintenance service company for maintenance. 
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1.2.2  Advanced 

If you move the cursor to Advanced, the Advanced menu appears. 

For the menus that show a “ ” to their left, select a menu and press the <Enter> key to display its submenu. 

 

 

 

(1) Processor Configuration submenu 

From the Advanced menu, select Processor Configuration and then press the <Enter> key to display the 
menu screen shown below. For the menu that has  on the left, move the cursor to it and then press the 
<Enter> key to show its submenus. 
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For details about the options, see the table below. 

 

Option Parameter Descriptions 

Processor Information – – 

Hardware Prefetcher Disabled 
[Enabled] 

Enable or disable hardware prefetcher. 

Adjacent Cache Line Prefech Disabled 
[Enabled] 

Enable or disable optimized access from memory to 
cache. 

Execute Disabled Bit Disabled 
[Enabled] 

Enable or disable Execute Disable Bit feature. This 
option is displayed only when the installed processor 
supports this feature. 

VT-x Disabled 
[Enabled] 

Enable or disable Intel Virtualization Technology (feature 
to virtualize processor). 

Active Processor Cores [All] 
1-8 

Specify the number of cores to enable in each processor 
package. The number of cores that can be specified 
depends on the processor installed. 

Hyper-Threading Disabled 
[Enabled] 

Enable or disable the feature to execute two threads with 
only one core. This option is displayed only when the 
installed processor supports this feature. 

  [    ]: Factory settings

 

(a) Processor Information submenu 
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For details about the options, see the table below (display only). 

 

Option Parameter Descriptions 

Processor 1 CPUID Number  ID of Processor 1 is displayed by a numerical value. 

Processor Type – Type of Processor 1 is displayed. 

Processor Speed – Clock speed of Processor 1 is displayed. 

Active Cores – The number of active cores in Processor 1 is displayed. 

Max Cores – The maximum number of cores in Processor 1 is displayed.

L2 Cache RAM – The secondary cache size of Processor 1 is displayed. 

L3 Cache RAM – The tertiary cache size of Processor 1 is displayed. 

Microcode Revision – The revision of the microcode applied to Processor 1 is 
displayed. 

EMT64 Supported 
Not Supported 

Whether the Intel 64 architecture is supported on Processor 
1 or not is displayed. 

Hyper-Threading Supported 
Not Supported 

Whether the Hyper-Threading Technology is supported or 
not on Processor 1 is displayed. 

Processor 2 CPUID Number  
Not Installed 

ID of Processor 2 is displayed by a numerical value. 
Not Installed indicates that no processor is installed in 
processor socket 2. 

Processor Type – Type of Processor 2 is displayed. 

Processor Speed – Clock speed of Processor 2 is displayed. 

Active Cores – The number of active cores in Processor 2 is displayed. 

Max Cores – The maximum number of cores in Processor 2 is displayed.

L2 Cache RAM – The secondary cache size of Processor 2 is displayed. 

L3 Cache RAM – The tertiary cache size of Processor 2 is displayed. 

Microcode Revision – The revision of the microcode applied to Processor 2 is 
displayed. 

EMT64 Supported Whether the Intel 64 architecture is supported on Processor 
2 or not is displayed. 

Hyper-Threading Supported Whether the Hyper-Threading Technology is supported or 
not on Processor 2 is displayed. 

  [    ]: Factory settings
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(2) Memory Configuration submenu 

From the Advanced menu, select Memory Configuration and then press the <Enter> key to display the menu 
screen shown below. For the menu that has  on the left, move the cursor to it and then press the <Enter> key 
to show its submenus. 

 

 

 

For details about the options, see the table below. 

 

Option Parameter Descriptions 

Memory Information – – 

  [    ]: Factory settings
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(a) Memory Information submenu 

 

 

For details about the options, see the table below (display only). 

 

Option Parameter Descriptions 

Total Memory – The physical capacity of installed memory is displayed. 

Available under 4GB – Memory capacity available in an area under 4 GB is 
displayed. 

CPU1_DIMM1-8 Status 
CPU2_DIMM9-16 Status 

Number 
Not Present 
 

Capacity and status of each DIMM is displayed. 
Number: indicates memory capacity and DIMM is 
working normally. 
Not Present: Indicates no DIMM is installed. 

  [    ]: Factory settings
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(3) PCI Configuration submenu 

From the Advanced menu, select PCI Configuration and then press the <Enter> key to display the menu 
screen as shown below. 

 

 

 

For details about the options, see the table below. 

 

Option Parameter Descriptions 

SAS Option ROM Scan Disabled 
[Enabled] 

Enable or disable the option ROM SCAN for onboard 
SAS. 

LANX Option ROM Scan Disabled 
[PXE Boot] 
iSCSI Boot 
 

Enable or disable the option ROM SCAN for onboard 
LAN. 
R320c-M4, R320d-M4 X:1/2/3/4 
R320c-E4, R320d-E4 X:1/2 

PCI Slot X Option ROM 
 

[Disabled] 
Enabled 

Enable or disable the option ROM on each PCI slot. 
R320c-M4, R320d-M4 X:1/2/3/4 
R320c-E4, R320d-E4 X:1/2 

  [    ]: Factory settings

 

Note For a RAID Controller, LAN card (network boot), or Fibre Channel controller, if no 
Hard Disk Drive on which an OS is installed is connected, set the option ROM for 
that slot to Disabled. 
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(4) Advanced Chipset Configuration submenu 

From the Advanced menu, select Advanced Chipset Configuration and then press the <Enter> key to 
display the menu screen as shown below. 

 

 

 

For details about the options, see the table below. 

 

Option Parameter Descriptions 

HPET Disabled 
[Enabled] 

Enable or disable the High-Precision Event Timer. This 
feature may not be supported depending on OS. 

Wake On LAN/PME Disabled 
[Enabled] 

Enable or disable the feature that remotely powers on 
the server through a network.  

  [    ]: Factory settings
 

Important The menu for VT-d and I/OAT may be displayed depending on your server model. 

However, do not change settings. 

VT-d must be Disabled, and I/OAT must be Enabled. 
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(5) USB Configuration submenu 

From the Advanced menu, select USB Configuration and then press the <Enter> key to display the menu 
screen shown below. 

 

 

 

For details about the options, see the table below. 

 

Option Parameter Descriptions 

Device Reset Timeout 10 sec 
[20 sec] 
30 sec 
40 sec 

Specify the timeout period when Start Unit command is 
issued to USB Mass Storage Device. 

  [    ]: Factory settings
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(6) Serial Port Configuration submenu 

From the Advanced menu, select Serial Port Configuration and then press the <Enter> key to display the 
menu screen shown below. 

 

 

 

From BIOS Redirection Port, select Serial Port A or Serial Port B and then press the <Enter> key to display 
the menu screen shown below. 
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For details about the options, see the table below. 

Option Parameter Descriptions 

Serial Port A Settings – – 

Serial Port A Disabled 
[Enabled] 

Enable or disable serial Port A. 

Serial A Base I/O [3F8h] 
2F8h 
3E8h 
2E8h 

Specify the base I/O address for serial port A. 

Serial A Interrupt [IRQ 4] 
IRQ 3 

Specify the interrupt for serial port A. 

Serial A Connection [Serial Connector] 
Internal Modem 

Specify the connection destination for serial port A, Serial 
connector or Internal modem. 

Serial Port B Settings – – 

Serial Port B Disabled 
[Enabled] 

Enable or disable serial Port B. 

Serial B Base I/O 3F8h 
[2F8h] 
3E8h 
2E8h 

Specify the base I/O address for serial port B. 

Serial B Interrupt IRQ 4 
[IRQ 3] 

Specify the interrupt for serial port B. 

Console Redirection Settings – – 

BIOS Redirection Port [Disabled] 
Serial Port A 
Serial Port B 

Enable or disable the console redirection feature for the 
specified serial port. Specifying Serial Port A or Serial Port B 
allows direct connection via terminal unit such as NEC ESMPRO 
Manager, and options for connection shown below are 
displayed. 

Terminal Type [VT100+] 
VT-UTF8 
PC-ANSI 

Select the terminal type. 

Baud Rate 9600 
19200 
57600 
[115200] 

Specify baud rate. 

Data Bits 7 
[8] 

Specify data bit width. 

Parity [None] 
Even 
Odd 

Specify parity type. 

Stop Bits [1] 
2 

Specify stop bits. 

Flow Control None 
[Hardware RTS/CTS] 

Specify the flow control method. 

Continue C.R. after POST Disabled 
[Enabled] 

Select whether the console redirection is continued after 
completion of POST or not. 

Console Connection [Direct] 
Via modem 

Specify the connector to be used for console. 

  [    ]: Factory settings
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1.2.3  Security 

If you move the cursor to Security, the Security menu appears. For the menu that has  on the left, move the 
cursor to it and then press the <Enter> key to show its submenus. Then configure the settings. 

 

 

 

Select Administrator Password or User Password, and then press the <Enter> key to display the screen 
where you can register/change the password. 

 

Tips • User Password cannot be set without setting Administrator Password  

• Do not set any password before installing OS. 

• If you have forgotten any password, contact the store where you purchased the 
product or your maintenance service company. If you clear the password set in 
the BIOS Setup utility (SETUP), see Chapter 1 (10 Resetting and Clearing the 

Server). 
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For details about the options, see the table below. 

 

Option Parameter Descriptions 

Password Configuration – – 

Administrator Password Up to 20 alphanumeric 
characters 

When the <Enter> key is pressed, the password entry 
screen to set administrative right is displayed. 
This password can be used to access all SETUP menus. 
Password can be set only when SETUP is started by 
administrative right. If no password is set, SETUP starts 
with administrative right. 

User Password Up to 20 alphanumeric 
characters 

When the <Enter> key is pressed, the password entry 
screen to set user right is displayed. With this password, 
access to SETUP menus is limited. The user password 
can be set when SETUP is started by administrative right 
or user right. 

Security Configuration – – 

Password On Boot [Disabled] 
Enabled 

Enable or disable the feature that requires a password 
entry on boot. This option can be selected when 
Administrator Password is set. 

Disable USB Ports [Disabled] 
Front 
Rear 
Front + Rear 

Select a USB port to be disabled. 

 [    ]: Factory settings
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1.2.4  Server 

If you move the cursor to Server, the Server menu screen appears. For the menu that has  on the left, move 
the cursor to it and then press the <Enter> key to show its submenus. 

 

 

 

The Server menu screen shows the options you can configure and their features. For the menu System 
Management, move the cursor to it and then press the <Enter> key to show its submenus. 

 

Option Parameter Descriptions 

System Management – – 

Event Log Configuration – – 

FRB-2 Timer Disabled 
[Enabled] 

Enable or disable FRB-2 timer. 

PCI Enumeration Monitoring Disabled 
[Enabled] 

Enable or disable the feature to monitor PCI device scan. 

PCI Enumeration Monitoring 
Timeout 

60-[180]-1200 Specify the timeout period for PCI device scan (Unit: 
second). 

Option ROM Scan 
Monitoring 

Disabled 
[Enabled] 

Enable or disable the feature to monitor option ROM scan.

Option ROM Scan 
Monitoring Timeout 

60-[300]-1200 Specify the timeout period for option ROM scan (Unit: 
second). 

OS Boot Monitoring Disabled 
[Enabled] 

Enable or disable the feature to monitor OS boot-up. If the 
NEC ESMPRO Agent is not installed on OS, disable this 
feature. 

OS Boot Monitoring Timeout 60-[600]-1200 Specify the timeout period for OS boot-up (Unit: second). 

POST Pause Monitoring Disabled 
[Enabled] 

Enable or disable the feature to monitor POST while the 
boot-up is suppressed. 

POST Pause Monitoring 
Timeout 

60-[180]-1200 Specify the timeout period for monitoring POST while the 
boot-up is suppressed (Unit: second). 

Thermal Sensor Disabled 
[Enabled] 

Enable or disable the feature to monitor the thermal sensor.
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Option Parameter Descriptions 

POST Error Pause [Disabled] 
Enabled 

Enable or disable the feature to suppress OS booting when 
POST detects an error. 

AC-LINK Stay Off 
[Last State] 
Power On 

Specify AC link feature. Specify how the DC power state 
should be when the AC power is supplied again after loss 
of power. (See the table below) 
If Power On or Last State is selected, the system starts 
after the time specified for Power On Delay Time has 
elapsed and CPU/IO modules of both systems are installed 
(180 seconds at longest). 

Power On Delay Time [50]-600 Specify the DC power-on delay time when Power On or 
Last State is selected for AC-LINK (Unit: second). 

 [    ]: Factory settings

 

The table below shows the operation of DC power when the AC power is turned off once and then back on, in 
accordance with the AC LINK setting. 

 

System status before AC power was turned off
AC LINK setting 

Stay Off Last State Power On 

Operating (DC power is ON) Off On On 

Abort (DC power is also OFF) Off Off On 

Forced shutdown* Off Off On 

* Continue pressing the POWER switch for at least 4 seconds to forcibly turn off the power. 

 

Tips If an uninterruptible power supply (UPS) is used for automatic operation, set the 
AC-LINK to Power On. 
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(1) System Management submenu 

From the Server menu, move the cursor to System Management and then press the <Enter> key to show its 
submenus. 

 

 

 

For details about the options, see the table below (display only). 

 

Option Parameter Descriptions 

BIOS Version – The current BIOS version is displayed. 

Board Part Number – The part number of motherboard is displayed. 

Board Serial Number – The serial number of motherboard is displayed. 

System Part Number – The part number of the system is displayed. 

System Serial Number – The serial number of the system is displayed. 

Chassis Part Number – The part number of chassis is displayed. 

Chassis Serial Number – The serial number of chassis is displayed. 

BMC Device ID – The device ID of BMC is displayed. 

BMC Device Revision – The revision of BMC is displayed. 

BMC Firmware Revision – The firmware revision of BMC is displayed. 

SDR Revision – The revision of Sensor Data Record is displayed. 

ASIC Revision – The firmware revision of Fault-tolerant chipset is 
displayed. 

SMM Revision – The firmware revision of System Management is 
displayed. 

System MAC Address – The system MAC address is displayed. 
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(2) Event Log Configuration submenu 

From the Server menu, move the cursor to Event Log Configuration and then press the <Enter> key to show 
its submenu. 

 

 

 

For details about the options, see the table below. 

 

Option Parameter Descriptions 

Clear Online Event Logs – Press the <Enter> key then select Yes to clear event 
logs of active module. 

Clear Offline Event Logs – Press the <Enter> key then select Yes to clear event 
logs of standby module. 
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1.2.5  Boot 

If you move the cursor to Boot, the Boot menu where you can configure the boot order appears. 

 

 

 

For details about the options, see the table below. 

Option Parameter Descriptions 

Boot Configuration – – 

Quiet Boot Disabled 
[Enabled] 

Enable or disable the feature to display logo during 
POST. When this option is set to Disabled, the results of 
POST execution are displayed instead of the logo. 
If BIOS Redirection Port is enabled, this option is 
shown as Unavailable and inaccessible (run with 
Disabled state automatically) 

Bootup NumLock State On 
[Off] 

Enable or disable NumLock feature of keyboard.  

Setup Prompt Timeout Number Specify the time until the <F2> is pressed to launch 
SETUP. 

Boot Option Priorities – – 

Boot Option #1 – These items display the priority of boot devices. 
 Boot Option #2 – 

Boot Option #3 – 

Boot Option #4 – 

CD/DVD ROM Drive BBS 
Priorities 

– Specify the boot priority for each BBS (BIOS Boot 
Specification). 

Floppy Drive BBS Priorities – 

Hard Drive BBS Priorities – 

Network Drive BBS Priorities – 

  [    ]: Factory settings 
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1.  When BIOS detects a bootable device, information on the device is displayed in the designated area. 

2.  The boot priority (from first to fourth) of the registered boot devices can be changed using the <↑>/<↓> 
and <+>/<−> keys. 
Move the cursor to a device using the <↑>/<↓> keys, and change the priority using the <+>/<−> keys. 

 

Tips • If a bootable device is newly connected, the priority lowest in its BBS Priorities 
is assigned to that device. 

• If a bootable device is disconnected from the server, the relevant device is 
removed from BBS Priorities. 

• When Load Setup Defaults is executed on Save & Exit menu, the Boot 

Option and BBS Priorities are changed as follows. 

 Boot Option Priorities 

 Boot Option #1: CD/DVD ROM Drive 

 Boot Option #2: Floppy Drive 

 Boot Option #3: Hard Drive 

 Boot Option #4: Network Device 
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1.2.6  Save & Exit 

If you move the cursor to Save & Exit, the Save & Exit menu appears. 

 

 

 

The options of this menu are described below.  

 

(a) Save Changes and Exit 

The SETUP utility closes with all the changes saved in NVRAM (Non-volatile memory). After the SETUP 
utility closes, the system automatically reboots. 

(b) Discard Changes and Exit 

The SETUP utility closes without saving the changes in NVRAM. The setting at startup of SETUP utility is 
retained. 
After the SETUP utility closes, the system automatically reboots. 

(c) Save Changes 

Changes are saved in NVRAM. 

(d) Discard Changes 

The changes are discarded and the settings are reset to the one at startup of SETUP utility. 

(e) Load Setup Defaults 

This option resets all values in the SETUP utility to the default settings. 
 

Note The factory-set value may differ from the default value depending on your server 
model. Reconfigure each item according to your environment by referring to the list 
of settings in this section. 
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2. BMC Configuration 

BMC Configuration utility allows you to view or change system parameters. 

 

2.1  Overview 

 

2.1.1  Offline Tools 

The server has the following offline tools: 

• Off-line Maintenance Utility 
Use this tool when maintaining the server. 

• BMC Configuration 
Use this tool when setting system configuration information to BMC. 

 
This section describes the features of BMC Configuration. 

 

2.1.2  Starting BMC Configuration 

When the server starts, press <F4> key to display Offline Tools menu, and select BMC Configuration on the 
menu. The BMC Configuration starts. 
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2.2  Features of BMC Configuration 

 

2.2.1  Main Menu 

The Main Menu appears when you select BMC Configuration on Offline Tools menu. 

 

BMC Configuration MENU                                            Ver. 1.000.100 

 

   

  BMC Configuration  

  BMC Initialization  

  BMC Reset : CPU/IO module 0  

  BMC Reset : CPU/IO module 1  

  Help   

  Return to the previous menu  

      Previous menu:[ESC]  

 

 

 

Main Menu 

(a) BMC Configuration 

You can set configuration information to BMC. 
If you select OK after you change the values, the set values are applied to BMC. 
See (2.2.2 Setting BMC Configuration) for details. 

(b) BMC Initialization 

You can restore the BMC Configuration information to the default value (except for some items). 
Executing this item initializes both CPU/IO modules 0 and 1. 
See (2.2.3 Initializing BMC) for details. 

(c) BMC Reset : CPU/IO module X 

You can reset BMC of CPU/IO module X (X = 0 or 1) without changing any settings. 
See (2.2.4 Resetting BMC) for details. 

(d) Help 

You can open BMC Configuration help window. 

(e) Return to the previous menu 

You can exit BMC Configuration, and return to Offline Tools menu. 
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2.2.2  Setting BMC Configuration 

 

The Main Menu appears when you select BMC Configuration on Offline Tools menu. 

 

 

 

 BMC Configuration  

  Network : CPU/IO module 0  

  Network : CPU/IO module 1  

  User Management   

  Mail Alert  

  SNMP Alert  

  System Operation  

  Miscellaneous  

  Help  

  Return to the previous menu   

      Previous menu:[ESC]  

 

 

BMC Configuration menu 

 

(a) Network : CPU/IO module X 

You can view network environment and services of BMC LAN of CPU/IO module X (X = 0 or 1) and change 
parameter setting. Only the module that is installed appears on this menu. 
See (2.2.2 (a) Network) for details. 

(b) User Management 

You can manage users who use BMC. 
See ((b) User Management) for details. 

(c) Mail Alert 

You can view E-mail alert issued from BMC and change parameter setting. 
See ((c) Mail Alert) for details. 

(d) SNMP Alert 

You can view SNMP alert issued from BMC and change parameter setting. 
See ((d) SNMP Alert) for details. 

(e) System Operation 

You can set parameters for remote KVM console and remote media. 
See ((e) System Operation) for details. 

(f) Miscellaneous 

You can set various features of BMC. 
See ((f) Miscellaneous) for details. 
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(a) Network 

The Network menu appears when you select Network on BMC Configuration menu.  

 

 

 

 Network  

  Property  

  Access Limitation  

  Service  

  Help   

  Return to the previous menu  

      Previous menu:[ESC]  

 

 

 

Network menu 

The table below shows details of parameters and their default value. 

Item Description Default Value 

Property 
 Management LAN Specify and display LAN port to communicate with BMC. *1 *2 

Management LAN 
: LAN port for BMC exclusive use. 
Shared BMC LAN 
: LAN port of System (OS) is shared and used. 

Management LAN

 Connection Type Specify and display the connection type of BMC LAN.*1 
Auto Negotiation 
  : Connecting by suitable setting. 
100Mbps Full 
  : Connecting by Full Duplex at speed of 100 Mbps. 
100Mbps Half 
  : Connecting by Half Duplex at speed of 100 Mbps. 
10Mbps Full 
  : Connecting by Full Duplex at speed of 10 Mbps. 
10Mbps Half 
  : Connecting by Half Duplex at speed of 10 Mbps. 

Auto Negotiation 

 BMC MAC Address MAC Address of BMC is displayed. － 
 DHCP Determine whether to dynamically obtain an IP address from a 

DHCP server. If the item is set to Enable and applied, BMC set the 
value IP Address, Subnet Mask and Default Gateway obtained 
from DHCP server. 

Disable 

 IP Address Specify the BMC LAN IP address. *4 192.168.1.1 
 Subnet Mask Specify the Subnet Mask of BMC LAN. *3 *4 255.255.255.0 
 Default Gateway Specify the Default Gateway IP address of the BMC LAN. *4 

If you set this item, it is necessary for applying configuration 
information that the gateway is connected on network. 

0.0.0.0 

 Dynamic DNS Determine whether to enable/disable of Dynamic DNS. *5 Disable 
 DNS Server Specify the DNS Server. 0.0.0.0 
 Host Name Specify the Host Name. *6 Blank 
 Domain Name Specify the Domain Name. *7 Blank 
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Item Description Default Value 

Access Limitation 
 Limitation Type Select the Access Limitation Type. 

Allow All 
  : Access to BMC is not limited. 
Allow Address 
  : Specify the IP Address that is allowed to access BMC. 
Deny Address 
  : Specify the IP Address that deny to access BMC. 

Allow All 

 IP Address Specify the IP Address to allow or deny to access with BMC. *8 *9 Blank 
Service 
 HTTP Enable or disable HTTP service. *10 Enable 
 HTTP Port Number Specify the HTTP port number. *11 80 
 HTTPS Enable or disable HTTPS service. *10 Enable 
 HTTPS Port Number Specify the HTTPS port number. *11 443 
 SSH Enable or disable SSH service. Enable 
 SSH Port Number Specify the SSH port number. *11 22 

 

*1: You can change this parameter only if you allows it. 

*2: After you change parameter value, resetting of BMC may be required depending on the server. When set to 
"Shared BMC LAN", the management LAN port is disabled. When set to "Shared BMC LAN", the system (OS) 
LAN port also transmits or receives data. Thus, the network performance may be reduced due to load of 
system LAN (or BMC LAN). 

*3: If an illegal value is specified for subnet mask, an error message is displayed and setting is disabled. 

*4: Can be changed only when DHCP is set to "Disable". 

*5: Can be changed only when DHCP is set to "Enable". 

*6: Host Name should be within 63 characters.  
Acceptable characters are: alphanumeric, hyphen (-), underscore (_), and period (.). 

*7: Host Name and Domain Name should be within total of 255 characters.  
Acceptable characters are: alphanumeric, hyphen (-), underscore (_), and period (.). 

*8: The range of IP address to "Allow" or "Deny" access is delimited by ",(Comma)". With regard to the setting of 
“Deny” access, "*(Asterisk)" can be described as a wild-card. (ex: 192.168.1.*,192.168.2.1,192.168.2.254) 

*9: Can be specified when Access Limitation Type is "Allowed Address" or "Deny Address". The length must not 
exceed 255 characters. 

*10: If HTTP is set to "Enable", HTTPS is changed to "Enable" automatically. You are not allowed to set "Enable" to 
HTTP only. 

*11: Port number can be specified only when the relevant port is set to "Enable". The port number must be unique. 
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(b) User Management 

 

The User Management menu appears when you select User Management on BMC Configuration menu.  

 

 

 

 User Management  

  User Account  

  Active Directory (Property)  

  Active Directory (Group)  

  LDAP   

  Help  

  Return to the previous menu  

      Previous menu:[ESC]  

 

 

 

User Management menu 

 

The table below shows details of parameters and their default value. 

Item Description Default 
Value 

User Account 
 User Enable or disable the user. *1 Enable 
 User Name Specify user name. *2 Blank 
 Password Specify password. *3 Blank 
 Confirm Password Specify the same character string used for "Password". *3 Blank 
 Privilege Specify the privilege of the user. *4 

  Administrator 
  Operator 
  User 

Administrator

Active Directory (Property) 
 Active Directory 

Authentication 
Enable or disable Active Directory authentication. Disable 

 User Domain Name Specify the user domain name. *5 *6 Blank 
 Timeout Specify timeout period for connection with Domain Controller. *5 120 
 Domain Controller Server1 Enable or disable Domain Controller 1. *5 *7 Enable 
 Server Address1 Specify IP address of Domain Controller 1. *5 *8 Blank 
 Domain Controller Server2 Enable or disable Domain Controller 2. *5 *7 Disable 
 Server Address2 Specify IP address of Domain Controller 2. *5 *8 Blank 
 Domain Controller Server1 Enable or disable Domain Controller 3. *5 *7 Disable 
 Server Address3 Specify IP address of Domain Controller 3. *5 *8 Blank 
Active Directory (Group) 
 Group Name Specify group name. *8 Blank 
 Group Domain Specify group domain. *6 Blank 
 Privilege Specify privilege of group. *4 

  Administrator 
  Operator 
  User 

Administrator



2. BMC Configuration 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 225

Chapter 3  Useful Features 

Item Description Default 
Value 

LDAP 
 LDAP Authentication Enable or disable LDAP authentication. Disable 
 IP Address Specify the IP address. *9 0.0.0.0 
 Port Number Specify the LDAP port number. *9 636 
 Search Base Specify the search base used in LDAP authentication. *9 *10 Blank 
 Bind Domain Name Specify the bind domain used in LDAP authentication. *9 *10 Blank 
 Bind Password Specify the bind password used in LDAP authentication. *9 *11 Blank 

 

*1: Can be specified if a user exists. 

*2: Up to 15 characters including alphanumeric, hyphen (-), and underscore (_) can be used. Note, however, User 
Name must start start with hyphen (-). In addition, "root", "null", "MWA", "AccessByEM-Poem", and names 
which are already assigned for other number are not allowed. 

*3: Up to 19 ASCII characters excluding " " (blank), " (quotation), & (ampersand), ? (question mark), = (equal sign), 
#, and ¥, can be used. 

*4: Privileges are defined as follows: 

Administrator : User who has administrator right. All operations are allowed. 

Operator : User who can operate the machine. Session management, license registration, remote 
KVM/media, configuration, and update are not allowed. 

User : General user. Viewing IPMI information only is allowed. 

*5: Can be specified only when Active Directory authentication is set to "Enable". 

*6: Up to 255 characters including alphanumeric, hyphen, underscore, and period can be used. 

*7: If Active Directory authentication is set to "Enable", at least one domain controller server must be enabled. 

*8: Can be specified only when domain controller server is set to "Enable". 

*9: Can be specified only when LDAP authentication is set to "Enable". 

*10: Characters in the range between 4 and 62 including alphanumeric, hyphen, underscore, period, comma, and 
equal sign can be used. 

*11: Alphanumeric characters in the range between 4 and 31 excluding ", #, and ¥ can be used. 
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(c) Mail Alert 

The Mail Alert menu appears when you select Mail Alert on BMC Configuration menu.  

 

 

 

 Mail Alert  

  Mail Alert  

  SMTP Server  

  Alert Level  

  Alert Test   

  Help  

  Return to the previous menu  

      Previous menu:[ESC]  

 

 

 

Mail Alert menu 

 

The table below shows details of parameters and their default value. 

Item Description Default Value 

Mail Alert 
 Mail Alert Enable or disable Mail Alert. Disable 
 Response of SMTP 

Server 
Specify the timeout period until when the connection to 
SMTP server succeed by E-mail transmission. 

30 

 To:1 Select Enable/Disable of To:1. *1 Enable 
 To:1 E-Mail Address Specify the mail address of To:1. *2 *3 Blank 
 To:2 Select Enable/Disable of To:2. *1 Disable 
 To:2 E-Mail Address Specify the mail address of To:2. *2 *3 Blank 
 To:3 Select Enable/Disable of To:3. *1 Disable 
 To:3 E-Mail Address Specify the mail address of To:3. *2 *3 Blank 
 From: Specify the mail address of From. *3 Blank 
 Reply-To: Specify the mail address of Reply-To. *3 Blank 
 Subject: Specify the Subject. *4 Blank 
SMTP Server 
 SMTP Server Specify the SMTP Server. *5 0.0.0.0 
 SMTP Port Number Specify the SMTP port number. 25 
 SMTP Authentication Select Enable/Disable of SMTP Authentication. Disable 
 CRAM-MD5 Select Enable/Disable of CRAM-MD5. *6 *7 Enable 
 LOGIN Select Enable/Disable of LOGIN authentication.  *6 *7 Enable 
 PLAIN Select Enable/Disable of PLAIN authentication. *6 *7 Enable 
 User Name Specify the SMTP User Name.  *6 *8 Blank 
 Password Specify the SMTP User Password. *6 *9 Blank 
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Item Description Default Value 

Alert Level 
 Alert Level Specify the kind of event to alert. Error, Warning 
 Error 

  : When "Error" is detected in each sensor type, the 
alert is sent to the checked address. 

 Error, Warning 
  : When "Error" or "Warning" is detected in each sensor 

type, the alert is sent to the checked address. 
 Error, Warning, Information 

  : When "Error", "Warning" or "Information" is detected 
in each sensor type, the alert is sent to the checked 
address. 

 Separate Setting 
  : You can arbitrarily select the event and the address 

(To:X) to alert in each sensor type. 
Alert Test Execute test by sending an alert by mail. *10 － 

 

*1: When Mail Alert is enabled, at least one addresses should be enabled. 

*2: Can be specified only when To:X is set to "Enable". 

*3: Up to 255 characters including alphanumeric, hyphen, underscore, period, and @ (at mark) can be used. 

*4: Up to 63 alphanumeric characters excluding +, ", ?, =, <, >, #, and ¥ can be used. 

*5: Up to 255 alphanumeric characters, hyphen, and period can be used for full domain name or IP address. 

*6: Can be specified only when SMTP Authentication is set to "Enable". 

*7: When SMTP Authentication is set to "Enable", at least one of the authentic method should be enabled. 

*8: Up to 64 alphanumeric characters excluding " " blank, ",?, =, <, >, #, and ¥, can be used. 

*9: Up to 19 alphanumeric characters excluding " " blank, ",?, =, <, >, #, and ¥, can be used. 

*10: Be sure to perform Alert Test after all the parameters are configured appropriately. Alert feature may fail 
depending on configuration made for network or alert receiver. 
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(d) SNMP Alert 

The SNMP Alert menu appears when you select SNMP Alert on BMC Configuration menu.  

 

 

 SNMP Alert   

  SNMP Alert  

  Alert Level  

  Alert Test  

  Help   

  Return to the previous menu  

      Previous menu:[ESC]  

 

 

 

SNMP Alert menu 

The table below shows details of parameters and their default value. 

Item Description Default Value 

SNMP Alert 
 SNMP Alert Enable or disable SNMP Alert. *1 Disable 
 Computer Name Specify the Computer Name. *2 Blank 
 Community Name Specify the Community Name. *2 Public 
 Alert Process Select One Alert Receiver or All Alert Receiver for Alert Process. One Alert 

Receiver 
 Alert Acknowledge Enable or disable Alert Acknowledge.  Enable 
 Alert Retry Count Specify the count of Alert retry. *3 3 
 Alert Timeout Specify the timeout period (in seconds) for alert. *3 6 
 Alert Receiver1 Enable or disable primary receiver. *4 Enable 
 IP Address1 Specify the IP Address of primary receiver. *5 0.0.0.0 
 Alert Receiver2 Enable or disable secondary receiver. *4 Disable 
 IP Address2 Specify the IP Address of secondary receiver.  *5 0.0.0.0 
 Alert Receiver3 Enable or disable tertiary receiver. *4 Disable 
 IP Address3 Specify the IP Address of tertiary receiver. *5 0.0.0.0 
Alert Level 
 Alert Level Specify the kind of event to alert. Error, Warning 
 Error 

  : When "Error" is detected in each sensor type, the alert is sent to 
the checked address. 

Error, Warning 
  : When "Error" or "Warning" is detected in each sensor type, the 

alert is sent to the checked address. 
Error, Warning, Information 
  : When "Error", "Warning" or "Information" is detected in each 

sensor type, the alert is sent to the checked address. 
Separate Setting 
  : You can arbitrarily select the event to alert in each sensor type. 

Alert Test Execute a test by SNMP alert. *6 － 
 

*1: When PEF (Platform Event Filter) is set to "Disable" in Miscellaneous menu, SNMP alert is disabled. 

*2: Up to 16 alphanumeric characters are accepted. 

*3: Can be specified only when Alert Acknowledge is set to "Enable". 

*4: When SNMP Alert is enabled, at least one alert receiver should be enabled. 

*5: Can be specified only when each Alert Receiver is set to "Enable". 

*6: Be sure to perform Alert Test after all the parameters are configured appropriately. Alert feature may fail 
depending on configuration made for network or alert receiver. 
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(e) System Operation 

The System Operation menu appears when you select System Operation on BMC Configuration menu.  

 
 

 

 System Operation  

  Remote KVM Console  

  Remote Media   

  Help  

  Return to the previous menu  

      Previous menu:[ESC]  

 

 

 

System Operation menu 

The table below shows details of parameters and their default value. 

Item Description Default Value 

Remote KVM Console 
 Encryption Enable or disable encryption. Enable 
 Port Number 

(No Encryption) 
Specify the port number when encryption is disabled. *1 7578 

 Port Number 
(Encryption) 

Specify the port number when encryption is enabled *1 7582 

 Mouse Cursor Mode Specify display mode of mouse cursor. 
Single 
Dual 

Dual 

 Mouse Coordinate 
Mode 

Select a mode to indicate coordinate when moving mouse 
cursor. 

Relative 
Absolute 

Relative 

 Keyboard Language Select a keyboard language. 
Japanese (JP) 
English (US) 
French (FR) 
German (DE) 

English(US) 

Remote Media 
 Encryption Enable or disable encryption. Enable 
 Remote CD/DVD 

(No Encryption) 
Specify the port number of remote CD/DVD port when 
encryption is disabled. *1 

5120 

 Remote USB Memory 
(No Encryption) 

Display the port number of remote USB memory when 
encryption is disabled. (Remote CD/DVD port number + 2)

－ 

 Remote FD 
(No Encryption) 

Display the port number of remote FD when encryption is 
disabled. (Remote CD/DVD port number + 3) 

－ 

 Remote CD/DVD 
(Encryption) 

Specify the port number of remote CD/DVD port when 
encryption is enabled. *1 

5124 

 Remote USB Memory 
(Encryption) 

Display the port number of remote USB memory when 
encryption is enabled. (Remote CD/DVD port number + 2) 

－ 

 Remote FD 
(Encryption) 

Display the port number of remote FD when encryption is 
enabled. (Remote CD/DVD port number + 3) 

－ 

 

*1: Port numbers must be the unique one. 
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(f) Miscellaneous 

The Miscellaneous menu appears when you select Miscellaneous on BMC Configuration menu.  

Item Description Default Value 

Miscellaneous 
 Behavior when SEL 

repository is Full 
Specify the behavior when SEL repository is full. *1 
Stop logging SEL 
  : SEL is not recorded any more. 
Clear all SEL  
  : Delete all SEL and record SEL newly. 
Overwrite oldest SEL 
  : Old SEL is overwritten with new SEL. 

Stop logging SEL 

 Platform Event Filter Enable or disable Platform Event Filter. *2 Enable 
 Management Software Setting for remote management － 
 ESMPRO Management Enable or disable NEC ESMPRO Management. *3 Current set value 
 Authentication Key Specify the Authentication Key. *4 *5 Guest 
 Redirection Enable or disable Redirection feature. *4 *6 Enable 

 

*1: When this item is changed to/from "Overwrite oldest SEL", all log records in the SEL Repository are cleared. 

*2: Disabling Platform Event Filter also disables SNMP alert. 

*3: When BMC can be managed directly from NEC ESMPRO Manager (Ver.5.4 or later), this item must be set to 
"Enable". If it is set to "Enable", Authentication Key is required. 

*4: Can be specified only when ESMPRO Management is set to "Enable". 

*5: This Authentication key is used when NEC ESMPRO Manager (Ver.5.4 or later) manages the target server. Up 
to 16 alphanumeric characters are accepted. 

*6: If Redirection is set to "Enable", Console Redirection Configuration port in BIOS is set to "Serial Port B" at next 
boot. 

 

Note If you do not use remote management feature by NEC ESMPRO, set to "Disable" for 
ESMPRO Management in Management Software. In this case, setting for relevant items 
are hidden and unnecessary. 

 

 



2. BMC Configuration 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 231

Chapter 3  Useful Features 

2.2.3  Initializing BMC 

If you select BMC Initialization on Main menu, the confirmation message as show below appears.  
Only the CPU/IO module installed in the server appears on this menu. 

 

 BMC Initialization  

     

  All of BMC configuration parameters will be restored   

  to the default settings.   

  Do you really initialize BMC?   

   – CPU/IO module 0   

   – CPU/IO module 1   

     

  Yes:[Enter] No:[ESC]   

 

Confirmation message (Initialization) 

<ESC> key: Aborts processing and returns to Main menu. 

<Enter> key: Initializes BMC configuration settings and restores the default value except for some items.  
After initialization, it takes about one minute to restart BMC. 

 

2.2.4  Resetting BMC 

If you select BMC Reset : CPU/IO module X on Main menu, the confirmation message as show below appears. 
Only the CPU/IO module installed in the server appears on this menu. 

 

 BMC Reset  

     

  It will take about one minute to restart BMC.   

  Do you really reset BMC?   

   – CPU/IO module X   

     

  Yes:[Enter] No:[ESC]   

 

Confirmation message (BMC Reset) 

<ESC> key: Aborts processing and returns to Main menu. 

<Enter> key: Resets BMC of CPU/IO module X (X = 0 or 1). It takes about one minute to restart BMC.  
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3. SAS Configuration Utility 

 
SAS Configuration utility makes settings of the built-in SAS controller. You can start it up by simple key operation 
during POST execution.   
 

Important • Because the server is installed with the latest version of the utility, your 
screen display may be different from the one described in this guide. 
For information on options different from those described in this guide, 
refer to the online help or ask your service agent. 

• This utility is set for the CPU/IO module of the primary side. When you 
configure the CPU/IO module of the secondary side, first power off the 
server, plug out and plug in the AC power cord of the primary side. 
Then start the server. 

• The SAS Configuration Utility is used for physical formatting. Do not 
change the settings on each utility menu, as doing so causes failure 
and malfunction of this server. 

 

 

3.1  Starting the SAS Configuration utility 

Take the following procedures to start the SAS/ Configuration utility. 

 

1.  Power on the server.  

The following message appears on the screen during POST execution. 

LSI Corporation MPT SAS2 BIOS 

MPT2BIOS-x.xx.xx.xx (xxxx.xx.xx) 

Copyright 2000-20xx LSI Corporation. 

 

Press Ctrl-C to start LSI Corp Configuration Utility... 
 

2.  Press and hold down the Ctrl key and press the C key.  

The SAS Configuration utility starts up with the Adapter List menu displayed.  
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3.2  Quitting the SAS Configuration Utility 

Take procedures below to quit the SAS/ Configuration utility. 

 

1.  Keep pressing the <Esc> key until the Adapter List menu appears. 

A message appears to prompt whether you want to quit the utility. 

Select Discard changes and reboot from the menu, and press the <Enter> key. 

Are you sure you want to exit? 
Cancel Exit 
Save changes and reboot. 
Discard changes and reboot. 
Exit the Configuration Utility and Reboot 

 

Tips You need not to select any other menu because no change is made on SAS Configuration 
utility. 

 



3. SAS Configuration Utility 

Express5800/R320c-E4, R320c-M4, R320d-E4, R320d-M4  Maintenance Guide (Windows) 234

Chapter 3  Useful Features 

3.3  Physical Formatting of the Hard Disk Drive 

 

Important This utility is set for the CPU/IO module of the primary side. When you 
configure the CPU/IO module of the secondary side, first power off the 
server, plug out and plug in the AC power cord of the primary side. Then 
start the server. 

 

The following describes how to execute physical formatting of hard disk drive. 

 

1.  Press the <Enter> key on the Adapter List menu.  

Adapter Properties menu appears after a short while. 

 

 

2.  Select SAS Topology and press the <Enter> key. 

SAS Topology menu appears after a while. 

 

 

3.  Select Direct Attach Device and press the <Enter> key. 

Hard disk drives that are installed on the primary CPU/IO module appear after a while. 
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4.  Select the hard disk drive to execute physical formatting and press the <D> key while pressing the <Alt> 
key. 

Device Properties menu appears after a while. 

 

 

5.  Select Format and press the <Enter> key. 

Device Format menu appears after a while. 

 

 

6.  Press the <F> key to start formatting. 

After the completion of formatting, the following message appears. 

 

 

Press any key to display Device Properties menu. 
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4. Flash FDD 

Flash FDD is a device that is compatible with a floppy disk drive. 

 

Flash FDD is used when: 

• Storing the parameter files of Windows OS 
See Chapter 1 (6. Windows OS Parameter File) in Installation Guide. 

• Collecting the hardware logs 
See Chapter 1 (12. Offline Tools). 

 

Only one Flash FDD can be connected to a USB connector of this server. If another USB or floppy disk drive is 
connected to this server, be sure to disconnect it. 

 

 CAUTION  

 

Be extremely careful not to lose Flash FDD or have it stolen. 
If Flash FDD is lost, stolen, misappropriated, or fraudulently obtained, there is a risk of 
leaking confidential information to a third party. NEC assumes no responsibility for 
damages caused by leaking confidential information in this way. 

 

If you want to change the write protection, remove Flash FDD from the server, change the write protection 
switch, and then connect it again. 

 

Note Pay attention not to move the write-protect switch when installing or removing Flash FDD.
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4.1  Notes on Using Flash FDD 

Do not use Flash FDD to back up data. Flash FDD can be used to save temporary data. 

 

4.1.1  Compensation for recorded data 

NEC does not pay compensation for data recorded on Flash FDD even if the data is lost. 

 

4.1.2  Handling Flash FDD 

• Flash FDDs are consumables.  
If Flash FDD causes an error, replace with a new Flash FDD. 

• Do not turn off the server while the access LED of Flash FDD is blinking. 
Doing so may cause failure of the device and damage to the data. 

• Flash FDD cannot be connected to a USB hub.  
Directly connect Flash FDD to the server. 

• Before handling Flash FDD, discharge static electricity from your body by touching a nearby metal object 
such as a doorknob or aluminum frame. 

• Do not disassemble Flash FDD. 

• Do not apply a strong force to Flash FDD. 

• Do not place Flash FDD in an area directly exposed to sunlight or near a heater. 

• Do not handle Flash FDD while eating, drinking, or smoking. Also, avoid contact with thinner, alcohol, or 
other corrosive substances. 

• Do not relocate the server with Flash FDD connected to USB connector. 

• Remove Flash FDD from the server when not in use. 

 

4.1.3  Use with EXPRESSBUILDER 

• Connect Flash FDD after Home Menu of EXPRESSBUILDER appears. 

• Before closing EXPRESSBUILDER, remove Flash FDD from the server.  
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5. Details of EXPRESSBUILDER 

EXPRESSBUILDER helps you to install operating system and maintain the server. EXPRESSBUILDER also 
provides bundled software and documents. 

 

 

5.1  Starting EXPRESSBUILDER 

Use the DVD labeled "EXPRESSBUILDER", as shown below: 

 

Tips Remove other removable media before starting EXPRESSBUILDER. 

 

(1) Insert the DVD into the server, and then restart the system. (Cycle the power of server, or press <Ctrl> + 
<Alt> + <Delete> keys.) 

Boot Selection Menu shown in Chapter 2 (5.2  Menus of EXPRESSBUILDER - (1) Boot Selection Menu) 
appears. 

(2) Insert the DVD into a computer running Windows. 

Autorun Menu shown in Chapter 2 (5.2  Menu of EXPRESSBUILDER - (4) Autorun Menu) appears.  

The autorun menu is disabled by factory default. Launch the menu by running 
\autorun\dispatcher_x64.exe. 

 

5.2  Menus of EXPRESSBUILDER 

EXPRESSBUILDER is operated by using onscreen menus. 

 

(1) Boot Selection Menu 

When EXPRESSBUILDER starts from DVD, the following menu appears. 

Use the upper and lower arrow keys to move the cursor, and then press <Enter> key to choose it. 
OS installation is chosen if no key is pressed. 

Tool menu

OS installation  *** default ***

Boot selection

 

Home Menu shown in (2) Home Menu appears when choosing OS installation. 

Tool Menu shown in (3) Tool Menu appears when choosing Tool menu. 
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(2) Home Menu 

 

Operate Home Menu using the mouse or keyboard. 

The following menus are included. 

a) Setup 
Installs Windows easily. For details about how to install Windows, see "Installation Guide (Windows)". 

b) Utilities 
Starts a utility provided by EXPRESSBUILDER. 
See Chapter 3 (5.3 Utilities Provided by EXPRESSBUILDER) for details. 

c) Versions 
Displays software and driver versions in EXPRESSBUILDER. 

d) Exit 
Closes EXPRESSBUILDER and then shut down or restart the server. 
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(3) Tool Menu 

Return to the previous menu

Test and diagnostics

Tool menu

 

Choose Test and diagnostics to run System Diagnostics, which is used to analyze and diagnose the server 
and check the cable connection. For details about system diagnostics, see Chapter 1 (11. System Diagnostics). 

 

(4) Autorun Menu 

 

Use Autorun menu to read documents or install bundled software. Adobe Reader is needed to view or print 
manuals of PDF format.  

 

Integrated Installation 

You can easily install Starter Pack or NEC ESMPRO using this feature. Log on the Windows with the built-in 
Administrator to use this feature.  

 

5.3  Utilities Provided by EXPRESSBUILDER 

The following utilities can be started when choosing Utilities from Home Menu. 

 

File execution 

Directly runs an external utility on removable media. Use this feature only for utilities provided by NEC. 

 

Note The operation of external utilities provided by companies other than NEC is not 
guaranteed. 

 
 



6. EXPRESSSCOPE Engine 3 
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6. EXPRESSSCOPE Engine 3 

EXPRESSSCOPE Engine 3 enables various features by using Baseboard Management Controller (BMC). 

 

EXPRESSSCOPE Engine 3 monitors statuses inside the server such as that of power supplies, cooling fans, 
temperature, and voltage. Connecting the management LAN port to your network enables you to do the 
following from a remote site through a web browser and SSH client;  

• Managing the server 

• Operating keyboard, video, and mouse (KVM) from a remote console (*) 

• Accessing a CD-ROM, DVD ROM, floppy disk, ISO image, or USB flash drive in a remote console (*) 

 

* To actualize these features, virtual USB mass storage (Remote FD, Remote CD/DVD, Remote USB Memory, 
or Virtual Flash) is always connected as USB mass storage. 

 

Tips To reset BMC, use the Off-line Tool of the server. 

See Chapter 3 (2. BMC Configuration) for details. 

 

 



7. NEC ESMPRO 
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7. NEC ESMPRO 

 

7.1  NEC ESMPRO Agent (for Windows) 

For details of NEC ESMPRO Agent (for Windows), see "NEC ESMPRO Agent Installation Guide (Windows)" in 
EXPRESSBUILDER or its help. 

 

7.2  NEC ESMPRO Manager 

NEC ESMPRO Manager remotely controls and monitors the server hardware.  

To use these features, install the bundled software such as NEC ESMPRO Agent on the server. 

 

See "NEC ESMPRO Manager Installation Guide" or online help of NEC ESMPRO for details. 

 

7.3  NEC ESMPRO Agent Extension 

NEC ESMPRO Agent Extension allows you to manage the server remotely by this server’s BMC connecting 
with NEC ESMPRO Manager. 

For details, see "NEC ESMPRO Agent Extension Installation Guide" in EXPRESSBUILDER. 

 

 

7.4  BMC Configuration 

BMC Configuration allows you to specify configuration information, backup or restore the system configuration 
information to this server’s BMC. 

For details, see "BMC Configuration User’s Guide" in EXPRESSBUILDER. 

 

Note • Configure BMC while the system is in duplex configuration. 

• To verify duplex configuration, see Chapter 1 (4. Names and Functions of 

Components) in User's Guide. 

 



7. NEC ESMPRO 
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7.5  NEC ExpressUpdate Agent 

NEC ExpressUpdate Agent enables you to manage and update the versions of the firmware and software 
installed in the server to be managed. 

By using NEC ExpressUpdate, you can easily apply the update packages that is downloaded by NEC ESMPRO 
Manager. 

For details, see "NEC ExpressUpdate Agent Installation Guide" in EXPRESSBUILDER. 

 

Tips Updates are available for some firmware and software that do not support NEC 
ExpressUpdate. See the following website to install these packages: 

http://www.nec.com/global/prod/express/index.html 

 

http://www.nec.com/global/prod/express/index.html�


8. NEC Product Info Collection Utility 
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8. NEC Product Info Collection Utility 

NEC Product Info Collection Utility can collect various logs related to the server all at once. You can collect the 
server information (Product Info) for maintenance by using this utility. 

 

Run \stdclct\collect.exe contained in the installation folder of this utility. 

This utility is usually installed to the C:\ezclct folder. 

 

The log folder is created in stdclct folder and “Product Info” is stored in a compressed (zip) file. 

 

Tips • Log on to Windows with an account that has an administrator privilege. 

• The installation drive requires a free space of at least 2.5 GB. 

 



9. Express Report Service / Express Report Service (HTTPS) 
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9. Express Report Service / Express Report Service (HTTPS) 

For details about Express Report Service / Express Report Service (HTTPS), see "Express Report Service / 
Express Report Service (HTTPS) Installation Guide" in EXPRESSBUILDER.  

 

Tips Express Report Service through the SNMP Alert of EXPRESSSCOPE Engine 3 is not 
available.  

Refer to "EXPRESSSCOPE Engine 3 User's Guide" for more information. 
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